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Chapter 1 File Management 
This section describes the file management options available within UltraEdit.  It will show the 
various methods for opening, closing, and deleting files.  It will also explain how to sort and 
compare files as well as how to convert files from different formats.  

This section further describes the page setup and printing options for files.  Finally this section 
will discuss options for using favorite file lists and project lists within UltraEdit. 

The following topics will be covered: 

File Management: 
File Menu Commands 
Creating Files 
Saving Files 
Opening Files 
Closing Files   
FTP - Open from FTP 
FTP - Save As to FTP 
Revert to Saved 
Deleting Active Files 
Comparing Files 
Inserting Files 
Inserting A String At Every Increment 
Sending mail 
Large file handling 

File Conversion: 
UNIX/MAC to DOS 
DOS to MAC 
DOS to UNIX 
ASCII to EBCDIC 
EBCDIC to ASCII 
ANSI to OEM 
OEM to ANSI 

Sorting Within A File: 
Ascending Sort 
Descending Sort 
Remove Duplicates 
Ignore Case 
Starting Column 

Print command 
Print Preview command 
Page Setup: 

Header & Footer Setup 
Justification 
Date & Time Codes 
Margin Setup 
Page Break 
Wrap Text When Printing 
Print Line Numbers 
Print Two Pages on One Sheet 
Print Syntax Highlighting  

Print Setup: 
Default Printer 
Page Orientation 
Paper Size 
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Paper Source 
Print Options 
Network Printing 

Favorite Files List: 
Opening a File 
Closing a File 
Adding a File 
Adding the Active File 
Removing a File 

Recent Files submenu 
Recent Projects/Workspaces submenu 
Exiting UltraEdit 

File Menu Commands 
The File menu offers the following commands: 

New     creates a new document 

Open     opens an existing document 

Quick Open opens an existing document allowing entry of 
name without browse dialog 

Close     closes an opened document 

Close All Files    closes all opened documents 

FTP  Open from FTP   opens an existing document from an FTP site 

FTP  Save As to FTP   saves an opened document to a specified  

file name on an FTP site 

Revert to Saved    reverts to last saved form of current 
document  

Save saves an opened document using the same file 
name 

Save As saves an opened document to a specified file 
name 

Save All saves all modified documents using the same 
file names 

Save Selection As    saves selection to a new file 

Make Copy/Backup    makes a copy/backup of active file 

Compare Files    compares two ASCII files 

Sort File     sorts the file based on current sort options 

Advanced Sort/Options   advanced sort options 

UNIX/MAC to DOS converts the file format from UNIX or MAC to 
DOS 

DOS to MAC    converts the file from DOS to MAC format 

DOS to UNIX    converts the file from DOS to UNIX format 

EBCDIC to ASCII    converts the file from EBCDIC to ASCII format 

ASCII to EBCDIC    converts the file from ASCII to EBCDIC format 
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OEM to ANSI    converts the file from OEM to ANSI format 

ANSI to OEM    converts the file from ANSI to OEM format 

ASCII to Unicode    converts the file from ASCII to Unicode format 

Unicode to ASCII    converts the file from Unicode to ASCII format 

Insert File     inserts a file into the active document 

Delete Active File deletes the disk file associated with the active 
window and closes the window losing all 
changes 

Send Mail     sends file via mail to recipients 

Insert String At Every Increment inserts a string at the specified increment in the 
file 

Print     prints a document 

Print All Files    prints all open documents 

Print Preview displays the document on the screen as it would 
appear printed 

Page Setup     sets up page headers and footers for printing 

Print Setup     selects a printer and printer connection 

Favorite Files    opens favorite files or manage the list 

Recent Files opens recent files  (this may be set up as part of 
the File Menu rather than a submenu via the 
Recent Files Menu on File Menu option on the 
General Configuration Page) 

Recent Projects/Workspaces opens recent projects/workspaces (may be 
replaced with the Project submenu by 
deselecting the Project Menu on Main Menu 
option on the General Configuration Page) 

Exit      exits UltraEdit 
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Creating Files 

New command 
Use this command to create a new document.  UltraEdit opens a blank page for you to edit.  
Global configurations will apply, but settings that vary from document to document will need 
to be reapplied. Shortcut:  CTRL+N 

Opening Files 

Open command 
Use this command to open an existing document (file) in a new window. You can open 
multiple documents at once.  Use the Window menu or file tabs to switch among the multiple 
open documents.  This command presents the File Open dialog.  This allows multiple files to 
be selected and opened at one time. Dragging files from the File Manager into UltraEdit’s 
window and dropping them (releasing the mouse button) will also open them.    

Shortcut:  CTRL+O 

File Open Dialog Box 
The following options allow you to specify which file to open: 

File Name 
Type or select the filename you want to open.  This box lists files with the extension you 
select in the List Files of Type box.  

List Files of Type 
Select the type of file you want to open. 

Drives 
Select the drive in which UltraEdit finds the file that you want to open.  

Directories 
Select the directory in which UltraEdit finds the file that you want to open. 

Read Only 
Check this item to open a file in a read-only manner.  Modifications will be disabled. 

Network 
Choose this button to connect to a network location, assigning it a new drive letter.  
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UltraEdit allows multiple files to be selected from the file list and opened at one time (Except 
UltraEdit-32 on Windows NT†).  To select multiple files, select the first file from the list, then 
with the CTRL key pressed, select other files in the list.  When all files are selected, select 
OK and the selected files will be opened. 

Dragging files from the File Manager into UltraEdit’s window and dropping them (releasing 
the mouse button) will also open files. 

Quick Open command 
Use this command to quickly open a file without the delay of showing a file browse dialog.  
The directory from which the file is to be opened is shown in the dialog.  Relative paths as 
well as the filename may be entered. 

With this command it is also possible to open with wildcards such as "*.txt". 

The file selected will be opened or an error displayed. 

Closing Files 

Close command 
Use this command to close all windows containing the active document.  UltraEdit suggests 
that you save changes to your document before you close it.  If you close a document 
without saving, you lose all changes made since the last time you saved it.  Before closing 
an untitled document, UltraEdit displays the Save As dialog box and suggests that you name 
and save the document. You can also close a document by using the Close icon on the 
document’s window. 

Close All Files command 
Use this command to close all files currently open in the edit window. UltraEdit suggests that 
you save changes to your document before you close it.  If you close a document without 
saving, you lose all changes made since the last time you saved it.  Before closing an 
untitled document, UltraEdit displays the Save As dialog box and suggests that you name 
and save the document. 

Note: If documents that are part of a project are closed using this command, UltraEdit will 
not automatically reopen these documents upon the next use of the project.  If you wish to 
reopen files upon the next use of the current project, choose a different project and UltraEdit 
will present a dialog box asking if you wish to close the currently opened files.  Files closed 
in this manner will be reopened when you return to a project. 

                                                        
† The normal operation of Windows NT does not permit the selection of long filenames and multiple 
selection from the open dialog.  To facilitate both operations, the open dialog box normally allows 
single selection with long filenames.  If, however, the SHIFT key is pressed while the file open dialog 
is invoked multiple selections are permitted with short file names. 
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FTP† 

FTP Accounts 
This dialog allows user FTP accounts to be configured.  The accounts are used for FTP 
Open and FTP Save As commands. 

An account specifies the server to be connected to and the user identification that will be 
used to connect to the server. 

The New Account button allows you to specify a new account name.  The account to modify 
may be selected from the list of accounts.  If any changes have been made to the account a 
prompt will be shown asking if the changes should be kept. 

The following items may be configured for each account: 

Domain or IP Address 
This is the ftp site that you wish to connect to such as ftp://ftp.idmcomp.com.  This may also 
be entered as ftp.idmcomp.com.  If preferred the IP Address in the form 
xxxx.xxxx.xxxx.xxxx may be entered. 

Name 
This is the username used to log into the server.  The default username is anonymous as 
this is typically used for anonymous log in to FTP accounts. 

Password 
This is the password used with the username to log into the server.  The default username is 
@.  This should be the password for the username as provided by the site administration, or 
for anonymous log in this is typically the e-mail address of the user. 

Save Password 
This checkbox determines if UltraEdit will save the password for later reference.  If not the 
user will be prompted for the password as required.  Note: if the password is saved it is 
stored on the system.  It is encrypted however the encryption mechanism is unsophisticated 
and should not be relied upon as a method of security. 

User Account 
This allows the user to specify an account on the host server when logging.  This is only 
required with some servers. 

                                                        
† FTP is only available in the 32 bit version of UltraEdit. 
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Initial Directory 
This is the initial directory to connect to on the FTP server.  This is not required.  If this is 
NOT specified, UltraEdit will remember the last directory for the account each time the user 
connects to the server.  

FTP/Proxy Port 
This is the port used by UltraEdit for FTP protocol.  The default is 21.  This may be changed 
if required.  If using the proxy it is the port used to connect to the proxy for FTP protocol. 

Proxy/Firewall Settings 
If connecting directly to the Internet the proxy settings should not be enabled.  If connecting 
via a proxy on a LAN it will be necessary to set up the proxy settings. 

Use Proxy 
This enables the proxy settings and configures this account to connect through the specified 
proxy. 

Proxy Server 
This is the name of the server (or IP address) that is used for the proxy.  If you do not know 
this name check with your system administrator. 

The Advanced button provides for additional configuration items for the account. 

Use the Delete button to delete an account. 

FTP Accounts – Advanced 
This dialog allows additional configuration for FTP user accounts.  The accounts are used for 
FTP Open and FTP Save As commands. 

The following items may be configured for each account: 

Cache password for session if not saved 
If this is checked the password for the account once entered is cached for the period 
UltraEdit is running and will not need to be reentered.  If the password is entered incorrectly 
and needs to be changed entering the Accounts dialog and leaving it will clear out the cache. 

Domain or IP Address 
This allows the transfer type of ASCII or Binary to be set for the account.  Binary transfers 
the file byte for byte with no modification.  ASCII causes the file to be appropriately 
converted for line terminations between different systems. 

Passive Transfers 
Some Firewalls require that the passive mode be used to allow connection.  If you have 
trouble connecting to an account via a Firewall it may be necessary to enable the Passive 
Transfer mode. 

If you attempt to connect via FTP and receive the error message “Port Command Failed.  
500 Invalid Port Command” experience has shown that selecting the Passive Transfer mode 
corrects this error in most cases. 
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Server Type 
For most FTP servers the default Auto or Unix should work without problem.  However this 
provides for connection to servers that need special handling.  The list of servers supported 
is expected to grow.  Currently supported are: 

 AIX 

Auto 

File Name Only - this takes the first field returned and displays it as the filename 

OS9000 

Stratus VOS - The "Full Path Leading Character" should be set to "%" and the 
"Path/Node Separator Character" should be set to ">". 

UNIX 

 VAX/VMS 

Full Path Leading Character 
This allows the user to override the leading character (normally /) for the full path of a file on 
the server.  If using a server type other than Normal you should not need to change this. 

Path/Node Separator Character 
This allows the user to override the character (normally /) used between directories/nodes on 
the server.  

If using a server type other than Normal you should not need to change this. 

Open from FTP 
Use this command to open a file via FTP.  This command presents a custom dialog that 
allows selection of the site/account to browse.   

A list of configured accounts is shown and any of the accounts may be selected.  If a new 
account is selected from the list UltraEdit automatically tries to connect to the site and 
browse it. 

A new account must be configured for each site to be connected to as each site may have a 
different name, password, directory etc. 

When the dialog is displayed the browse button will display the list of files for the given site.  
Double clicking on any of the directories shown in the list will attempt to change to the 
specific directory. 

The directory list may be filtered to show a sub-set of files by specify a filter in the "Filter" 
text field.  Additionally the "Hide Directories" check box will cause directories not to be 
shown. 

To open a file, either double-click on the file or select it and click on the Open button.  To 
open multiple files hold the CTRL key and click on the files to be opened.  To open a group 
of files, click on the first file in the list you wish to open and hold the SHIFT key while clicking 
on the last file in the group to be opened.  All files between the first and last file will be 
selected.  The transfer progress will be shown as the file is transferred. 

Additionally the Change Directory button may be used to type in a directory to change to. 

While an operation is in progress a warning will be shown if an attempt to start another 
operation is made, or canceling the dialog is requested. 
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While files are being transferred, or a site is being connected to the dialog will show the 
current status. 

By default after the file is retrieved and open the dialog will be closed if the option Close 
Dialog After Open is set.  This option may be cleared to have the dialog remain open. 

From this dialog additional FTP functionality is available: 

Refresh 
This refreshes (rereads) the directory information from the host server. 

Create Dir 
This creates a new directory on the host server.  No checking of the name or syntax is 
performed; any errors are reported back from the host server. 

Permissions 
This allows the file permissions to be set on a remote file.  This will only work on servers that 
recognize the FTP Site command chmod.  Typically this would only be a UNIX/Linux server. 

Rename 
This renames a remote file or directory on the host server. 

Delete 
This deletes a remote file or directory on the host server. 

Save As to FTP 
Use this command to save an open document/file via FTP.  This command presents a 
custom dialog that allows selection of the site/account to browse.   

A list of configured accounts is shown and any of the accounts may be selected.  If a new 
account is selected from the list UltraEdit automatically tries to connect to the site and 
browse it. 

A new account must be configured for each site to be connected to as each site may have a 
different name, password, directory etc. 

When the dialog is displayed the browse button will display the list of files for the given site.  
Double clicking on any of the directories shown in the list will attempt to change to the 
specific directory. 

The directory list may be filtered to show a sub-set of files by specify a filter in the "Filter" 
text field. 

To save the file, type in the filename or click on an existing filename and click the Save As 
button.  The transfer progress will be shown as the file is transferred. 

While an operation is in progress a warning will be shown if an attempt to start another 
operation is made, or canceling the dialog is requested. 
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While files are being transferred, or a site is being connected to the dialog will show the 
current status. 

From this dialog additional FTP functionality is available: 

Refresh  
This refreshes (rereads) the directory information from the host server. 

Create Dir 
This creates a new directory on the host server.  No checking of the name or syntax is 
performed; any errors are reported back from the host server. 

Permissions 
This allows the file permissions to be set on a remote file.  This will only work on servers that 
recognize the FTP Site command chmod.  Typically this would only be a UNIX/Linux server. 

Rename 
This renames a remote file or directory on the host server. 

Delete 
This deletes a remote file or directory on the host server. 

Revert to Saved 
Use this command to return to the last saved state of the file currently being edited.  In the 
case of multiple changes or untracked changes to a file this can be more effective for 
restoring good data than repeating nested undo’s.  If automatic backup settings cause the 
user to find that the reverted state of the document is not what was expected one should 
check the .BAK file. 

Saving Files 

Save command 
Use this command to save the active document to its current name and directory.  When you 
save a document for the first time, UltraEdit displays the Save As dialog box so you can 
name your document.  If you want to change the name and directory of an existing 
document before you save it, choose the Save As command.   Shortcut:  CTRL+S 

Save As command 
Use this command to save and name the active document.  UltraEdit displays the Save As 
dialog box so you can name your document.  To set a default directory for use by the Save 
As command use the Default Save Directory setting found in Configuration under the 
Advanced menu. To save a document with its existing name and directory, use the Save 
command. 
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Save All command 
Use this command to save all modified documents to their current name and directory.  
When you save a document for the first time, UltraEdit displays the Save As dialog box so 
you can name your document.  If you want to change the name and directory of an existing 
document before you save it, choose the Save As command. 

Save Selection As command 
Use this command to save the current selection to a new file.  UltraEdit displays the Save As 
dialog box so you can name your document. 

Case Sensitive File Names 
UltraEdit will read and write a file without changing the case of the file name.  If you are 
working with a mapped drive, experience has shown that changes to filename case are 
usually due to changes made by the client software used to map the drive. 

You may test this by reading/writing a file to a local disk. 

Make Copy/Backup 
This allows the user to make a backup copy of the active file (with any current changes) 
without affecting the active file. 

The active file maintains the current file name and does not change name unlike the Save 
As command. 

Compare Files† 
This menu item allows two ASCII files to be compared.  The files are compared and if found 
to be identical no further action is taken.  If the files are different, the files are shown in 
separate windows with the differences highlighted. The file comparison performs a line-by-
line comparison.  When the compare files menu item is selected, a dialog box is displayed 
that allows you to select the files to be compared. 

The compare files function is only designed to work with ASCII text files.  If files other than 
ASCII are selected for comparison the results returned are undetermined and should be used 
with caution.  

The file compare dialog allows the user to select the following options: 

Differences in color 
This option will display differences in two different colors, one for lines added and another for 
lines that have been removed.  Additionally, lines will be indicated with a !> if they are new 
in the second file and <! if they have been removed in the second file. 

                                                        
† With the 16-bit version of UltraEdit, the compare feature requires Win32s to be installed.  This function 
will not work on Windows 3.x without Win32s. 
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Differences Side-by-Side 
This determines if the file differences are shown side by side.  In this case, the scroll bar will 
need to be used to see both files.  The side by side view is a combination of the normal 
differences view, and two files being shown vertically side by side with the differences 
appearing on different lines.  The file differences are synchronized so that portions of the 
files that are the same show up beside each other.  

Ignore Blanks 
This option is used to allow the file comparison to ignore differences that are only white 
space characters (spaces, tabs).  If this option is selected, lines are considered identical if 
the only difference is white space. 

Only Show Lines That Differ 
With this option set the window showing the file differences will only show the lines that are 
different between the two files.  Lines that are identical will not show in the window. When 
compare is selected in the dialog, the two files to be compared are opened in the editor and 
shown vertically beside each other.  All other files are minimized. When the file differences 
are shown in the compare window, double clicking on the compare window positions the files 
being compared at the appropriate line within the editor for easy editing. Any changes to the 
files will need to be saved and a new compare performed to update the compare window for 
correct line number positioning. 

The compare function can handle very large files, however it may not be able to handle files 
as large as those that may be edited within UltraEdit due to its memory requirements for the 
compare operation. 

Saving/Printing Output 
Once the compare is complete you may choose to save the output to a file for future 
reference by pressing the Save button or F12 and assigning a file name to the output.  If you 
prefer you may print the output by pressing the Print button. 

Advanced Sort and Options 
This command allows you to set the sort options and perform a sort of the active file.  The 
sort is performed on the complete file.  The UNDO command is not supported with sort 
operations. 

When this option is selected, a dialog is presented with the following options: 

Sort Order 
Ascending  sets the sort for ascending order (a to z, 1-9) and is the default. 

Descending  sets the sort for descending order (z to a, 9-1). 

Remove Duplicates 
If this is checked any lines that are found to be identical to another are removed; the first line 
is preserved.  If the Ignore Case option is set, lines are considered identical if the characters 
are the same with the only difference being the case of them. 
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Ignore Case 
This option should be checked if you want the search to be insensitive to case, i.e. CAT is 
considered the same as cat.  Do not check this option if the sort should consider CAT 
different from cat. 

Starting Column 
You may specify the column at which the sort is to be based.  The options are: 

Column of Cursor or Specific Column Number 
If you select the column of cursor, the sort will be based on the characters at the column 
number the cursor is positioned to at the time the sort is invoked.  Alternatively, you may 
specify the column number (1 being the first column) at which the sort is based.  The default 
behavior is column 1 specified. These options are saved between UltraEdit sessions and are 
used by the Sort File command. 

File Conversion 

UNIX/MAC to DOS 
Use this command to correct the end of line characters for display in UltraEdit and other text 
editors.  Some documents generated from UNIX based systems (and some other systems) 
do not terminate each line with a carriage return and linefeed.  UltraEdit requires all lines to 
be terminated with a carriage return and linefeed character.  

This command searches the file for all carriage return and linefeed characters.  If a carriage 
return character is found without an accompanying linefeed character, a linefeed character is 
added.  If a linefeed character is found without a preceding carriage return character a 
carriage return character is inserted.  If a linefeed is found preceding a carriage return the 
characters are reversed. 

To convert a file to UNIX format, use the DOS to UNIX command. 
To convert a file to MAC format, use the DOS to MAC command. 

DOS to MAC 
Use this command to convert the file to a Macintosh format.  This will replace the carriage 
return and line feed combinations to a carriage return only.   

To convert a file from UNIX or MAC format, use the UNIX/MAC to DOS command. 

DOS to UNIX 
Use this command to convert the file to a UNIX format.  This will replace the carriage return 
and line feed combinations to a line feed only.   

To convert a file from UNIX or MAC format, use the UNIX/MAC to DOS command. 

ASCII to EBCDIC 
This function converts the complete file from ASCII to EBCDIC format.  This is useful in 
dealing with files that need to be exported in the EBCDIC file format (usually on Mainframe 
computer systems).   

To convert a file from EBCDIC to ASCII format, use the EBCDIC to ASCII command. 
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ANSI to OEM 
Use this command to convert a file that uses the ANSI (Windows) character set to the OEM 
(DOS) character set.   

To convert a file from OEM to ANSI, use the OEM to ANSI command. 

ASCII to Unicode 
This function will convert the complete file from ASCII to Unicode (16-bit wide characters). 

The conversion uses the active code page.  For information on code pages see the Windows 
documentation/help. 

The status bar will show a "U-" in front of the file type (DOS/UNIX/MAC) to indicate the file is 
Unicode. 

A file may be converted to ASCII with the Unicode to ASCII command. 

Insert File 
Use this command to insert an existing document (file) into the active document.  This 
command presents a dialog allowing selection of the file to insert.  The complete contents of 
the selected file are inserted in the active document at the cursor position. 

Delete Active File command 
Use this command to close the active document and delete its associated file from the disk. 
This command prompts the user to ensure the file should really be deleted. If the file is 
deleted from the disk, it is no longer available. USE THIS COMMAND WITH CARE. 

Send Mail command 
Use this command to send the active file as a MAIL attachment.  The file and all changes 
are sent.  This feature is only supported on systems that have MAPI mail interface installed. 

Large file handling 
UltraEdit allows editing of files up to 2 GB in size.  This is accomplished with relatively small 
amounts of memory being used.  UltraEdit is a disk-based editor and only loads a small 
portion of the file into memory at one time. 

Normally, UltraEdit copies a file that is being edited to a temporary file, and at the end of the 
editing session deletes the file, after copying back to the appropriate original file.  To speed 
up editing of very large files, the General Options configuration page allows you to specify 
editing without using temporary files.  This removes the time necessary to copy the file to a 
temporary file.  When editing files of many megabytes this can be an advantage. 

WARNING - If this option is selected, all changes are permanent! 

A dialog box is shown warning the user this setting is enabled each time a file is opened.  
Changing the INI settings will disable this.   

A "Threshold" field is provided to allow the user to specify files that are equal or larger than 
this value to be loaded without the creation of the temporary file.  Files smaller than this 
would be loaded normally, creating a temporary file.  Setting the value to zero means that all 
files would be loaded without the creation of the temporary file.  The "Threshold" field is only 
applicable if the option to open files without the temporary file is set. 
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Additionally, the Disable Line Number option improves the performance when navigating 
around large files as less disk access are required to track the line numbers. 

Insert String at Every Increment  
When handling large database type files it is sometimes necessary to split the file into 
“records” or known line lengths as the file has been output without any delimiters/separators 
between records. This feature allows a user-specified string to be inserted at a constant user-
specified increment in the file from some start point in the file to some end point in the file. 

Start Point 
The start point for this operation may be the beginning of the file, or the position of the 
cursor.  This is helpful if the file has a header in it that should not be treated as part of the 
data.  The default behavior is the beginning of the file is the start point. 

End Point 
The end point may be specified as one of the following: 

n the end of the file (default behavior) 

n a known offset into the file 

n after the specified number of records have converted 

n when a particular string is found - In this case the insertion stops at or before the 
beginning of the string if found.  If not found the option to continue or not is given. 

 
Example: 

A data base file has records of known length of 2000 characters.  Each record has been 
output consecutively with no separation between the records.  For editing purposes, you want 
to put each record onto a single line.  With this feature, you can specify the string to insert is 
“̂ p” (insert a new line - paragraph) and that the increment at which to insert the string is 
every 2000 characters.  UltraEdit will add the new line at the end of each record until the end 
of file is encountered. 

Print command 
Use this command to print a document.   This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.  Shortcut Keys: CTRL+P 

Print All Files command 
This command prints all the open documents with the current page setup and printer 
settings.  To change the settings use the Page Setup or Printer Setup commands from the 
File Menu. 
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Print Preview command 
Use this command to display the active document as it would appear when printed.  When 
you choose this command, the main window will be replaced with a print preview window in 
which one or two pages will be displayed in their printed format.  The print preview toolbar 
offers you options to view either one or two pages at a time; move back and forth through 
the document; zoom in and out of pages; and initiate a print job. 

Print Preview Toolbar 
The print preview toolbar offers you the following options: 

Print 
Bring up the print dialog box, to start a print job. 

Next Page 
Preview the next printed page. 

Prev Page 
Preview the previous printed page. 

One Page / Two Page 
Preview one or two printed pages at a time. 

Zoom In 
Take a closer look at the printed page. 

Zoom Out 
Take a larger look at the printed page. 

Close 
Return from print preview to the editing window. 

Page Setup 
The Page Setup menu item presents a dialog allowing the user to set up page headers, 
footers and margins for printing.  The page header, if setup, is printed at the top of every 
page.  The page footer, if setup, is printed at the bottom of every page.  If a page footer or 
header is setup, a single line is printed across the page between the header or footer and the 
text to be printed. 

Selecting the appropriate check box will disable the header or footer.  If the header or footer 
is enabled, the separator line that is normally printed between the header/footer and the 
page text may optionally be disabled. 

The page header and footer may include text defined by the user, and additionally special 
characters to allow the filename, and page numbers to be printed in the header or footer. 
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The special characters are: 

 &f  This is replaced in the header or footer with the full filename including path. 

 &n  This is replaced in the header or footer with the filename only (no path). 

 &p  This is replaced in the header or footer with the page number. 

&t  This is replaced in the header or footer with the total number of pages. 

 &l  This aligns the text following the “&l” to the left side of the header/footer area. 

 &c  This aligns the text following the “&c” to the center of the header/footer area. 

 &r  This aligns the text following the “&r” to the right side of the header/footer area. 

 (Note - the alignment characters are not required, and any or all of them may 
appear in a single header or footer.  However, if more than one is present, they 
must be in the order above (“&l” must be before “&c” and “&c” must be before 
“&r”).  

Additionally, the header or footer may include the file date and time or system date and time.  
Two radio buttons allow the selection of either the file date or the system date to be included 
in the header or footer.  The radio buttons select the source of the date and time.  Additional 
special characters used in the header or footer specify if the date and time are to be printed 
and what format is used. 

The characters used to specify the time and date format are shown below; the absence of 
any of these characters result in the time and date not being printed. 

The formatting codes for date and time are listed below:  

Format Description 
%a Abbreviated weekday name 
%A Full weekday name 
%b Abbreviated month name 
%B Full month name 
%c Date and time representation appropriate for the locale 
%d  Day of the month as a decimal number (01-31) 
%H Hour in 24-hour format (00-23) 
%I Hour in 12-hour format (01-12) 
%j Day of the year as a decimal number (001-366) 
%m  Month as a decimal number (01-12) 
%M  Minute as a decimal number (00-59) 
%p  Current locale’s AM/PM indicator for a 12-hour clock 
%S  Second as a decimal number (00-59) 
%U  Week of the year as a decimal number, with Sunday as the first day of the week (00-51) 
%w Weekday as a decimal number (0-6; Sunday is 0) 
%W  Week of the year as a decimal number, with Monday as the first day of the week (00-51) 
%x Date representation for current locale 
%X  Time representation for current locale 
%y Year without the century as a decimal number (00-99) 
%Y Year with the century as a decimal number 
%Z  Time zone name or abbreviation; no characters if time zone is unknown 
%%  Percent sign 

 
 

Examples: 

Date is July 4th 1994.  Time is 9:00pm 
“%X , %x”   prints  “21:00 , 07/04/94” 
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Date is July 4th 1994.  Time is 9:00pm 
“%c”  prints  “07/04/94 21:00” 

 
Date is Jan 10th 1991.  Time is 5:00am 
“%A, %B %d, %Y %I:%M%p”  prints   Tuesday, January 10, 1991  05:00:am 

Page Margins 
The page margins may be set up in either inches or millimeters (mm).  Each margin - top, 
bottom, left and right - may be set independently.  The margins are applied before the 
headers and footers are generated.  If the printer is set up to have a minimum margin that is 
greater than the margin selected in UltraEdit the printer margin will be in effect. 

Page Break Character 
The page break character may be set to any ASCII character.  The page break character 
defaults to a form-feed character, 12 (0C HEX).  This character may be changed if required 
but should not be set to any printable character, as a page break will be inserted on every 
occurrence of this character when printing occurs.  It may be desirable to change this 
character if the font being used does not allow the page break character to be seen. 

Wrap Text When Printing 
Setting this option will cause the printed output to automatically wrap the text to additional 
lines of any line that exceeds the width of the printable area of the page. 

Print Line Numbers 
Setting this option causes the line numbers to be printed for each line on the left-hand side of 
each page. If a line is wrapped, the line number is printed with the first line only.  This setting 
is independent from the Display Line Number setting. 

Print 2 Pages on 1 Sheet 
This option allows two logical pages to be printed on a single sheet of paper.  The logical 
page data is scaled to print two pages side-by-side.  This scaling may mean that a little more 
or less data may fit side-by-side than when the pages are printed on a single sheet. 

This option is particularly useful for saving paper on printouts. 

Print Syntax Highlighting 
This option allows pre-configured Syntax Highlighting to be shown when the selected 
document is printed. 

Print Setup 
Use this command to select a printer and a printer connection.  This command presents a 
Print Setup dialog box, where you specify the printer and its connection. 

Print Setup Dialog Box 
The following options allow you to select the destination printer and its connection. 
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Printer 
Select the printer you want to use.  Choose the Default Printer; or choose the Specific Printer 
option and select one of the currently installed printers shown in the box.  You install printers 
and configure ports using the Windows Control Panel.  

Orientation 
Choose Portrait or Landscape. 

Paper Size 
Select the size of paper that the document is to be printed on. 

Paper Source 
Some printers offer multiple trays for different paper sources.  Specify the tray here. 

Options 
Displays a dialog box where you can make additional choices about printing, specific to the 
type of printer you have selected. 

Network 
Choose this button to connect to a network location, assigning it a new drive letter. 

Favorite Files 
The Favorite Files feature allows a user to store the filenames of frequently opened files, or 
favorite files that the user wishes to quickly reference and open in the future. 

When the Favorite Files menu item is selected, a dialog is displayed that allows the user to 
open one or more of the favorite files and modify the list of favorite files. 

The dialog shows a list of files that are currently in the favorite file list.  The following 
controls are used to manage the list: 

Open 
The open button opens the selected files from the list and closes the dialog.  Multiple files 
may be selected from the list and opened at once.  Any changes to the list are saved.  
DOUBLE CLICK of any files in the file list will perform the open command. If one of the 
selections is a directory, a file open dialog is shown initialized to the specified directory. 

Close 
The close button closes the dialog.  Any changes to the list are saved. 

Add File 
The add file button presents a file open dialog allowing the user to browse for a file to add to 
the list.  If a valid file is selected the file is added to the list. 
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Add Active File 
The add active file button adds the filename of the active file in the editor to the file list. 

+All Open Files 
The +all open files button adds the filenames of all files in the editor to the file list. 

Add Directory 
The add directory button allows a user to browse for a directory and add this to the list.  This 
allows the user to quickly open files from a favorite directory. 

Remove File 
The remove file button removes any selected files from the file list. 

Recent Files 
Use this command to select the document you wish to edit from up to 16 of the most recently 
edited documents.  The number of documents shown here is configurable in the General 
Configuration dialog under the Advanced menu†.  Select the document you wish to edit by 
highlighting and clicking on it in the sub-menu that appears when you click on Recent Files.  
Note: The files shown in this submenu may be appended to the File Menu by selecting the 
appropriate option on General Configuration Page.  This requires restarting UltraEdit.  
Please see the General Configuration Page section for more details. 

Recent Projects/Workspaces 
Use this command to select the project you wish to edit from the most recently edited 
projects.  Select the project you wish to edit by highlighting and clicking on it in the sub-menu 
that appears when you click on Recent Projects.  The number of projects viewable here 
matches the number of recent files set in the General Configuration dialog.  Note: The 
Project menu may be moved to this position as a submenu with the Recent Projects 
appended to the end of the Project menu by selecting the appropriate option on the General 
Configuration Page.  This requires restarting UltraEdit.  Please see the General 
Configuration Page section for more details. 

Exit command 
Use this command to end your UltraEdit session.  You can also use the Close command on 
the application Control menu.  UltraEdit prompts you to save documents with unsaved 
changes. 

Shortcuts: Mouse: Double-click the application’s Control menu button. 

       Keys: ALT+F4 

                                                        
† This is limited to the four most recent files and is not user-configurable in the 16-bit version of 
UltraEdit. 
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Chapter 2 Edit Features 
This section describes the edit features available within UltraEdit.  It will explain how to move 
within files and include basic and advanced examples for editing files within UltraEdit. 

The following topics will be covered: 

Edit Menu Commands 
Cursor (Moving in File): 

Cursor Movement 
Selecting/Highlighting Text 
Insert Mode 
Overstrike Mode 

Undo/Redo commands 
Cut/Copy/Paste commands 
Drag and Drop Editing Features 
Select All command 
Select Line command 
Select Range command 
Blocking Text   
Hex Editing (Please see Hex Editing section) 
Date/Time Insertion 
Spell Checking a File 
Read Only Files 
Word Wrap 

Edit Menu Commands 
The Edit menu offers the following commands: 

Undo   reverses the previous editing operation 

Redo   reverses the previous UNDO command 

Cut    deletes data from the document and moves it to the clipboard 

Copy   copies data from the document to the clipboard 

Paste   pastes data from the clipboard into the document 

Cut & Append deletes data from the document and moves it to the clipboard 
appending it to any existing data in the clipboard 

Copy & Append copies data from the document and moves it to the clipboard 
appending it to any existing data in the clipboard 

Copy File Path/Name  copies the full pathname of the active file to the clipboard 

Clipboards   allows the user to select the active clipboard 

Select All   selects all the text in the active document 

Select Line   selects the line with the cursor 

Select Word  selects the word with the cursor 

Select Range  selects a user specified range 

Delete   deletes the selected text or character at cursor 

Delete Line   deletes the line with the cursor 

Delete to Start of Line deletes from the cursor position to the start of line 

Delete to End of Line deletes from the cursor position to the end of line 
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Date/Time   inserts date/time at the cursor position 

Hex Edit toggles the state of the editing mode for the current window 
between HEX and ASCII 

Hex Insert/Delete presents a dialog allowing insertion or deletion of bytes in a file 
while in HEX editing mode 

Spell Check invokes the spelling checker, and checks the complete file or 
selected text 

Read Only   toggles the READ ONLY state of the active file 

Toggle Word Wrap automatically wraps words to the next line at the horizontal edge 
of the active window, or at a specified column  

Comment Add adds line comments to selected lines 

Comment Remove removes line comments from selected lines 

Insert Color inserts a color value into the document 

Cursor Movement 
Following are several methods for moving the cursor within a document in UltraEdit: 

Cursor Arrows 
The “up”, “down”, “right” and “left” arrows will move the cursor one character or line as 
indicated.   

Holding down the CTRL key while using the “left” and “right” cursor arrows will move the 
cursor left and right to the beginning of the previous/next word. 

Holding down the CTRL key while using the “up” and “down” keys does not affect the cursor 
position, but moves the text within the editor window up or down respectively.  If the text is 
moved enough for the cursor to meet the upper or lower edge of the editor window the cursor 
will then move from line to line as it does when normally using the “up” and “down” arrows. 

Home and End 
The “Home” key moves the cursor to the beginning of the line the cursor is on.  Holding 
down the CTRL key while using the “Home” key moves the cursor to the beginning of the 
document. 

The “End” key moves the cursor to the end of the line the cursor is on.  Holding down the 
CTRL key while using the “End” key moves the cursor to the end of the document. 
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Scrolling 
UltraEdit supports several methods for scrolling.  These are listed below: 

Vertical Scrolling 
Vertical scrolling is performed with one of the following methods: 

Vertical scroll bar 

IntelliMouse Support 

Ctrl+Up/Down arrows for scrolling up or down by one line while leaving the cursor on the 
current line 

Horizontal Scrolling 
Horizontal scroll bar 

Undo command 
Use this command to reverse the last editing action, if possible.  UltraEdit supports multiple 
levels of undo (the specific number varies based on the items being undone).  Repeated 
Undo commands will attempt to step backwards through the previous commands and undo 
one at a time.  The Redo command may be selected to redo a command that has been 
undone.  If commands are undone and then a new command is performed, the Redo will no 
longer allow previously undone actions to be redone.  Shortcut:   CTRL+Z or ALT-
BACKSPACE 

Redo command 
The Redo command allows commands that have previously been undone with the Undo to 
be redone.  If commands are undone and then a new command is performed, the Redo will 
no longer allow previous undo actions to be redone.  Shortcut:   CTRL+Y 

Cut command 
Use this command to remove the currently selected data from the document and put it on 
the clipboard.  This command is unavailable if there is no data currently selected. 

If the Cut & Append to clipboard is selected the data is appended to the contents of the 
clipboard otherwise cutting data to the clipboard replaces the contents previously stored 
there. 

Shortcut:  CTRL+X 

Copy command 
Use this command to copy selected data onto the clipboard.  This command is unavailable if 
there is no data currently selected. 

If the Copy & Append to clipboard is selected the data is appended to the contents of the 
clipboard otherwise copying data to the clipboard replaces the contents previously stored 
there. 

Shortcut:   CTRL+C   
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Paste command 
Use this command to insert a copy of the clipboard contents at the insertion point.  This 
command is unavailable if the clipboard is empty.  Shortcut:   CTRL+V 

Clipboards (Normal, 1-9) 
UltraEdit provides up to nine user clipboards for use with the Cut, Copy and Paste 
commands as well as the standard Windows Clipboard.  The active clipboard may be 
changed from the Edit Menu, or the Right Click context menu. 

When changing the active clipboard the contents of the clipboards are not modified.  With 
the exception of the standard Windows Clipboard the contents of the clipboards are 
destroyed when UltraEdit is closed. 

Text Selection/Highlighting 
Holding down the “Shift” key while cursoring with the arrows as described above highlights 
the text the cursor passes showing that the highlighted text is selected for edit. 

Holding down the CTRL and the “Shift” key while using the left or right cursor arrows 
highlights one complete word at a time for editing, moving to the beginning of the 
previous/next word as described above. 

Holding down the CTRL and the “Shift” key while using the up or down cursor arrows 
highlights all text between the starting and ending position of the cursor. 

Holding down the CTRL and the “Shift” key while using the “Home” key will highlight all text 
from the beginning cursor position to the beginning of the document being edited. 

Holding down the CTRL and the “Shift” key while using the “End” key will highlight all text 
from the beginning cursor position to the end of the document being edited. 

Insert/Overstrike Modes 
UltraEdit allows editing in both insert and overstrike modes. The mode of operation is 
indicated in the status bar at the bottom right of the UltraEdit window. The insert/overstrike 
mode is changed with the INSERT key.  The mode is toggled when the INSERT key is 
pressed. 

If insert mode is selected, the second area of the status bar is clear, if overstrike mode is 
selected, the second area of the status bar shows ‘OVR’. 

Insert mode causes a key to be inserted into the document at the position of the cursor. 
Overstrike mode causes the character immediately to the right of the cursor to be 
overwritten by the new character. 

If the active editor window is in HEX mode, the active window is always in overstrike mode.  
To insert text in HEX mode, use the HEX Insert/Delete selection from the Edit menu or the 
keyboard shortcut CTRL + D. 

Select All command 
The Select All command highlights the complete file. This allows the user to select the 
complete file and Cut it to the clipboard.  Use the Select Line command to select a single 
line.  Shortcut:   CTRL+A 
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Select Line command 
The select line command highlights the line in which the cursor is positioned.  The end of line 
characters are also highlighted.  This allows the user to select a line and Cut it to the 
clipboard.  Alternatively, triple clicking with the left mouse button will also select a line. 

Use the Select All command to select the complete file. 

Selecting Text 
UltraEdit allows the user to select text by double clicking the primary mouse button (usually 
the left button).  Normally a single word is selected made up of any alphanumeric character 
or underscore _.  If at the time the primary mouse button is double clicked the control key is 
pressed, a string is selected rather than just a single word.  This can be very useful in 
selecting filenames, e-mail addresses etc.  The characters that delimit the string are 
configurable in the General Options configuration page.  This function works on a single line 
only.  The delimiter entries, one for the left edge of the text to be selected and one for the 
right edge, specify what characters should be used to stop any further text from being 
selected.  If a space only is specified in each field all text either side of the cursor position 
will be selected until a space is encountered. 

If text is selected when the right mouse button is pressed, a new menu item Open File 
Highlighted is added to the top of the pop-up menu and if selected the file is opened if it 
exists. 

UltraEdit provides several methods for selecting (highlighting) text.  In general, using the 
Shift Key and cursor keys will select text as will using the Shift Key and mouse positioning.  

Additionally, there are several other methods that make it easier to select a range of text. 

When the Shift Key is pressing at the same time as performing the following functions the 
current selection (if present), or a new selection will be extended to select text up to the 
cursor position following the command: 

 Find Next/Previous 

Goto 

Goto Bookmark 

The Shift Key should be pressed at the time the action for command takes place, not on the 
command that shows the dialog.  For example, if Ctrl+G displays the Goto Dialog and OK is 
clicked to perform the Goto, the Shift Key is pressed when the OK is clicked, NOT when the 
Ctrl+G is pressed to display the dialog. 

Blocking Text 
In Column Mode the operation of the editor is changed for selecting text.  When column 
mode is selected highlighted text is based on the character column position of the first 
character selected to the column of the last character of text selected.  Text selected in this 
mode does not automatically include all text between the start and end position, but includes 
all text in the columns between the first and last character selected.  Column mode editing is 
sometimes referred to as block mode editing as the act of selecting text forms a rectangle. 

Select Range 
This presents a dialog allowing the user to specify a range within the file that should be 
selected/highlighted. 

The user is able to specify the line and column for the start and end of the selection.  When 
the dialog is first displayed the entry fields default to the current selection. 
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If not in Column Mode, UltraEdit will switch automatically to Column Mode if the start and 
end columns are specified with different values. 

Drag and Drop Editing 
UltraEdit supports dragging and drop editing using the mouse.  Drag and drop editing allows 
the user to select text in the normal manner and then copy or move the selected text by 
dragging it to a new location with the mouse.  No keyboard interaction is required. 

Initially the user selects text in the normal manner.  Once text has been selected, the user 
may click the primary mouse button (usually the left button) on the selected text, at which 
time the mouse pointer changes to a pointer with a small dotted rectangular box at the 
bottom of the pointer.  This pointer indicates you are in the drag and drop editing mode and 
may drag the selection to a new location. 

While keeping the primary mouse button down the selected text may be dragged to a new 
location.  As you move the mouse the cursor will follow the mouse and the cursor indicates 
the new position of the text if you stop pressing the mouse button (and “drop” the text). 

The user may even drag the text from one file to another within UltraEdit.  If the mouse is 
positioned over a different file within UltraEdit, that file will become active and the text may 
be dropped into that file at the cursor position shown. 

At any time, pressing ESCAPE will cancel the drag and drop mode. 

Additionally, instead of moving the text being dragged it may be copied to a new location.  If 
at any time while in the drag and drop mode the CTRL key is pressed and held the mouse 
pointer changes to have a small ‘+’ symbol beside it indicating the text will be copied to the 
new location indicated by the cursor and also remain in the original position. 

Drag and Drop editing is supported in normal, HEX and Column editing modes. 

Drag and Drop Files 
UltraEdit supports dragging and dropping files from the File Manager into an open session of 
UltraEdit.  Files may be selected from the File Manager (multiple files may be selected) and 
dragged into the UltraEdit window.  If the mouse button is released with the mouse over 
UltraEdit’s window the files selected will automatically be opened for editing with UltraEdit. 

Delete 
The delete command deletes the selected text or if no text is selected it deletes the 
character at the cursor. 

Delete Line 
The delete line command deletes the line in which the cursor is positioned.  The end of line 
characters are also deleted. 

Use the Select Line command to select the line. 

Delete to End of Line 
The delete to end of line command deletes all contents of the current line from the position 
of the cursor to the end of the line containing the cursor.  Shortcut:   CTRL+F12 
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Delete to Start of Line 
The delete to start of line command deletes all contents of the current line from the position 
of the cursor to the beginning of the line containing the cursor.  Shortcut:   CTRL+F11 

Insert Date/Time 
The insert date/time command inserts the date and time at the cursor position.  The date and 
time are formatted according to the control panel settings.  A single space is inserted 
between the date and time.  To insert only the date or time the Template definition feature 
may be used. 

Hex Mode Editing (Please see Hex Editing section) 

Spelling Checker 
UltraEdit incorporates a 100,000+ word spelling checker.  The spelling checker is invoked 
from the Edit Menu and will check the complete file if text is not selected, or if text is 
selected it will check the selected text. 

If a word is not found in the selected dictionary the Check Spelling Dialog is displayed with 
various options that allow the word to be changed, ignored, or added to a user dictionary. 

The new spelling checker supports different languages.  These languages are selected from 
the Spell Checker Options configuration page.  For further details on Spell Checker options 
and configuration please see the Configuration Features section. 

Read Only Command 
The Read Only command toggles the state of the read only status of the file.  If the read only 
status is set the file cannot be modified.  If the file has already been modified the 
modifications are maintained and the file may be saved. 

The default behavior of the read only status may be configured in the General Configuration 
Page.  This determines if the file is read only when it is opened. 

Word Wrap Command 
The Word Wrap command toggles the Word Wrap settings of the document.  When Word 
Wrap is activated the settings on the Tab/Word Wrap configuration page will control how 
Word Wrap is implemented. 

If the editor active window is in HEX mode, this command is not available.  UltraEdit will 
prompt the user with a dialog box stating that Column/Block editing is only permitted with 
fixed pitch fonts and when Word Wrap is not selected. 

Comment Add/Remove 
These commands allow line comments (as defined in Syntax Highlighting) to be added to or 
removed from the selected lines.  The file being edited must be enabled with Syntax 
Highlighting and line comments must be defined for the particular language. 

If the line comments are appropriately defined, these functions will add the line comment 
characters to the beginning of each line or remove the line comment characters from the 
beginning of each line.  When removing comment characters, the characters will only be 
removed if they are the first characters in the line. 
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Insert Color 
This function allows a user to select a color value and insert it into a document.  The dialog 
allows the user to view or choose a color and then insert the value of the color into the 
document. 

The color value is shown in one of the three specified formats: 

1)  Decimal - This is the decimal value for the color value in RGB (Red,Green,Blue). 

2)  Hexadecimal - This is the hexadecimal value for the color value in RGB 
(Red,Green,Blue). 

3)  HTML - This is the format required for display in an HTML document. The # is added to 
the value. 

When the dialog is first displayed, the color value will default to the selected color (if there is 
a value selected) in the active file.  UltraEdit will try and determine the format of this also 
based on the selection. 

When the user clicks on OK, the Color Value shown will be inserted into the document, 
replacing the current selection if a selection is made. 

Working with “Wide Files” 
UltraEdit allows the user to edit files with lines extending up to 2047 bytes.  At this point 
UltraEdit will “soft wrap” the line meaning that it is wrapped for viewing purposes without 
actually modifying the contents of the line. 

Insert Literal Character (Keyboard Command) 
This command allows a literal character (such as Control C) to be inserted into the file.  
Pressing Ctrl+I tells UltraEdit that the next character is to be inserted directly into the file 
without any translation. 

This is useful for inserting control codes that may be needed by printers or other devices. 

Example: 

Ctrl+I followed by Ctrl+C inserts a Control C character into the file 
Ctrl+I followed by ESC inserts an escape character into the file 
Shortcut:   Ctrl+I 

Right Mouse Button Commands 
UltraEdit allows the right mouse button to display a pop-up menu.  If the right mouse button 
is clicked while in a document window, the Edit Menu is displayed at the position of the 
mouse click.  If text is selected when the right mouse button is pressed, a new menu item 
Open File Highlighted is added to the top of the pop-up menu and if selected the file is 
opened if it exists. 

If no text is selected, UltraEdit will examine the text under the cursor and if it finds what it 
believes may be a file it will add a new menu item "Open " followed be the name of the file it 
will try and open.  If this is a URL the information will be passed to the default browser for 
opening. 

If the right mouse button is clicked while in the UltraEdit main window and outside of a 
document window, the File Menu is displayed at the position of the mouse click. 
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Chapter 3 Hex Editing Features 
This section describes the Hex editing features available within UltraEdit.  This extends the 
capabilities of UltraEdit beyond text editing to allow editing of any binary file. 

The following topics will be covered: 

 

Hex Mode Editing 

Hex Insert/Delete 

Hex Mode Detection 

Hex Mode Editing 
The HEX Edit command selects the editing mode for the active window. The mode is toggled 
between Hexadecimal (HEX) and ASCII. The ASCII mode of editing is typically used for any 
ASCII (text) based files. In the ASCII mode, UltraEdit allows normal operation of all functions 
and allows any characters to be typed. 

The HEX mode of editing is typically used for non-ASCII files, or binary files. These files 
typically contain non-printable characters, and are not text files. 

The following restrictions apply when HEX mode is selected: 

Insert mode is not supported. 
 

When the HEX mode of editing is selected for a given window, UltraEdit splits the screen 
area into three areas as shown: 

File Offset: Hexadecimal Representation    ; ASCII Representation 

000000h: 30 31 32 33 34 35 36 37 38 39 30 31 32 33 34 35  ;123456789012345      

The file offset area shows the current byte offset of the character at the beginning of the line 
to form the beginning of the file.  In HEX mode the ruler shows the offset from the start 
address shown on the left. 

The hexadecimal representation shows the hexadecimal value of each file byte as a two-
character field, separated from the next byte by a space (' '). 

The ASCII representation provides the view of printable characters. Non-printable characters 
are shown with a period character ('.'). 

Editing may be performed in the ASCII area, or the HEX area. Positioning from one area to 
the other is performed by clicking the left mouse button in the appropriate area or by 
pressing the TAB key. The TAB key switches the cursor between the ASCII and HEX area 
and maintains the character offset in the file.  In the HEX area, the only valid characters are, 
0-9, A-F, and a-f. All other characters are invalid and are ignored. In the ASCII area, any 
printable character is valid, and will be accepted with the exception of <CR> and ENTER. 

Editing in either the ASCII area or the HEX area automatically updates the other area after 
each valid character is typed. 

All modifications are performed in OVERSTRIKE mode. 

To insert or delete characters in HEX mode, use the HEX Insert/Delete selection from the 
Edit menu. 

Cut, Copy and Paste are supported in HEX mode.   



 45

Find, Replace, and Replace All are also supported in HEX mode.  Regular expression 
searches within these functions are not supported in HEX mode. 

Shortcut Keys: CTRL+H 

Hex Insert/Delete 
The HEX Insert/Delete command allows the insertion or removal of characters at the current 
cursor position while in the HEX mode.  This command presents a dialog that allows 
selection to insert or delete characters and requires specification of the number of characters 
that are to be inserted or deleted.  If insert is selected, UltraEdit will insert the specified 
number of characters in the file and initialize them to a hexadecimal value of 20 (ASCII 
space).  The characters may then be modified as required.  If delete is selected, the 
specified number of characters will be removed from the file beginning at the cursor position. 

Shortcut Keys: CTRL+D 

Hex Mode Detection 
When UltraEdit opens a document it automatically scans the first 3K for ASCII NULL ‘00’.  If 
UltraEdit detects more than one ASCII NULL in the first 3K of a document it determines that 
it is a binary file and opens it in HEX mode.  

NULLS are not valid in an ASCII file and will be converted to spaces if you edit the file in text 
mode.  

If you view a HEX file in text mode but make no changes UltraEdit should not convert the 
NULLS to spaces, but if you do make changes in text mode to a HEX file the change will 
occur. 

Hex Mode – Line Terminators 
By default a file is recognized as UNIX or MAC when it is loaded and the Status Bar should 
show this.  When the file is loaded it will be converted to DOS (CR/LF) and in HEX mode 
you will see this.  [If the file contains more than one null (Hex 00) in the first 3K it will not be 
treated as UNIX but a binary file and not converted]. 

When the file is saved it will be converted back to UNIX (LF Only) if the "Save File as Input 
format" setting is set in Advanced Configuration. 

The settings in Advanced Configuration default to the above actions. 

If you go to Advanced Menu and Configuration and disable the "Auto Convert Unix Files" this 
will not happen, or you can leave it set and if you want the file saved as DOS format you can 
disable the setting "Save File as Input format". 

Additionally the file may be manually converted from the File Menu.  When converted to 
UNIX or MAC from the file menu the actual conversion takes place when the file is saved but 
the status bar is updated immediately so that you are aware of the format. 
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Chapter 4 Search Features 
This section describes the search features available within UltraEdit.  It explains the methods for 
using the find and replace functions of UltraEdit and includes a section on the use of regular 
expressions to teach the user how to fully exploit these functions.  

The following topics will be covered: 

Search Menu Commands 
Find 

Using the Find Command 
Special Search Characters 
Search Direction 
List Lines Containing String 
Match Case 
Match Whole Word Only 
Regular Expressions 
ASCII Find (in HEX mode) 

Using the Find in Files Command 
Match Case 
Match Whole Word Only 
Search Subdirectories 
Results to Edit Window 
Regular Expressions 

Using the Find Next Command 
Using the Find Previous Command 
Continue Search at End of File 

Replace 
Using the Replace Command 

Special Search Characters 
Find Next 
Replace All 
Replace in Current File 
Replace All Within the Selected Text 
Replace All In All the Open Files 
Match Case 
ASCII Find (in HEX mode) 

Using the Replace in Files Command 
Match Case 
Match Whole Word Only 
Search Subdirectories 
Regular Expressions                 

Match Brace 
Goto Line/Page 
Bookmarks 

Setting/Removing Bookmarks 
Moving Between Bookmarks  

Wordcount 
Function List      
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Search Menu Commands 
The Search menu offers the following commands: 

Find   searches document for a text string 

Find Next   repeats the last find 

Replace searches document for a text string and replaces it with another 
text string 

Find In Files  searches files on disk for a text string 

Replace In Files searches files on disk for a text string and replacees with 
another text string 

Find Matching Brace finds and highlights between matching braces 

Goto Line/Page positions the cursor at the specified line or page break (or file 
position in HEX mode) 

Toggle Bookmark  toggles a bookmark at the current line 

Previous Bookmark  moves the cursor to the previous bookmark 

Next Bookmark  moves the cursor to the next bookmark 

Clear All Bookmarks clears all bookmarks 

Word Count   counts the number of words in the document 

Function List  finds and shows list of functions in the active document 

Find command 
This command displays a dialog box for searching the document for the specified text.  The 
search is performed in the direction specified.  If the string is not found and Continue Find at 
End of File is selected on the General Configuration page, the search wraps around to the 
other end of the file and continues the search.  If the string is not found a message is 
displayed. 

In addition to searching for printable characters, tab characters and new line (Carriage 
Return/Line Feed) characters may be searched for.  To search for a tab character, use “̂ t” 
characters in the dialog.  To search for new line characters, use “̂ p” characters in the dialog.  
To search for a “̂ ” character, use “̂ ^” in the dialog. 

Additionally, the characters “̂ s” will be replaced with any text that is highlighted when a find 
is executed and the characters “̂ c” will be replaced with the contents of the clipboard (up to 
600 characters).  This is useful particularly for macros.  When recording a macro, the option 
exists to include a find of a specified character string, or using “̂ s” the macro records the “̂ s” 
and when replayed will determine the text highlighted at the time the macro is playing back.  
Likewise when using “̂ c”, these characters will be replaced with the contents of the clipboard 
at the time the macro is playing back. 
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Special Character Summary 
  Symbol Function 

  ^^  searches for a “̂ ” character 

  ^s  searches for selected (highlighted) text when a macro is running 

  ^c  searches for the contents of the clipboard when a macro is running 

  ^b  matches a page break 

  ^p  matches a new line (paragraph) 

  ^t  matches a tab character 

Note - ^ refers to the character ‘̂’ NOT Control Key + value. 

To select all text between the cursor position and the search target, hold down the SHIFT 
key at the time the search is started with the FINDNEXT button. 

The following search options exist: 

Search Direction 
The default search direction is down (toward the end of the document). The option to search 
up or down the document is given. If a search has already occurred in the document, the 
default search direction is that of the previous search. 

List Lines Containing String 
This option causes UltraEdit to search for all occurrences of the string in the active 
document and to list them in a dialog box. By double clicking on one of the result lines (or 
selecting it and clicking on Goto) UltraEdit will position to that line in the file. 

Match Case 
By default, the search will not be case sensitive. The option to make the search case 
sensitive is given. If a search has already occurred in the document, the default selection for 
case sensitivity is that of the previous search. 

Match Whole Word Only 
By default, the search will not be restricted to matching whole words only. This option allows 
the search to be restricted to whole words only.  This is useful for searching for ‘a’, or ‘A’ 
without finding all words including ‘a’. If a search has already occurred in a document, the 
default selection will match the previous search. 

Regular Expressions 
See Appendix 2 Regular Expressions for a table of regular expressions. 
If the editor active window is in HEX mode, an additional option exists: 
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ASCII 
By default, in HEX mode, the search will be for hexadecimal characters.  Optionally the find 
may be configured to search for ASCII characters.  When a find operation is complete the 
text is highlighted.  Initially after the find is performed, a slim dialog box is displayed 
enabling easy selection of find and find next. Changing the INI settings will disable this.  
Shortcut Keys: ALT+F3 or Ctrl+F 

Find In Files command 
This command displays a dialog box for searching for a text string in files on a disk.   

The string to search for is specified in the Find field.  The files to search are specified in the 
In Files/Types and Directory fields.  The Directory field specifies the directory to search and 
the In Files/Types field specifies the filename or types.  The filename may contain wildcards 
and may also contain multiple file types separated by semicolons, i.e.: 

 *.cpp;*.h 

The In Files/Types field may also be used to specify a specific list of files to be searched 
separated by semicolons, i.e.: 

  journal.txt; manual.txt; diary.txt 

The following search options exist: 

Search In 

Files Listed 
This will search the files listed in InFiles/Types and Directory fields (default selection). 

Open Files 
This will search all open files.  The InFiles/Types and Directory fields will be ignored. 

Project Files 
This will search all files within the open project.  The InFiles/Types and Directory fields will 
be ignored. 

Match Case 
By default, the search will not be case sensitive. The option to make the search case 
sensitive is given. If a search has already occurred in the document, the default selection for 
case sensitivity is that of the previous search. 

Match Whole Word Only 
By default, the search will not re restricted to matching whole words only. This option allows 
the search to be restricted to whole words only.  This is useful for searching for ‘ a ‘, or ‘A’ 
without finding all words including ‘a’. If a search has already occurred in a document, the 
default selection will match the previous search. 
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Search Subdirectories 
By default, only files specified in the specified directory are searched.  This instructs the 
search to search all sub directories of the specified directory. 

Results to Edit Window 
This option instructs UltraEdit to create an edit window (new file) for the results of the find.  
This allows editing of the results and saving the results.  The default action is to capture the 
output in a list box window (Output Window) that allows the user to double click on the result 
and have the file opened automatically. 

Regular Expressions 
See Appendix 2 Regular Expressions for a table of regular expressions. 
Successive finds update an existing “Find Results” window if it already exists, or creates a 
new window if it does not.  If the window already exists, results are appended to the end. 

Find Next command 
This command repeats the previous FIND command in the forward direction toward the end 
of the file. The next occurrence of the find text will be found (if present) in the forward 
direction. 

To select all text between the cursor position and the search target, hold down the SHIFT 
key at the time the search is started with the FIND NEXT menu item or shortcut key.   

Shortcut Keys:   F3 

Find Previous command 
This command repeats the previous FIND command in the backward direction toward the 
beginning of the file.  The next occurrence of the find text will be found (if present) in 
backward direction. 

To select all text between the cursor position and the search target, hold down the SHIFT 
key at the time the search is started with the FIND NEXT menu item or shortcut key.   

Shortcut Keys:  CTRL+F3 

Continue Search at End of File (General Configuration Page) 
This option determines if the search for a string is to be continued at the opposite end of the 
file if the string is not found.  If this option is not set, UltraEdit does NOT wrap around at the 
end of file when searching for a string.  The default behavior is for UltraEdit to continue the 
search from the opposite end of the file when a target is not found. 

Replace command  
This command displays a dialog box for searching the document for the specified text, and 
replacing it with a different text. The search is performed in the direction specified.  If the 
string is not found, the search wraps around to the other end of the file and continues the 
search.  If the string is not found a message is displayed. 
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In addition to searching and replacing printable characters, tab characters and newline 
(Carriage Return/Line Feed) characters may be searched for or replaced.  To specify a Tab 
character, use “̂ t” characters in the dialog.  To specify the newline characters, use “̂ p” 
characters in the dialog.  To specify a “̂ ” character, use “̂ ^” in the dialog. 

Additionally, the characters “̂ s” will be replaced with any text that is highlighted when a find 
is executed and the characters “̂ c” will be replaced with the contents of the clipboard (up to 
600 characters).  This is useful particularly for macros.  When recording a macro, the option 
exists to include a find of a specified character string, or using “̂ s” the macro records the “̂ s” 
and when replayed will determine the text highlighted at the time the macro is playing back.  
Likewise when using “̂ c”, these characters will be replaced with the contents of the clipboard 
at the time the macro is playing back. 

Special Character Summary 
  Symbol Function 

  ^^  searches for a “̂ ” character 

  ^s  searches for selected (highlighted) text when a macro is running 

  ^c  searches for the contents of the clipboard when a macro is running 

  ^b  Matches a page break 

  ^p  Matches a new line (paragraph) 

  ^t  Matches a tab character 

Regular Expressions 
See Appendix 2 Regular Expressions for a table of regular expressions. 
 

The following replace options exist: 

Find Next 
Find next finds the next occurrence of the specified text. 

Replace 
Replace finds the next occurrence of the specified text and replaces it with the new text. 

The user may also specify “Selected Text” under the “Replace Where” selection and the 
replace will be limited to the selected area. 

Replace All 
Replace all finds every occurrence of the specified text and replaces each occurrence with 
the new text. 

The Replace All provides the additional options: 

Replace in Current File 
This replaces all occurrences within the current file only.  It determines if the replace should 
be from the top of the file, or the cursor position based on the setting in this dialog box. 
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Replace All Within the Selected Text  
This replaces only the occurrences of the string that falls within the area of selected text at 
the time the replace is started. 

Replace All in All the Open Files  
This replaces all occurrences of the string in all open files. 

Match Case 
By default, the search will not be case sensitive. The option to make the search case 
sensitive is given. If a search has already occurred in the document, the default selection for 
case sensitivity is that of the previous search. 

If the editor active window is in HEX mode, an additional option exists: 

ASCII 
By default, in HEX mode, the search will be for hexadecimal characters.  Optionally the find 
may be configured to search for ASCII characters.  When a find operation is complete the 
text is highlighted.  In HEX mode additional characters may be highlighted if the specified 
search string crosses a line.  In this case, all characters displayed from the first character of 
the search string on the first line to the last character of the search string on the last line are 
highlighted.  If a replace is requested, only the search string will be replaced. 

Initially after the replace is performed, a slim dialog box is displayed enabling easy selection 
of find next and replace operations. Changing the INI settings will disable this.  Shortcut 
Keys: CTRL+R 

Replace In Files command 
This command displays a dialog box for searching for a text string in files on a disk and 
replacing it with another text string.  You can specify the string to search for and the files to 
search.  Valid filenames may include wildcard characters, so to search all text files with the 
extension “*.txt” you may specify “path\*.txt” where path is the drive and full directory path to 
the files.  You may also select to search files in sub directories. 

When the find/replace is executed, each file where the find string is found is modified and 
each occurrence of the string is replaced with the replace string.  If the file is read-only, the 
file is not modified and a message box is posted.  At the end of the operation, a dialog box is 
displayed indicating how many times the replace occurred and how many files were 
modified. 

The following search options exist: 

Match Case 
By default, the search will not be case sensitive. The option to make the search case 
sensitive is given. 

Match Whole Word Only 
By default, the search will not re restricted to matching whole words only. This option allows 
the search to be restricted to whole words only. This is useful for searching for ‘ a ‘, or ‘A’ 
without finding all words including ‘a’. If a search has already occurred in a document, the 
default selection will match the previous search. 
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Search Subdirectories 
By default, only files specified in the specified directory are searched.  This instructs the 
search to search all sub directories of the specified directory. 

Regular Expressions 
See Appendix 2 Regular Expressions for a table of regular expressions. 

 

Match Brace 
This command searches forward in the file from the cursor position to find an open or close 
brace.  If an open brace is found, the search continues in a forward direction until a matching 
close brace is found at the same nest level.  If the first brace found is a close brace, the 
search is performed in the reverse direction until a matching open brace is found at the 
same nest level. 

When the matching brace is found all the text between and including the two braces is 
highlighted. 

An open brace is (, [, or {.  A close brace is ), ] and }.  Shortcut Keys: Ctrl+B 

Goto Line/Page 
The Goto menu item presents a dialog that allows the user to specify the line or page break 
at which the cursor should be positioned.  The cursor is positioned at the line specified and 
the line is scrolled into view.  If the line number is greater than the number of lines in the file, 
the cursor is positioned at the end of the file. 

When Page Break is specified, the cursor is positioned at the line with the specified page 
break character. 

When the Shift Key is pressed at the same time as performing the Goto function the current 
selection (if present), or a new selection will be extended to select text up to the cursor 
position following the command. 

In HEX mode the goto dialog allows the user to select the offset into the file at which the 
cursor should be positioned.  If the offset is greater than the file size, the cursor is positioned 
at the end of the file. 

Shortcut Keys: CTRL+G 

Setting and Moving to Bookmarks 
UltraEdit allows you to set a “bookmark” to mark a position in a file. Once a bookmark has 
been set at a line, you may use menu or keyboard commands to move to that line.  

To set a bookmark: 

1. Move the cursor to the line where you want to set a bookmark. 

2. From the Search menu, choose Toggle Bookmark. 

Shortcut Keys: CTRL+F2 

To remove all the bookmarks, use the "Clear All Bookmarks" menu item. 

To move to the next bookmark after the insertion point, choose Next Bookmark from the 
Search menu. Shortcut Keys: F2 

To move to the previous bookmark after the insertion point, choose Previous Bookmark from 
the Search menu. Shortcut Keys: Alt+F2 
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When the Shift Key is pressed at the same time as performing the Goto Bookmark 
function the current selection (if present), or a new selection will be extended to 
select text up to the cursor position following the command. 

Word Count 
The word count feature analyzes the document and determines the number of Words, Lines 
and Non-Space characters in the file and displays the result. 

The number of lines determined are real lines terminated with the line terminator.  If a line is 
wrapped in the display, this is not counted as multiple lines. 

Function List 
This command shows the list of functions in the active document.  The results are displayed 
in a dockable window either in alphabetical order, or in order they occur in the document.  By 
double clicking on one of the result lines UltraEdit will position to that line in the file and the 
focus will change to the file.  If Enter is pressed while focus is in the Function List UltraEdit 
will position to that line and focus will remain in the function list.  Ctrl+Enter will also position 
to the line in the file and the focus will change to the file. 

Optionally the Function List may be set to search all documents in the active project.  This is 
set by right clicking in the Function List and selecting the appropriate menu item. 

Additionally, by right clicking in the Function List the user may select to sort (or not) the 
Function List in alphabetical order. 

UltraEdit searches for a particular pattern to determine if a line is considered a function.  The 
pattern that is searched for is a regular expression string(s) that may be modified by the 
user. 

The regular expression string(s) is defined in the wordfile.txt file and each language may 
have its own definition. 

Note - The regular expression string must use UltraEdit style regular expressions.  This 
ensures that the function list will always work irrespective of the regular expression settings. 

See the Syntax Highlighting section for details on changing the string used for recognizing a 
function. 
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Chapter 5 Project Features 
This section describes the project features available within UltraEdit.  This section will describe 
the uses of the project/workspace features and show the various methods for opening, closing, 
and deleting projects.   

The following topics will be covered: 

Project Menu Commands 
Project/Workspace 
New Project 

Workspace 
Project 

Opening a Project/Workspace 
Closing a Project/Workspace 
Deleting a Project/Workspace 
File Management 

Adding Project/Workspace Files 
Deleting Project/Workspace Files 
Associating Project/Workspace Files 
Accessing Projects/Workspaces 

 
File Menu 

Project Menu       

Project Menu Commands 
The Project menu allows you to manage your projects or workspaces.  This provides an easy 
way to group associated files. 

This functionality combines the grouping of files for quick access via the Files dialog and the 
saving/restoring of the open file’s state. 

New Project  creates and opens a new project file. 

Open Project opens an existing project file. 

Close Project closes a project. 

Files  adds, removes or opens files within the project. 

New Project command 
The New Project command allows you to create a new project/project file.  A project allows 
you to manage your projects or workspaces.  This provides an easy way to manage and 
group associated files.  In many instances a group of files may be related and while editing a 
particular file there may be reason to edit or view other associated files.  These files can be 
grouped as a project/workspace. 

Grouping these files into a project allows you to easily access and/or open all the associated 
files when needed without having to search for them.  The project support provides 
combined project and workspace functionality.  In many cases it may be convenient to use 
the automatic workspace support as described below: 

Workspace 
The workspace functionality saves the state of all open files in the project file when the 
project is closed including window position, cursor position and which files are open. 
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When a project is opened all the files that were previously opened when the project was 
closed are opened automatically.  The files do not have to be specifically added to the 
project via the Files dialog. 

Project 
The project functionality allows files to be associated together even if they are not currently 
open in the editor.   Files may be added to the project or removed from the project via the 
Files dialog.   The files within the project can easily be opened via the Files dialog. 

Open Project command  
The Open Project command allows you to open an existing project that must previously have 
been created with the New Project command.  When a new project is opened the current 
project (if opened) will be closed.  The option will be given to close files that are currently 
open.  When the project is opened, any files that were previously open when the project was 
last closed will be opened automatically. 

Close Project command 
The Close Project command closes the currently opened project.  The state of all files will be 
saved in the project file allowing them to be opened automatically when the project is next 
opened.  The option will be given to close files that are currently open.   

Note:  If the Close All Files command from the File menu is used to close project files all 
files that were open for edit in the project will be stored in a closed state and will not be 
opened the next time the project is used. 

Files  
The project files feature allows a user to store the filenames of files associated to the project 
to allow the user to quickly reference and open in the future. 

When the project files menu item is selected, a dialog is displayed that allows the user to 
open one or more of the files and modify the list of files. 

UltraEdit allows a "Project Directory" to be specified and in conjunction with this the option to 
use "Relative Paths".  If these are set up, UltraEdit will store the filenames relative to the 
project directory allowing the paths to be maintained (by changing the project directory) if the 
user moves the project.  The relative paths must be below the project directory.  Additionally, 
if the "Relative to Project File" setting is checked, the project files will be set as relative files 
to the directory in which the project file resides.  This allows the project file and its files to be 
stored in the same directory and when moved together the project directory would not need 
to be updated. 

In some cases it is advantageous to group multiple sets of files together within a single 
project.  UltraEdit provides for grouping of these files in named groups.  These groups may 
be added or deleted as needed and files may be added to each group.  When a new group is 
created it will automatically include any files currently shown in the Project Files List allowing 
the user to migrate files from an existing project/group to a new group. 

The dialog shows a list of files that are part of the project.  The following controls are used to 
manage the list: 
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New Group 
The new group button presents a dialog box to the user allowing the user to specify the name 
of the group about to be added. 

Delete Group 
The delete group button permanently deletes the currently displayed group from the project. 

Open 
The open button opens the selected files from the list and closes the dialog.  Multiple files 
may be selected from the list and opened at once.  Any changes to the list are saved.  
DOUBLE CLICK of any files in the file list will perform the open command. 

Close 
The close button closes the dialog.  Any changes to the list are saved. 

Add File 
The add file button presents a file open dialog allowing the user to browse for a file to add to 
the list.  If a valid file is selected the file is added to the list.   

Multiple files may be selected by holding the CTRL key and clicking on files with the left 
mouse button.  Alternatively, clicking on one file and holding the SHIFT key while clicking on 
another file will cause all files listed between them to be selected as well. 

Add Active File 
The add active file button adds the filename of the active file in the editor to the file list. 

Remove File 
The remove file button removes any selected files from the file list.  Up to 2000 files may be 
added to a project. 

Optional Wordfile 
The Optional Wordfile entry box allows the user to specify a different wordfile to be used for 
Syntax Highlighting when the project is active.  If the path is fully qualified it will be an 
absolute path to the wordfile, otherwise the path would be a relative path to the project 
directory or project file (based on settings above). 
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Chapter 6 Display Features 
This section describes the display features available within UltraEdit.  It will show the various 
options associated with setting up the user views, fonts, printer fonts, and more. 

The following topics will be covered: 

View Menu Commands 
Toolbar 

Toolbar Options 
Displaying/hiding the toolbar 
Configuring the toolbar (See Configuration section) 

Status Bar 
Displaying/hiding the status bar 
Reading the status bar 

Help Prompts 
Line/Column Number 
File Type 
Read Only 
Date/Time Modified 
File Size / Bytes Selected 
Status Indicators   

File Tabs 
Displaying/hiding file tabs 
Navigating using file tabs 
File tab information (saved/unsaved) 

Output Window 
Displaying/hiding the output window 
Uses for the output window 

Fonts 
Setting display fonts 
Setting printer fonts 
Mirroring the display font 
Fixed pitch font information 

Colors 
Setting window colors: 

Text 
Background 
Bookmarks 
Selected Text 
Selected Text Background 
Line/Column Text 
Line/Column Text Background 

Setting Default Colors 
Tabs/Spaces 

Showing Tabs and Spaces 
Why would I show tabs and spaces? 

Column Markers 
Setting Column Markers 
Displaying Column Markers 
Locking Text Left of the First Column Marker (Fixed Columns) 

Rulers/Line Numbers 
Displaying/Hiding Rulers 
Displaying/Hiding Line Numbers 

ASCII Table 
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Displaying the ASCII Table 
Inserting characters from the ASCII Table 

Tag List 
Tag List Modify 

View Menu Commands 
The View menu offers the following commands: 

Views/Lists    shows a submenu of toggled items 

View as (Highlighting File Type) shows file with selected syntax highlighting 

Toolbar    shows or hides the toolbar 

Status Bar    shows or hides the status bar 

Open File Tabs   shows or hides file tabs 

File Tree View   shows or hides the file tree view 

Function List   shows or hides the function list 

Macro List    shows or hides the macro list 

Tag List    shows or hides the tag list 

Output Window   shows or hides the output window 

Set HEX/Column Mode Font  select the screen font to use for HEX and 
Column Mode 

Set Font    select the screen font to use 

Set Printer Font   select the printer font to use 

OEM Character Set   forces font to OEM Character Set 

Mirror Display Font   use display font for the printer 

Reset Fonts (Default)  reset the screen and printer fonts to default settings 

Set Colors set the screen colors for text, background, bookmarks 
and column markers 

Show Spaces/Tabs show spaces, tabs and new line characters as visible 
characters 

Set Column Markers  set Column Markers 

Show Column Marker 1  enable first column marker defined 

Show Column Marker 2  enable 2nd column marker defined 

No Scroll Left Side of Marker 1 toggle fixed pane/columns left of 1st column marker 

Display Ruler toggle the column ruler indicator at the top of each 
window 

Display Line Numbers  toggle the line number display at the left of each window 

Spacing - Single   view document with single spacing 

Spacing - 1 ½ Spacing  view document with 1 ½ spacing 

Spacing - Double   view document with double spacing. 

ASCII Table   show ASCII table 
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View as (Highlighting File Type) 
This allows the user to override the Syntax Highlighting selection made by UltraEdit based 
on the file extension and view any file as one of the available languages. 

The menu selection allows selection for any of the languages available within Syntax 
Highlighting and a selection of no highlighting. 

If the user uses this feature to override the syntax highlighting the override will stay in effect 
until the file is closed, or saved under a new name. 

Toolbar command 
Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in UltraEdit, such as File Open.  A check mark appears next to the 
menu item when the Toolbar is displayed. 

Toolbar 
The toolbar is displayed across the top of the application window, below the menu bar.  By 
left clicking on the border of the toolbar and dragging one may move the toolbar to another 
position.  Double clicking on the title bar of the toolbar will return the toolbar to its “docked” 
position.  The toolbar provides quick mouse access to many tools used in UltraEdit. 

To hide or display the toolbar, choose Toolbar from the View menu (ALT, V, T). 

The contents of the toolbar are user configurable.  Buttons may be added or deleted via the 
Toolbar in the Configuration page under the Advanced menu.  Please see Chapter 11 
Configuration Features for more details. 

Status Bar command 
Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state.  
A check mark appears next to the menu item when the Status Bar is displayed. 

Status Bar 
The status bar is displayed at the bottom of the UltraEdit window.  To display or hide the 
status bar, use the Status Bar command in the View menu. 

Status Bar Contents (from left to right) 

Help Prompts 
The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.  This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.  If after viewing the description 
of the toolbar button command you wish not to execute the command, then release the 
mouse button while the pointer is off the toolbar button. 
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Line/Column Number 
The line number (if enabled) of the cursor in the file, and the column number are displayed 
together in a single panel.  In HEX mode this displays the cursor position in HEX and 
Decimal values. 

File Type 
The file type indicates if the file is a DOS file, UNIX file or MAC file. 

Read Only 
This field displays “R/O” if the active file is in a Read Only status.  If the file is writable this 
field will be blank. 

Date/Time 
The date and time the active file was last modified (prior to this session).  For new files the 
date and time shown is the creation date and time. 

File Size / Bytes Selected 
This displays the file size of the active file.  The file size is updated when UltraEdit writes any 
changes to the disk.  If a portion of the active text is selected this field will display the 
number of bytes selected. 

Status Indicators 
The right areas of the status bar indicate which of the following keys are latched down: 

Indicator Description 

OVR the overstrike mode is selected 

CAP the caps lock key is latched down 

Insert/Overstrike Modes 
UltraEdit allows editing in both insert and overstrike modes. The mode of operation is 
indicated in the status bar at the bottom of the UltraEdit window. The insert/overstrike mode 
is changed with the INSERT key. The mode is toggled when the INSERT key is pressed. 

If insert mode is selected, the second area of the status bar is clear, if overstrike mode is 
selected, the second area of the status bar shows ‘OVR’. 

Insert mode causes a character to be inserted into the document at the position of the cursor. 
Overstrike mode causes the character immediately to the right of the cursor to be 
overwritten by the new character. 

If the editor active window is in HEX mode, the active window is always in overstrike mode.  
To insert text in HEX mode, use the HEX Insert/Delete selection from the Edit menu. 
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Open File Tabs† 
This menu item enables or disables the TAB control that allows the user to select between 
open documents.  The tab control allows easy selection between open documents while 
maintaining all other window switching and display functionality. 

If you right click on the open file tabs a pop-up menu is displayed with several file options. 

The TAB control may be dragged from its default docked position at the top of the main 
window and docked at the bottom of the window, or left standalone.  If it is standalone, it may 
be resized vertically and horizontally as desired. 

When the TAB control is in its default docked position, scroll arrows appear if more 
documents are open than can be displayed. 

The TAB control may be resized.  If resized while docked so that more than one row of tabs 
is shown the scroll arrows will no longer be available. 

Right clicking on an open file tab will allow the file tabs to be sorted.  These will be sorted 
alphabetically when the command is performed.  Due to the operation of the underlying 
control used, if multiple lines are displayed the underlying control will reorder the ROWS of 
tabs but internally keep the order the same.  This means that the sort will work but the rows 
may not be in order and will change order if a file from a different row is selected.  

Using File Tabs 
File tabs allow the user to open multiple files at once and easily keep track of files currently 
in use.  By left clicking on a file tab one may move from one file to another. 

Right clicking on a file tab will open a special menu with the following options: 

Close 
Save 
Save As 
Conversions > 
Special > 
Print 
Print Preview 
Restore 
Minimize 
Maximize 

       
This “short” version of the File menu lists the most-used file functions.  If all files are 
minimized, choosing “maximize” from this menu will maximize all open files. 

File Tree View† 
This menu item enables or disables the File Tree View. 

The File Tree View shows a list of files or directories for the selected drive in a tree type 
format.  The Drive/File List shows the drives available and additionally allows a selection for 
displaying all the open files or files in the current project. 

Double clicking on any of the files in the Tree View will open or activate the file.  Multiple 
files may be selected and opened at once.  (To select multiple files, use the left mouse 
button and the shift key to select between two files, or the control key and the left mouse 
button to select multiple non-contiguous files). 

                                                        
† This feature is only available in the 32-bit version of UltraEdit. 
† This feature is only available in the 32-bit version of UltraEdit. 
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The "Filter" entry box allows the user to specify a file filter that will be applied to the files 
shown when viewing one of the drives.  It does not apply when showing project or open files. 

Several functions are available by right clicking on the appropriate file.  These are 
dependent on the list being shown.   

Open Files 
If the list of files shown is the currently open files the following functions are available when 
the right click menu is shown. All of the functions below work on ALL the selected files: 

 Close 

 Save 

 Print  

Tile Horizontal  

 Tile Vertical  

Project Files/Drive 
If the list of files shown is the currently open files the following functions are available when 
the right click menu is shown: 

 Open Selected File - This will open the selected file(s) in the editor. 

 Properties - This displays the normal file properties shown in Microsoft Explorer. 

Common 
At any time right clicking on the Tree View will provide options to hide the view, or to disable 
the docking.  If it is not docked it will show as a window unattached to other windows. 

Function List 
This menu item enables or disables the Function List.  Selection of this item only makes the 
Function List visible; it does not populate the Function list.  If the list has not been populated 
the message “No Functions!” will be displayed in the Function List.  To list the functions in a 
file select Function List from the Search menu or press F8. 

Macro List 
This menu item enables or disables the Macro List.  If no macros are available for use (see 
Load and Set Auto Load commands under Macro menu) the message “No Macros!” will be 
displayed in the Macro List.  Double clicking on macros displayed in the Macro List will 
activate them. 

Right clicking in the Macro List will display a menu with the following options: 

Modify Macro  invokes the Modify Macro dialog  

Allow Docking allows the Macro List to be docked outside of the UltraEdit 
window 

Hide   hides the Macro List 
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Tag List  
This menu item enables or disables the Tag List showing predefined "tags". A tag is simply a 
short string of characters and the name "tag" is used as this feature is commonly used for 
"HTML Tags". 

The purpose of the tag list is to provide a method to easily insert into a document commonly 
used tags/strings without having to type them.  The Modify button allows the list of tags to be 
modified.  

To insert a tag, select the tag you wish to insert and click on insert or double click on the tag.  
When the tag is inserted into the active document, the start tag (if defined) is inserted at the 
beginning of any text selected and the end tag (if defined) is inserted at the end of the 
current selection.  If no selection is made the tags are inserted at the cursor location. 

Multiple groups of tags may be defined and the group may be selected from the drop-down 
list. 

The dialog is "non-modal" and can be displayed while continuing to edit the document - it is 
not necessary to close it to continue editing. 

Tag List Modify 
Right clicking in the Tag List and selecting Modify Tags allows the Tag List to be modified. 

The filename field must be filled in.  This is the file used for storing the tags.  A New File 
may be created or the Browse button may be used to select an existing tag list file. 

The tags may be split into groups for association.  At least one group must exist to add any 
tags and this may be defined with the New Group button.   

Each tag may have a start and end tag.  The tags are entered in the boxes provided and can 
be inserted to the tag list with the Add Tag button or may be used to replace the selected 
tag. 

Clicking on an existing tag in the list will fill in the Begin Tag and End Tag boxes for easy 
modification. 

When a New Group is added or a different group selected a prompt is issued asking if any 
changes made should be saved. 

Creating Custom Tag Lists 
During installation UltraEdit-32 creates a file called taglist.txt in the directory to which 
UltraEdit is installed.  If you are not sure where this file is located you can find the path to 
"taglist.txt" by typing CTRL+F8 to activate the Tag List dialog and pressing the Modify 
button.  The full path of taglist.txt will be displayed at the bottom of the dialog box in a 
textbox labeled "Filename:". 

The Tag List file contains three section labels: 

? ? [TagList] 
? ? [Group List] 
? ? [Tag Group] 

[TagList] 
This identifies the most recently used tag group.  If you are creating a new tag list you do not 
have to have this section label in your tag list; UltraEdit will add it.  However, if you do not 
have an ActiveGroup specified here the Tag List dialog will appear blank until you select a 
tag group from the combo box at the bottom of the dialog. 
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If you do want to specify a tag group to appear in the Tag List dialog on startup it should be 
specified as follows: 

[TagList] 

ActiveGroup=HTML - Tags 

[Group List] 
This identifies the list of all Tag Groups that will be recognized in the rest of the file and 
displayed in the Tag List dialog.  It is important that Tag Groups are referenced exactly as 
they appear in the Tag Group header described below.  If they are not referenced exactly as 
they appear in the Tag Group header they will not be displayed in the Tag List dialog.  
Example: 

[Group List] 

0=HTML - Special Characters 

1=HTML - Tags 

2= 

[Tag Group] 
This will head each language-specific tag group (e.g.): 

[Tag Group - HTML - Special Characters].  Without this section header, UltraEdit will not 
recognize a tag list. 

Please note: Format IS important.  If you choose to create your own tag list please ensure 
that you follow these guidelines. 

All lines in a tag group must be preceded by sequential line numbers starting with a "0" at the 
beginning of the tag group.  The line number must be followed by an equal sign and terms 
defined for the tag group must be enclosed in double quotes (e.g.): 

0="&Aacute;" 

1="&aacute;" 

2="&Acirc;" 

For languages that allow open and close tags you may list both so that text may be 
highlighted and tags may be inserted bracketing the selected text.  Please specify these tags 
as follows: 

0="<!-- ... -->" 

1="<A> ... </A>" 

2="<A HREF=> ... </A>" 

Adding Individual Tag Lists 
 

If you wish to add tag lists to the default taglist.txt for UltraEdit-32 please append the tag list 
you download at the end of the file taglist.txt. 

[Group List] 

0=COLD FUSION - Tags 

1=HTML - Special Characters 
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2=HTML - Tags 

Any tag lists you append to taglist.txt must be listed under "[Group List]" to be active.  The 
full group name should follow the number assigned to the tag group.  Ensure you type the 
entire description that appears at the top of the tag group in the brackets (i.e. for Cold Fusion 
you would type "0=COLD FUSION - Tags"). 

[Tag Group - HTML - Special Characters] 
Any tag group you add must have a header as shown above.  All information between "[Tag 
Group - " and the closing bracket "]" should be used to identify your tag group under [TagList] 
and [Group List]. 

Replacing the Default Tag List with Any Available Tag List  
If you wish to replace the default Tag List with any available tag lists please rename 
taglist.txt to taglist.bak and open the selected file and copy it to taglist.txt in the directory 
where you have installed UltraEdit. 

Output Window  
This menu item enables or disables the Output Window.  The Output Window is used to 
capture the output from user tools (see Tools Configuration) or from the Find in Files output. 

Double clicking on a line containing the filename and line number will cause UltraEdit to 
attempt to open the file specified at the line number.  If the filename is fully qualified the 
filename will be located and the number after this will be used for the line number.  If the 
filename is not fully qualified UltraEdit will attempt to determine the filename from the first 
word in the line that contains a period.  UltraEdit will the open the specified file in the 
directory of the active file. 

Double clicking on one of the result lines will cause UltraEdit to position to that line in the file 
and the focus will change to the file.  If Enter is pressed while focus is in the Output Window 
UltraEdit will position to that line and focus will remain in the Output Window.  Ctrl+Enter will 
also position to the line in the file and the focus will change to the file.  

With the release of v6.20 the Output Window includes two added Context menu (right-click) 
options: Clear Output and Copy to Clipboard.   

Set HEX/Column Mode Font 
The Set Hex/Column Mode Font menu item presents the Choose Font dialog box that allows 
selection of different fonts and font sizes.  The selection made will apply when editing in HEX 
mode or in Column mode.   UltraEdit will automatically switch to this font when HEX or 
Column modes are selected. 

For normal font selection use Set Font from the View Menu. 

Set Font  
The Set Font menu item presents the Choose Font dialog box that allows selection of 
different fonts and font sizes.  The selection made will be applied to the screen fonts and the 
printer font if the Mirror Display Font menu item is checked on the View Menu.  If this item is 
not checked, the printer fonts have been selected independently from the screen fonts. 

Font selections may be reset to default values by selecting the Reset Fonts menu item. 

Note:  If the printer does not support the selected font, Windows automatically adjusts to the 
closest font. 
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Font dialog box 
The Font dialog is presented when fonts are selected from the View Menu.  It will be 
presented if either Set Font or Set Printer Font is selected. 

The Font dialog presents a selection of installed fonts that may be selected for use.  If the 
fonts are being selected for the printer, only fonts applicable to the printer are available.  
Selection of font and font size is available. 

Mirror Display Font 
The Mirror Display Font menu item instructs UltraEdit to use the font that is selected for the 
screen when printing.  This overrides any font selection already made for the printer with the 
Set Printer Font menu item.   

Set Printer Font 
The Set Printer Font menu item presents the Font dialog box that allows selection of 
different fonts and font sizes for use by the printer.  The selection made will apply only to the 
printer fonts.  Selection of the printer fonts deselects the Mirror Display Font menu item on 
the View Menu.  Only fonts applicable to the printer will be available. 

Font selections may be reset to default values by selecting the Reset Fonts menu item. 

OEM Character Set 
This setting forces all fonts to show upper ASCII characters with the OEM Character Set 
(assuming the font supports it).  This allows DOS files with upper ASCII characters to be 
shown correctly with the ASCII character set instead of with the ANSI (Windows) character 
set. 

Reset Fonts (Default) 
The Reset Fonts menu item instructs UltraEdit to reset user selections of the screen and 
printer fonts to the default settings.  Any user selections of the screen fonts made with the 
Set Font menu item or printer fonts made with the Set Printer Font menu item will be lost. 

Set Colors 
This menu item allows the user to configure the color of the following items: 

Regular text 
Background 
Bookmark highlighting 
Selected text color 
Selected text background 
Line/Column display text 
Line/Column display background 
Active Line 
Active Line Background 
Column Markers 

 
By clicking on the color a new color may be selected from the color dialog box.  Only solid 
colors are valid for the background colors and bookmark color selections. 

The background and bookmark colors are used for all files.  The text color is used for all files 
that are not recognized by the Syntax Highlighting. 
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Show Spaces/Tabs 
This menu item allows the displaying of spaces, tabs and new line characters as visible 
characters on the screen.  It does not change the document, but allows you to clearly 
distinguish between the different characters. 

Spaces are shown as: ‘·’ 

Tabs are shown as:  ‘»’ 

New lines are shown as: ‘¶’ 

If there is not enough room to show the ‘»’ with the tab, the tab will appear as normal, and 
non-visible. 

Set Column Markers 
This menu item presents a dialog box allowing the user to specify the column numbers at 
which markers are displayed. 

Two markers may be configured and displayed.  A column marker is a thin vertical line that 
indicates the position of the column on the screen.  If a column marker is specified to be at 
column 80, the marker is placed between the 80th column and the 81st column. 

The column markers may be enabled/disabled independently using the menu items Show 
Column Markers. 

Show Column Marker 1/2 
These menu items toggle on and off the display of the column markers that may have been 
configured with the Set Column Markers menu item. 

No Scroll Left Side of Marker 1  
This menu item works in conjunction with the column markers.  When this item is checked 
(enabled) the columns to the left of the 1st column marker are fixed and do not scroll 
horizontally.  The columns to the right of the column marker will scroll as normal when the 
horizontal scroll bar is used or when the cursor is positioned to the right hand side of the 
window forcing a horizontal scroll. 

If this feature is enabled, columns to the right of the marker will scroll horizontally while 
columns to the left will not.  While the horizontal scroll is in effect, any mouse selection or 
clicking of the primary mouse button within the fixed portion of the display will cause the 
horizontal scroll position to be reset allowing viewing and editing of the continuous columns. 

If the 1st column marker is disabled or set to 0 this function will have no effect. 

Display Ruler  
This menu item toggles the column ruler that displays the column numbers at the top of each 
window.   

The ruler indicates the column number in even increments.  For fixed pitch fonts this will 
show the correct column indication.  For variable pitch fonts, this will show the column 
numbers based on the average character width for the active font. 

The ruler colors may be set with the Set Color dialog. 
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Display Line Numbers 
This menu item toggles the line number display on the left-hand side of the window.  The line 
numbers are shown in a fixed area on the left-hand side of the Window for each file if this 
item is checked.  The font used is automatically selected based on the current font and is 
slightly smaller than the selected font for display. 

The color of the line numbers may be set with the Set Color dialog. 

To print a file with line numbers, make the appropriate selection under the Page Setup dialog 
(File Menu). 

Line numbers may be disabled using the Disable Line numbers selection on the General 
Configuration Page. 

Line Spacing 
These items provide for Single, 1 ½ and Double spacing.  This allows a document to be 
viewed and printed with additional spacing between each line of text. 

If Single spacing is selected, each line is displayed and printed with the normal character 
height and line spacing. 

If 1½ spacing is selected, each line is displayed and printed with the 1 ½ the normal 
character height for the line.  The actual characters are the normal height but spacing 
allocated for the line is increased giving additional room for notes to be handwritten between 
lines. 

If Double spacing is selected, each line is displayed and printed with the 2 times the normal 
character height for the line.  The actual characters are the normal height but spacing 
allocated for the line is increased giving additional room for notes to be handwritten between 
lines. 

ASCII Table 
This feature displays a pop-up dialog that contains an ASCII Table. 

This table contains the following columns: 

Character 
This column shows the characters as they would be displayed using the selected font.  The 
font may be changed using the “Select Font” button. 

Decimal # 
This is the decimal value of the character in the range of 0 to 255.  Characters not available 
on the keyboard may be inserted into UltraEdit by holding down the ALT key and typing their 
four-digit decimal equivalent on the numeric keypad.  For example, ALT+0225 will insert the 
character “á”. 

Hexadecimal # 
This is the hexadecimal value of the character in the range of 0 to FF. 

Name # 
This is the recognized name for the character.  This is for the first 32 characters only. 
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Ctrl Character # 
This is the recognized control character that the character represents.  This is for the first 32 
characters only. 

To view the characters with a different font use the “Select Font” button.  When the ASCII 
Table starts up it defaults to the font currently selected within the editor. 

If you wish to insert any of the characters in to the active file select the character and click 
the “Insert Char” button or double click the character in the table. 
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Chapter 7 Format Features 
This section describes the formatting features available within UltraEdit.  This provides the 
flexibility required to deal with different file types and formats as well as helpful reformatting 
features needed by most users. 

The following topics will be covered: 

Format Menu Commands 
Reformat Paragraph 
Carriage Return/Line Feed Conversion: 

Removing CR/LF’s from text/file 
Adding CR/LF’s to text/file 

Tabs & Spaces: 
Changing tabs to spaces 
Changing spaces to tabs 
Trim Trailing Spaces 

OEM/ANSI: 
What are OEM and ANSI? 
Converting OEM format files to ANSI 
Converting ANSI format files to OEM 

Capitalization: 
Change selected text to all upper case 
Change selected text to all lower case 
Capitalize selected text 
Invert existing capitalization 

Indentation: 
Add Indents 
Remove Indents 

Page Breaks: 
Inserting Page Breaks 
Removing Page Breaks     

Format Menu Commands 
The Format menu offers the following commands: 

Reformat Paragraph reformats paragraph to wrap at column number with 
hard returns 

Paragraph Formatting aligns paragraph - Left/Right/Center/Fill 

Convert CR/LF’s to Wrap  converts CR/LF’s to Word Wrap for selected text 

Convert Wrap to CR/LF’s  converts Word Wrap to hard CR/LF’s for complete file 

OEM to ANSI   converts OEM character set to ANSI character set 

ANSI to OEM   converts ANSI character set to OEM character set 

Tab to Spaces   converts tabs to spaces 

Spaces to Tabs(All)   converts all spaces to tabs 

Spaces to Tabs(Leading)  converts leading tabs to spaces 

Trim Trailing Spaces  trims the trailing spaces from each line 

To Upper Case   converts the selected text to upper case 

To Lower Case   converts the selected text to lower case 

Capitalize    capitalizes first character of each word in selected text 
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Invert Case inverts the case (lower/upper) of each character of 
selected text 

Add Indents presents a dialog to allow adding indentation to selected 
rows of text 

Remove Indents presents a dialog to allow removing indentation from 
selected rows of text 

Insert Page Break   inserts a page break at the cursor position 

HTML Tidy    checks and tidies up HTML files 

Reformat Paragraph command  
Use this command to format the current paragraph (or selected text) to the specified column 
number boundary.  The column number is specified in the Advanced Configuration 
(TAB/Word Wrap Settings) page.  A paragraph is determined as having two hard returns in 
succession (i.e. a blank line). 

All hard returns are removed for the paragraph, and the paragraph is reformatted to the 
appropriate column boundary. 

The whole file may be reformatted using the Select All command from the Edit menu (or 
CTRL+A) to first select the complete file, then Reformat Paragraph to reformat it. 

If the Auto Indent feature is enabled the paragraphs will be automatically indented based on 
the first line of the paragraph. 

The settings used in the Paragraph Reformatting dialog will be used for this command. 

Paragraph Formatting 
The paragraph formatting allows the user align the paragraph in the following manners: 

Left Align  Text will be left aligned against the left margin and will not extend past 
the right margin. 

Center Align Text will be centered between the left and right margins. 
Right Align The text will be right aligned against the right margin and will not extend 

past the left margin. 
Fill The text will be aligned between the right and left margins with spaces 

added between words to ensure alignment to both margins.  The last line 
of the paragraph will be aligned only to the left margin. 

Each of the separate alignment commands may be selected individually from the menu, or 
invoked from the Paragraph Setup/Reformatting dialog.   

The Paragraph Setup/Reformatting dialog specifies the parameters used for reformatting.  
These parameters are used when one of the paragraph formatting commands are used. 

The parameters are: 

Hanging Indent This applies to the left alignment only.  If set, the alignment will allow a 
second margin to be specified that is used for the second and 
successive lines of a paragraph.  This causes the first line of a 
paragraph to be indented with one setting and the rest of the paragraph 
to have a different setting.  If this is set, the hanging indent value may 
be entered in the dialog. 

Margins - Use paragraph left margin   

This instructs UltraEdit to use the existing left margin of the paragraph 
that is being reformatted rather than specifying a new margin value. 
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Margins - Specify margin 

This setting instructs UltraEdit to use the left margin value entered in the 
dialog as the indention for the left margin when reformatting the 
paragraph. 

Margins - Right margin 

This setting specifies the right margin to be used when reformatting the 
paragraph.  This is the last column number (starting at 1) at which text 
may be placed. 

The margin settings above will be used for all reformatting commands including the 
Reformat Paragraph command.  All hard returns are removed for the paragraph, and the 
paragraph is reformatted based on the settings.  The complete file may be reformatted using 
the Select All command to first select the complete file, and then reformat it. 

Convert CR/LF’s to Wrap 
Use this command to remove the CR/LF (carriage return/line feed) characters from the file 
allowing the text to be Word Wrapped by UltraEdit.  This feature removes all CR/LF 
characters for text that is selected.  If no text is selected this function has no effect. 

To remove all CR/LF characters from the file select the complete file.  To do this, position 
the cursor at the beginning of the file and press CTRL+SHIFT+END at the same time. 

To add CR/LF (carriage return/line feed) characters to the file use the Convert Wrap to 
CR/LF’s command. 

Convert Wrap to CR/LF’s 
Use this command to Word Wrap the text based on either the width of the display window or 
a specified column number and write CR/LF (carriage return/line feed) characters to the file.  
If a space is found at the position of the wrap a single space is removed.  This allows the 
document to be saved as viewed in the word wrap state with CR/LF characters inserted at 
the end of each word wrapped line. 

When this item is selected, a dialog box is displayed allowing selection of the wrap 
parameters.  By default, the text will be wrapped based on the current view.  That is to say, 
the text will be wrapped at the window boundary as shown on the screen.  This dialog allows 
selection of a column number at which the text should be wrapped.  In this case the text will 
be wrapped at the specified column or at the preceding word boundary on the line.  

This feature works on the complete file if no text is selected.  If a selection is made, the 
feature only converts the selected area. 

To remove CR/LF (carriage return/line feed) characters from the file use the Convert 
CR/LF’s to Wrap command. 
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CR/LF fix: 

UNIX/MAC to DOS(File Menu>Conversions) 
Some documents generated from UNIX based systems (and some other systems) do not 
terminate each line with a carriage return and linefeed.  UltraEdit requires all lines to be 
terminated with a carriage return and linefeed character.  

This command searches the file for all carriage return and linefeed characters.  If a carriage 
return character is found without an accompanying linefeed character, a linefeed character is 
added.  If a linefeed character is found without a preceding carriage return character a 
carriage return character is inserted.  If a linefeed is found preceding a carriage return the 
characters are reversed. 

Tabs to Spaces 
Use this command to convert all of the tab characters within a file to spaces.  This uses the 
tab settings from the Tab/Word Wrap configuration page (See Chapter 11 Configuration 
Features) to determine how the tab character/tab stop is to be interpreted. The conversion is 
performed such that the formatting will remain the same.  

If a portion of the file is selected/highlighted only the selected portion is converted, otherwise 
the complete file is converted. 

To convert spaces to tabs use the Spaces to Tabs (Leading) or Spaces to Tabs (All) 
command. 

Spaces to Tabs (Leading) 
Use this command to convert all of the (leading) spaces in a file to tabs.  This uses the tab 
settings to determine how the tab character/tab stop is to be interpreted. 

The leading spaces refer to the space at the beginning of a line.  Any spaces after the first 
non-space character in a line will not be converted.  To convert all spaces in a line use the 
Spaces to Tabs (All) command. 

The conversion is performed such that the formatting will remain the same.   This will mean 
that where there are insufficient spaces to replace with a tab character and retain the same 
formatting the spaces will be left in place. 

If a portion of the file is selected/highlighted only the selected portion is converted, otherwise 
the complete file is converted. 

To convert tabs to spaces use the Tabs to Spaces command. 

Spaces to Tabs (All) 
Use this command to convert all of the spaces in a file to tabs.  This uses the tab settings to 
determine how the tab character/tab stop is to be interpreted. 

The conversion is performed such that the formatting will remain the same.   This will mean 
that where there are insufficient spaces to replace with a tab character and retain the same 
formatting the spaces will be left in place. 

If a portion of the file is selected/highlighted only the selected portion is converted, otherwise 
the complete file is converted. 

If you wish to convert only the space at the beginning of a line use the Spaces to Tabs 
(Leading) command. 

To convert tabs to spaces use the Tabs to Spaces command. 
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Trim Trailing Spaces 
Use this command to remove the trailing white space (tabs, spaces) from the ends of each 
line.  This function removes the trailing white spaces from the end of every line in the file 
and positions back to the beginning of the file when it is complete. 

The General Configuration page provides a setting allowing spaces to be trimmed 
automatically when a file is saved. 

OEM to ANSI 
Use this command to convert a file that uses the OEM character set (usually DOS generated 
text files) to the ANSI (Windows) character set. 

To convert a file from ANSI to OEM, use the ANSI to OEM command. 

ANSI to OEM 
Use this command to convert a file that uses the ANSI (Windows) character set to the OEM 
(DOS) character set. 

To convert a file from OEM to ANSI, use the OEM to ANSI command. 

Capitalize 
This command changes the first letter of all words in the selected text to upper case and the 
remaining letters to lower case.  There is no limit on the amount of text that may be selected.  
If Column Mode is selected, the selected columns only are converted.  Shortcut Keys:  F5 

Invert Case 
This command inverts the case of all selected text.  There is no limit on the amount of text 
that may be selected.  If Column Mode is selected, the selected columns only are converted.   

Shortcut Keys: SHIFT+F5 

To Lower Case 
This command changes all selected text to lower case.  There is no limit on the amount of 
text that may be selected.  If Column Mode is selected, the selected columns only are 
converted.  Shortcut Keys: CTRL+F5 

To Upper Case 
This command changes all selected text to upper case.  There is no limit on the amount of 
text that may be selected.  If Column Mode is selected, the selected columns only are 
converted. 

Shortcut Keys: ALT+F5 
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Add Indents 
The Add Indents menu item presents a dialog that allows the user to specify the number of 
spaces to add at the beginning of each of the selected (highlighted) lines.  UltraEdit starts 
adding the specified number of spaces to each line beginning with the first highlighted line 
and ending with the last line that has at least one character selected (highlighted). 

The Indents will be added to all lines stated above, irrespective to any indentations that may 
already exist. 

To remove indentations, use the Remove Indents menu item on the Format Menu. 

Remove Indents 
The Remove Indents menu item presents a dialog that allows the user to specify the number 
of spaces or tabs to remove from the beginning of each of the selected (highlighted) lines.  If 
the checkbox specifying removal of all indents is checked, UltraEdit will remove ALL 
indentation at the beginning of the selected lines.  UltraEdit starts removing the indents 
beginning with the first highlighted line and ending with the last line that has at least one 
character selected (highlighted). 

If no indentation is found at the beginning of a selected line, no changes are made to that 
line. 

To add indentations, use the Add Indents menu item on the Format Menu. 

Insert Page Break 
The Insert Page Break menu item inserts a page break character at the current cursor 
position.  The page break character can be configured in the Page Setup dialog. 

When the document is printed, the page break character is replaced with a page break.  
Printing continues on the next page following a page break character. 

HTML Tidy 
HTML Tidy is an excellent utility that formats, checks and tidies up HTML code.  This was 
developed by Dave Raggett and has been integrated into UltraEdit-32. 

More information on HTML Tidy may be found at: http://www.w3.org/People/Raggett/tidy 

When this is invoked, the active document will be saved and HTML Tidy will parse the file.  
The output window will be used to display any errors or warnings that are found.  Double 
clicking on line with the error or warning in the output window will position the cursor to the 
appropriate line in the file. 

When HTML tidy runs it will generate a "tidy" version of the file and UltraEdit will display this 
in a new file/window titled "** HTML Tidy Output **".  This will be overwritten each time 
HTML Tidy is used. 

HTML Tidy provides many, many configuration options.  These may be set in a configuration 
file.  These are documented on the HTML Tidy WWW page listed above.  In order to use a 
configuration file you need to set the appropriate INI option specifying the location of the 
configuration file.  See the INI Section for details. 
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Chapter 8 Column/Block Editing Features 
This section describes the column (or block) mode features available within UltraEdit.  This 
section will provide detailed explanations of the features and provide some insight as to how and 
when these are useful. 

The following topics will be covered: 

Column Menu Commands 
What is Column/Block Editing? 
Column Mode 
Column Editing: 

Insert/Fill Columns 
Delete Columns 
Cut Columns 
Insert Number 

Sequential number insertion 
Sum Columns 

Column Menu Commands 
The Column menu offers the following commands: 

Column Mode  selects column/block mode editing 

Insert/Fill Columns  specifies the text to insert into each column 

Delete Columns  specifies how many/which columns to delete 

Cut Columns  specifies how many/which columns to cut 

Insert Number  specifies number range to insert into each row 

Sum Columns/Selection sums the total of all the numbers that appear in the selected 
area 

What is Column/Block Editing? 
With normal editing, text selection selects all text within a given line.  Column or block 
editing allows the user to choose selected columns from a given line for editing without 
affecting the other columns in the line.  This allows a user to remove a column of accounting 
figures or preformatted characters at the beginning of lines as well as giving the user the 
ability to insert spaces, tabs or characters ahead of a block of text without changing the 
justification of the text.  This can be very useful for editing database information as 
databases often require beginning characters to be in specific positions and improper editing 
can cause a database not to be able to find the edited data. 

Column/Block editing can be activated/deactivated by selecting Column Mode from the 
Column menu or by using the appropriate shortcut keys.   

Column/block editing is only possible with fixed pitch fonts and if Word Wrap is not 
activated.  If Word Wrap is activated, UltraEdit will inform the user that it is aborting Column 
mode activation. 
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Column Mode 
This command changes the operation of the editor for selecting text.  When column mode is 
selected highlighted text is based on the character column position of the first character 
selected to the column of the last character of text selected.  Text selected in this mode does 
not automatically include all text between the start and end position, but includes all text in 
the columns between the first and last character selected. 

Column mode editing is sometimes referred to as block mode editing as the act of selecting 
text forms a rectangle.  It is very useful for editing text that has been copied from another 
application with extra formatting characters that need to be removed without impacting the 
text. 

Cut, Copy and Paste work with the selected text. 

Column mode editing requires the Word Wrap be turned off and a fixed pitch font be 
selected. 

When column mode is enabled, additional column features are enabled; Insert/Fill Columns, 
Delete Columns, Cut Columns and Insert Number. 

Shortcut Keys: ALT+C 

Insert/Fill Columns 
This command presents a dialog that allows a text string to be entered.  This text will be 
inserted into every line that is selected, or if no selection is made it will be inserted into every 
row starting at the current cursor position and proceeding to the last row of the file.  The text 
string will be inserted into every row at the column position indicated by the cursor when this 
command is invoked.  If text does not exist at this column in any row, spaces ‘ ‘  will be 
added to pad the row allowing the text to be inserted correctly. 

If at the invocation of this command, text is highlighted, the columns indicated by the 
highlighted text will be replaced with the specified text. 

Delete Columns 
This command presents a dialog that allows the number of columns to be deleted to be 
specified.  The columns will be deleted from every line that is selected, or if no selection is 
made they will be deleted from the file from every row starting at the current cursor position 
and proceeding to the last row of the file.  If a value of zero ‘0’ is entered, columns will be 
deleted based on the highlighted text when this command is invoked.  This command does 
not save the deleted text in the clipboard. 

Cut Columns command 
Use this command to remove the currently selected data from the document and put it on 
the clipboard.  This command is unavailable if there is no data currently selected. 

Cutting data to the clipboard replaces the contents previously stored there. 
Shortcut Keys: CTRL+X 
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Insert Number 
This command allows a sequential number to be inserted into every line selected, or if no 
lines are selected, into every line at the column position indicated by the cursor.  This 
command presents a dialog that allows the initial value to be entered and the increment for 
each line.  This provides an easy method to add line numbers into a text file. 

If any text is highlighted at the invocation of this command, the inserted line numbers will 
replace the highlighted text.  The spacing required for the line numbers is calculated 
automatically based on the number of lines that will have a number inserted, the initial value 
and the increment.  All numbers may be positive or negative non decimal point numbers. 

If the option to add "Leading Zeros" is selected the appropriate leading zeros will be added to 
each number to pad the field to the same width (in characters) as the maximum number to 
be inserted.  If this option is not selected, trailing spaces will be used. 

Sum Columns/Selection 
This command sums the total of all the numbers that appear in the selected area (columns 
or lines) and presents the total in a dialog box. 

As some number formats have a comma, or other character that is part of the number or a 
separator (i.e. one thousand may be represented as 1,000) this may be configured.  The 
dialog allows the user to specify any character that should be ignored in a number and by 
default is initialized to a comma (,). 

The SUM button recalculates the total.  It allows the separator to be modified and the total 
recalculated. 

The TOTAL is shown in an editable entry box allowing the total to be formatted and copied to 
the clipboard and pasted into the document if required. 
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Chapter 9 Macro Features 
This section describes the macro features available within UltraEdit.  This allows the automation 
of many tasks using the macro features. 

The following topics will be covered: 

Macro Menu Commands 
Loading Macros: 

Set Auto Load 
Macro Load appending file to existing macros 

Saving/Deleting Macros: 
How to save a macro 
How to delete a macro 

Creating/Editing Macros: 
Macro Command Options 
Configuring Macro Hot Keys 
Editing macros from the command line 
Templates and Macros - Which To Use? 

Recording/Playing Macros: 
Recording a Macro 
Recording Nested Macros 
Playing back a Macro 

Macro Features: 
Warn on Exit if Macro not Saved 

Macro Menu Commands 
Load loads a macro file 

Load and Append to Existing loads and appends a macro file to any macros 
already resident 

Save All saves all macros to a file 

Set Auto Load specifies the macro to load at startup 

Edit Macro edits a macro 

Delete All     deletes all resident macros 

Delete Macro/Modify Hot Key deletes a macro, or modify its ‘Hot’ key 

Record     starts ‘recording’ a macro 

Stop Recording stops recording a macro 

Play Again plays last macro again 

Play Any Multiple Times plays any macro, or plays a macro multiple 
times 

Warn on Exit if Macro Not Saved warns user macros are not saved when exiting  
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Load 
The Load command presents a dialog box for loading a previously saved set of macros from 
a disk file. The dialog box allows selection of a file from any file device known to the system. 
The default file name presented is UltraEdit.MAC, although any filename is acceptable. 

When a file is selected for loading, a check is made to ensure the file is an UltraEdit macro 
file. 

"^s" may be used in the filename.  UltraEdit will replace this with the currently selected text in 
the active Window.  Likewise, "^c may be used and UltraEdit will replace this with the 
contents of the clipboard. 

Load and Append to Existing 
This function allows a macro file to be loaded appending the file to the macros already 
resident unlike the Load command that deletes all resident macros before loading the file. 

A dialog box is presented for loading a previously saved set of macros from a disk file. The 
dialog box allows selection of a file from any file device known to the system. The default file 
name presented is UltraEdit.MAC, although any filename is acceptable. 

When a file is selected for loading, a check is made to ensure the file is an UltraEdit macro 
file. 

Save All 
The Save All command presents a dialog box for saving the macros that have been 
recorded using the Record command to a disk file. The dialog box allows selection of a file 
from any file device known to the system. The default file name presented is UltraEdit.MAC, 
although any filename is acceptable. 

This command is available only if a macro has been recorded, or loaded. 

Set Auto Load 
The Set Auto Load command allows you to specify a macro file that should be loaded 
automatically when UltraEdit is started. 

This also allows a specific macro to be executed a specified number of times if required.  A 
macro file may be loaded automatically without executing a macro. 

This method of loading a macro at startup overrides the Command Line parameters for 
loading a macro.  If no macro is specified to be loaded here, the command line parameter 
setting if specified will be used. 

Edit Macro 
The Edit Macro command allows a new macro to be created and edited or an existing macro 
that has previously been generated with this command or with the Macro Record command 
to be edited or renamed. 

In many cases it is easier for the user to generate the macro by recording it with the Macro 
Record command and then to edit it if necessary.  The learning curve is less with this 
approach. 
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Commands 
A macro is a series of commands that may later be played back automatically to modify the 
file.  The left-hand side of the dialog shows the current macro being edited and an editable 
window containing the commands that make up the macro. 

The commands in the macro must be one of the predefined commands.  These predefined 
commands are shown on the right of the dialog.  If the mouse is double clicked on the 
command it is automatically added to the macro, or clicking on the arrow to the left of the 
commands will add it to the macro. 

Parameters 
Many of the commands have numeric parameters.  The numeric parameters are quite 
obvious, such as “Goto Line #” or “Goto Page #”.  However, some of the commands such as 
Find and Replace, Sort, etc have additional parameters that are not numeric.  These 
additional parameters are listed below the command list for easy selection. 

Creating a New Macro 
Click the New/Macro button to create a new macro from this dialog.  This displays the Macro 
Definition dialog where you define the macro name and Hot Key if required. 

When this new macro is created, three macro commands are automatically added to the 
macro: 

Insert Mode or OverStrike Mode 
ColumnModeOn or ColumnMode Off 
HexOn or HexOff 

 
These three commands are added based on the current state of the editor.  The purpose is 
to establish a known state each time the macro is played.  If a macro is recorded in one 
mode and played back in another the results may be unpredictable.  Establishing the mode 
at the beginning of the macro helps to ensure the expected results are achieved.  These 
commands may be modified as required. 

Once an edit macro has been created, it may be edited.  Please see Appendix 4 Macro 
Parameters for more detail. 

Modifying an Existing Macro 
To modify a macro, commands may be typed directly into the macro edit box or selected 
from the command list.  Commands are not case sensitive but must be spelled exactly as 
shown in the command list.  For a complete list of available commands and parameters 
please see Appendix 4 - Macro Parameters. 

Macro Definition Dialog 
The macro definition dialog is shown when a new macro is created either from the Macro 
Record command or from the Edit Macro command. 

It allows a name to be given to the macro, and a hot key assignment to be given to the 
macro. The macro recording starts after pressing OK if invoked from the Record command. 

The hot key assignment allows the user to specify a key combination that will automatically 
invoke the macro.  If a key assignment is chosen that is already used by UltraEdit the key 
assignment will override UltraEdit’s assignment. 
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The following keys are supported: 

A-Z 
0-9 
F1-F12 
Space, Enter and Tab 
In addition, the key modifiers CONTROL, ALT and SHIFT may be selected. 

It is not required that a name be entered, or a hot key assignment be made. 

Default behavior shows a Cancel Dialog while the macro is executing.  For macros that 
execute quickly this may not be desired and may be disabled by deselecting the “Show 
Cancel Dialog for this macro” setting. 

During Playback a find and replace command may result in the search string not being 
found.  The default behavior in this case is to stop the macro execution.  For some macros, 
possibly where a replace all is being performed, it is desirable not to stop the macro 
playback.  In this case, select the “Continue if a Find with Replace Not Found”. 

Delete All 
This command deletes all the resident macros.  If any of the macros have been created or 
modified since the file was saved the user is prompted allowing the macros to be saved prior 
to deleting them. 

Delete Macro/Modify Hot Key 
This command allows the user to delete a macro, or modify the hot key associated with any 
macro.  A dialog box is presented that shows all of the macros and allows any macro to be 
selected and its hot key modified (or the macro may be deleted).  No support is provided to 
modify the contents of a macro.  For more details on the hot key assignments see Macro 
Recording. 

 

Templates and Macros - Which One Do I Use? 

Templates 
A template is a pre-defined text that may be recalled automatically at a later time and 
inserted into a file.  They generally are used to store text that is consistently used for 
repeated functions.  They are very useful for inserting text into a document in a formatted 
manner - such as in forms.  Their use of special characters such as date strings allows 
flexibility in otherwise fixed text sections. 

Macros 
A macro is a series of commands that may later be played back automatically to modify the 
file.  Macros allow users to store complex combinations of commands that are consistently 
used on like files for repeated processes. 
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An advantage of macros over templates is that they allow find and replace functions to be 
executed within a process rather than simply inserting text.  Defining macros is more 
complex than defining templates but allows much more powerful use of the abilities of the 
editor than templates alone. 

Record 
The Record command starts ‘recording’ keystrokes and actions for later playback. Recording 
is stopped when the Stop Recording menu selection is made.   

This command presents the Macro Definition Dialog allowing you to define the macro name 
and Hot Key if required.  When the dialog is dismissed with the OK button the macro 
recording starts. 

Notes for Recording Macros 
The Record function records all keystrokes and characters typed while recording is selected. 
All keystrokes are recorded, including key combinations that move to end of line, top or 
bottom of document etc. Care should be taken to ensure that when the macro is to be played 
back the same keystrokes are appropriate. 

Mouse motion and scrolling is NOT recorded while recording is selected. All positioning 
should be performed with the keyboard. 

Macros will record and playback the Next Window and Previous Window commands. 

Find and Replace is supported while recording is selected. Any find or replace functions will 
be recorded directly as performed, unless using special characters that are replaced when 
executing with the contents of the clipboard or the highlighted text.† If all or any occurrences 
of “FIND” are replaced with “REPLACE” in a file, the same action will be performed when the 
macro is played back. 

Cut, Copy and Paste are also supported while macro recording is selected. Any of these 
operations will be performed dynamically as the macro is played back. That is to say that if 
an item is cut while recording the macro, an item will be cut while playing back the macro 
based on the selected text at the time the macro is being played back. If the selected text is 
different while playing back the macro, from when the macro is recorded, the text cut while 
playing back the macro will also be different. 

As multiple macros are now supported, this command is available when macros already 
exist. 

HEX editing is now supported within macros. 

The following commands are supported when recording a macro: 

Keyboard entry - typing characters 
Cursor positioning 
Selecting text with keyboard commands 
Cut, copy, paste 
Find/replace 
HEX mode switching and editing 
File open, close, save 
Bookmarks 
Playing macros - nesting macros 
Window switching - next/previous window 

                                                        
† For more information on this and for special characters useful with macros please see the Find 
command. 
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Insert/Overstrike selection 
Unix/Mac to DOS 
DOS to Unix 
DOS to MAC 
Convert Wrap to CR/LFs 
Convert CR/LFs to Wrap 

Stop Recording 
The Stop Recording command stops capturing keystrokes and actions that started when the 
Record function was selected. Once a macro has been recorded and the session has been 
stopped with this command, the macro may be played back by selecting the Play Again or 
Play Any/Multiple Times command. 

After a macro has been recorded, it may by saved using the Save All command. 

Playback 
The Playback command allows a macro that has been recorded with the Macro Record 
command to be replayed. The macro is replayed one time for each invocation of the 
command. To replay the macro multiple times use the Playback Multiple Times command. 

This command is not available if a macro record has not been recorded or loaded. 

Playback Multiple Times 
The Playback Multiple Times command allows a macro that has been recorded with the 
Macro Record command to be replayed multiple times. A dialog box is presented that 
prompts the user for a number between 1 and 100000 that specifies the number of times the 
macro should be replayed. To replay the macro a single time use the Playback command. 

This command is not available if a macro record has not been recorded or loaded. 

Warn on Exit if Macro Not Saved 
This indicates and determines if a warning will be issued when UltraEdit closes, or a new 
macro file is loaded and the existing macros have been modified but not saved. 

If this is not checked, no warning will be given. 
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Chapter 10 Advanced Features 
This section describes the Advanced options and features available within UltraEdit.  The 
configuration area allows UltraEdit to be configured to best suit the needs of the user. 

The following topics will be covered: 

Advanced Menu Commands 
Configuration and option settings: (Please see Configuration section) 
Display/Modify Templates: 

What is a Template and when would I use it? 
Creating/Editing a Template 
Using Time/Date in a Template 
Naming a Template 
Deleting a Template 
Inserting a Template 

DOS Commands: 
Using DOS Commands in UltraEdit 
Passing filenames  
When to use the Alternate Capture Method 

Running Windows Programs in UltraEdit 
Tool Configuration: 

Creating/Editing User Tools 
Deleting User Tools 

Advanced Menu Commands 
The Advanced menu provides access to some of the advanced capabilities of UltraEdit.  
These include: 

Configuration:   a tabbed dialog with access to the following pages: 

General 

Tab/Word Wrap 

Backup 

Spelling Checker 

Toolbar 

Key Mapping 

Syntax Highlighting 

File Types 

File Associations 

Display/Modify Templates  display or modify the user definable templates 

Insert Template   insert a user-defined template into the file 

DOS Command   run a DOS command and capture its output 

Last DOS Command  repeat the last DOS command 

Run Windows Program  run a Windows program 

Alternate Capture Method   alternate capture method for capturing output 

Tool Configuration    user-definable tool configuration 
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Display/Modify Templates command 
Use this command to display the dialog for editing the templates.  A template is a pre-
defined text that may be recalled automatically at a later time and inserted into a file. 

Up to 50 templates may be defined.  Each of the first 20 templates may be recalled at a later 
time using hot keys Alt+0 through Alt+9, and Shift+Alt+0 through Shift+Alt+9, or any of the 
templates may be recalled with the Insert Template dialog. 

Each template may optionally have a name associated with it that if defined will show up on 
the tool tips on the toolbar and in list of templates when inserting a template.  The templates 
are stored in a file in the default directory, or the directory specified in the General Options 
configuration page. 

Special Strings 
A template may contain special text strings that are translated at the time the template is 
recalled.  These special strings are: 

[DATE_DMY] is translated into the current date with the format DAY/MONTH/YEAR. 

[DATE_MDY] is translated into the current date with the format MONTH/DAY/YEAR. 

[DATE_TEXT] is translated into the current date with the date displayed as text. 

[TIME]  is translated into the current time IN 24-HOUR FORMAT. 

^ this indicates the position at which to place the cursor after the template 
has been inserted. 

[FULL_FILE_NAME] Is translated into the full path and filename of the active 
document. 

[FILE_PATH]  Is translated into the drive and path of the active document. 

[FILE_NAME]  Is translated into the root filename of the active document. 

[FILE_EXTENSION] Is translated into the file extension of the active document. 

Note - ^ refers to the character ‘̂’ NOT Control Key + value. 

Additionally, for extended date and time formatting, UltraEdit supports the following 
enhanced functionality: 

Time 
To specify the USER TIME format use the following syntax in your template: 

For local time use the following markers: 

[TIME_USER]...time format string here...[TIME_USER_END] 

For system time use the following markers: 

[TIME_USER_SYS]...time format string here...[TIME_USER_SYS_END] 

The time format string is defined as follows: 

If you use spaces to separate the elements in the format string, these spaces will appear in 
the same location in the template. The letters must be in uppercase or lowercase as shown 
(for example, “ss”, not “SS”). Characters in the format string that are enclosed in single 
quotation marks will appear in the same location and unchanged in the template. 

String  Meaning 
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h  Hours with no leading zero for single-digit hours; 12-hour clock 

hh  Hours with leading zero for single-digit hours; 12-hour clock 

H  Hours with no leading zero for single-digit hours; 24-hour clock 

HH  Hours with leading zero for single-digit hours; 24-hour clock 

m  Minutes with no leading zero for single-digit minutes 

mm  Minutes with leading zero for single-digit minutes 

s  Seconds with no leading zero for single-digit seconds 

ss  Seconds with leading zero for single-digit seconds 

t  One character time marker string, such as A or P 

tt  Multicharacter time marker string, such as AM or PM 

 

For example, to get the time string 

“11:29:40 PM” 

use the following format string: 

“hh’:’mm’:’ss tt” 

This string MUST be between the markers, for example: 

[TIME_USER]hh’:’mm’:’ss tt[TIME_USER_END] 

Date 
To specify the USER TIME format use the following syntax in your template: 

For local date use the following markers: 

[DATE_USER]...date format string here...[DATE_USER_END] 

For system date use the following markers: 

[DATE_USER_SYS]...date format string here...[DATE_USER_SYS_END] 

The date format string is defined as follows: 

Use the following elements to construct a format string. If you use spaces to separate the 
elements in the format string, these spaces will appear in the same location in the template. 
The letters must be in uppercase or lowercase as shown in the table (for example, “MM” not 
“mm”). Characters in the format string that are enclosed in single quotation marks will appear 
in the same location and unchanged in the template. 
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String  Meaning 
d  Day of month as digits with no leading zero for single-digit days. 

dd  Day of month as digits with leading zero for single-digit days. 

ddd  Day of week as a three-letter abbreviation. 

dddd Day of week as its full name. 

M  Month as digits with no leading zero for single-digit months. 

MM  Month as digits with leading zero for single-digit months. 

MMM Month as a three-letter abbreviation. 

MMMM Month as its full name. 

y  Year as last two digits, but with no leading zero for years less than 10. 

yy  Year as last two digits, but with leading zero for years less than 10. 

yyyy Year represented by full four digits. 

For example, to get the date string 

“Wed, Aug 31 94” 

use the following picture string: 

“ddd’,’ MMM dd yy” 

This string MUST be between the markers, for example: 

[DATE_USER]ddd’,’ MMM dd yy[DATE_USER_END] 

Insert Templates command 
Use this command to insert a template.  It presents a dialog, allowing you to select the 
template you wish to insert from the list of templates. 

Optionally, the hot keys Alt+0 through Alt+9 and Shift+Alt+0 through Shift+Alt+9 may be 
used instead of this menu command. 

DOS Command  
This command allows a DOS command to be run from within UltraEdit and the results of the 
command are captured and automatically displayed by UltraEdit at the completion of the 
command.  A dialog box is presented that allows the command to be specified (with a 
browse button) and the working directory† to be specified. 

The command line specified should be the full path of the file to be executed unless it is a 
system command (such as DIR), or it is in the Windows directory, or the Windows System 
directory. 

The working directory should be the full path of the working directory, or left blank if not 
required. 

                                                        
† The working directory is only supported in the 32-bit version of UltraEdit. 
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In order to allow maximum flexibility of programs to be run a special command line 
sequence is permitted that will cause the active file name to be inserted into the command 
line and passed to the program to be executed.  For example: 

You set up a command to run a compiler and you want to invoke the compiler with the file 
you are currently editing.  If you change files you want the compiler to be invoked with the 
new file.  The compiler is c:\comp\compiler. 

Specify the following command in the dialog box: 

c:\comp\compiler %F 

When the command is executed, the full directory path, filename and extension of the active 
window will replace the % F.  The file will be saved before the command is executed. 

The following commands may be used to pass a portion of the full-qualified filename: 

%P Path only (“C:\project\test\”) 

%N fileName only (“test”) 

%E Extension only (“.c”) 

%P%N%E is equal to %F which is (“C:\project\test\test.c”) in the example above. 

NOTE - If the %f, %p, %n, %e are lower case the file names are passed as long file names 
and should be put in quotes, i.e. “%f” or “%p%n” etc.  If the %F, %P, %N, %E are in upper 
case the filename and path will be converted and passed as the “8.3” short filename 
specification for maximum compatibility with DOS programs. 

Additionally the following commands are available: 

%R  This may be used for the full path/name of the project (%r for long name, %R for 
short name) 

%RP  This may be used for the full project path (%rp for long name, %RP for short 
name) 

%RN  This may be used for the project name only (%rn for long name, %RN for short 
name) 

%modify% In some cases it may be necessary to modify the command line parameters 
each time the tool is run.  To do this, add %modify% in the command line and 
when the tool is run a dialog box will be shown allowing the user to modify the 
command line or cancel and run without modification. 

%sel% This instructs UltraEdit to add the highlighted/selected text from the active 
document into the command line in place of the %sel%. 

The output from the command will be captured and displayed in a window when the 
command has completed. 

As the output from a DOS program is sometimes buffered by the operating system, this 
process may not work correctly with a program that requires interaction while it is executing.  
The prompts may not appear on the screen at the correct time and the user may wonder why 
there is no activity. 

As the output will always be captured, if the program generates no console screen output the 
captured output may be empty and UltraEdit will show an empty window. 
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Note - If capturing the output does not work correctly, or the command does not function 
correctly you may try the Alternate Capture Method command from the Advanced Menu†. 

The Last DOS Command repeats the last command specified with the DOS command dialog 
without presenting the dialog box. 

Run Windows Program 
This command allows a Windows program to be executed from within UltraEdit.  The output 
is not captured.  A dialog box is presented that allows the command to be specified (with a 
browse button) and the working directory to be specified‡. 

The command line specified should be the full path of the file to be executed, unless it is in 
the Windows directory, or the Windows System directory. 

The working directory should be the full path of the working directory, or left blank if not 
required. 

In order to allow maximum flexibility of programs to be run a special command line 
sequence is permitted that will cause the active file name to be inserted into the command 
line and passed to the program to be executed.  For example: 

You set up a command to run a compiler and you want to invoke the compiler with the file 
you are currently editing.  If you change files you want the compiler to be invoked with the 
new file.  The compiler is c:\comp\compiler. 

Specify the following command in the dialog box: 

c:\comp\compiler %F 

When the command is executed, the %F will be replaced by the filename of the active 
window,  The file will be saved before the command is executed. 

The following commands may be used to pass a portion of the fully qualified filename: 

%P Path only (“C:\project\test\”) 

%N fileName only (“test”) 

%E Extension only (“.c”) 

%P%N%E is equal to %F which is (“C:\project\test\test.c”) in the example above. 

NOTE - If the %f, %p, %n, %e are lower case the file names are passed as long file names 
and should be put in quotes, i.e. “%f” or “%p%n” etc.  If the %F, %P, %N, %E are in upper 
case the filename and path will converted and passed as the “8.3” short filename 
specification for maximum compatibility with DOS programs. 

To run a DOS program use the DOS Command. 

Alternate Capture Method 
This command changes the method used to capture the output from a DOS or Console 
application run from within UltraEdit.  Under Windows 95 some applications do not run 
correctly, or do not capture output correctly using the standard method. 

                                                        
† This feature is only available in the 32-bit version of UltraEdit. 
‡ The working directory is only available in the 32-bit version of UltraEdit. 
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The primary difference is that this alternate method does not show the output of the 
command on the DOS Window as it is executing. 

This method does however resolve issues seen by some users. 

Tools Configuration/Use 
UltraEdit allows the user to configure up to ten menu items to commands of the users 
choice.  Additionally up to ten additional tools may be configured for the active project by 
selecting the "Project Tool Configuration" menu item. 

These commands may be any DOS or Windows commands, and appear in the lower 
portion of the Advanced menu when set up. 

When the Tool Configuration menu item is selected, a dialog box is presented allowing the 
user to specify the command line and action for each of the users choices.  The following 
information is presented: 

 Command Line 
This is the actual command line that will be invoked it may contain a '%F' that will be 
replaced by the full directory specification and filename of the active file.  The file will be 
saved first if changes have been made 

You set up a command to run a compiler and you want to invoke the compiler with the file 
you are currently editing.  If you change files you want the compiler to be invoked with the 
new file.  The compiler is c:\comp\compiler 

Specify the following command in the dialog box: 

c:\comp\compiler %F 

When the command is executed, the %F will be replaced by the full directory path, filename 
and extension of the active window.  The file will be saved before the command is executed. 

The following commands may be used to pass a portion of the full qualified filename: 

%P Path only ("C:\project\test\") 

%N fileName only ("test") 

%E Extension only (".c") 

%P%N%E is equal to %F which is ("C:\project\test\test.c") in the example above. 

NOTE - If the %f, %p, %n, %e are lower case the filenames are passed as long filenames 
and should be put in quotes, i.e. "%f" or "%p%n" etc.  If the %F, %P, %N, %E are in upper 
case the filename and path will converted and passed as the "8.3" short filename 
specification for maximum compatibility with DOS programs. 

Additionally the following commands are available: 

%R  This may be used for the full path/name of the project (%r for long name, %R for 
short name) 

%RP  This may be used for the full project path (%rp for long name, %RP for short 
name) 

%RN  This may be used for the project name only (%rn for long name, %RN for short 
name) 

%modify% In some cases it may be necessary to modify the command line parameters 
each time the tool is run.  To do this, add %modify% in the command line and when the tool 
is run a dialog box will be shown allowing the user to modify the command line or cancel and 
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run without modification. 

%sel% This instructs UltraEdit to add the highlighted/selected text from the active 
document into the command line in place of the %sel%.  

Working Directory 
This is the working directory for the specified command.  If applicable, the process will be 
started with this as its working directory.  As above, the %P may be used to specify the 
path†. 

Menu Item Name 
This is the name of the item as it appears on the Advanced menu. 

Windows Program Checkbox 
This must be checked if the program being invoked in the command line is a Windows 
application. 

Command Output (DOS Commands ONLY)  
DOS command output may be optionally captured to a file.  The four options for DOS 
command output are:  

1) append to existing file (create new file if one does not exist)  

2) Replace existing file 

3) Create new file each time the command is run; and  

4) Capture the output to a list box (Output Window).  

This list box allows the user to double click on a line of the captured output and UltraEdit 
attempts to open the referenced file and position to the specified line if found. 

As several commands may be configured, it is quite possible the user may wish for some 
commands to always create a new file, while other commands should replace the existing 
file (or append to it).  For this reason, each capture mode (append, replace, new) will create 
a new file for that mode if one does not exist.  Each time a command is run, the file for the 
given capture mode will be appended to or replaced if appropriate, or a new file created if 
selected. 

Command List Box 
The command list box shows the configured commands.  By double clicking on a command 
in this list, the configuration items are pre-loaded with the parameters of this command and 
may be modified.  To keep the changes, the user MUST select REPLACE to overwrite the 
existing command, or INSERT to generate a new command. 

If you click on an item, you may delete it by selecting the DELETE button. 

Requirements 
DOS commands require that certain files exist depending on the operating system: 

Windows 95 requires the COMMAND.COM file be on the Windows directory. 

                                                        
† This feature is only available in the 32-bit version of UltraEdit. 
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Windows NT requires that CMD.EXE be in the path. 

Windows 3.x requires that the DOSPRMPT.PIF be in the Windows directory. 

Note - If the capturing the output does not work correctly, or the command does not function 
correctly you may try the Alternate Capture Method command from the Advanced Menu†. 

 

                                                        
† This feature is only available in the 32-bit version of UltraEdit. 
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Chapter 11 Configuration Features 
This section describes the configuration options available within UltraEdit.  The default value 
settings are intended to suit the majority of users however the flexibility of the configurable 
section is intended to allow users to customize UltraEdit to better suit their individual 
requirements.   

The following topics will be covered: 

General Configuration Page 
General: 

Allow Multiple Instances 
Project Menu on Main Menu 
Recent Files List on File Menu 
Number of Recent Files on Menu 
Number of HEX characters/line 
Setting Left & Right Delimiters for Ctrl+Dbl Click 
Save Bookmarks 
Minimize on Last File Close 
Disable File Change Detection 
Auto Update Changed Files 
Disable Line Number 
Open File Without Temp File 
Auto Detect Unix Files 
Auto Convert Unix Files 
Save File as Input Format 
Default to Read Only 
Reload Open Files on Startup 
Use Default Directory on Initial File Open 
Use Active File Directory On File Open 

Edit: 
Auto Indent 
Allow Positioning Beyond Line End 
Disable Drag & Drop 
Home Key Always Goto Column 1 
Select Extension for Settings (to configure tab/word wrap settings by file extension) 
Use Spaces in Place of Tabs 
Setting the Tab Stop Value 
Default Word Wrap on For Each File 
Setting the Wrap Method 

Find: 
Show Slim Find Dialog After Start 
Continue Find at End of File 
Unix style Regular Expressions 
Find dialog defaults to word under cursor 
Find Next/Prev finds selected text (not text last searched for) 

 

Backup: 
Backup files on save 

No Backup 
Replace extension with .BAK 
Append .BAK to existing extension 

Default Backup Directory 
Automatic Backup 

Time between automatic save 
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Do not auto-save unnamed files 
Do not auto-save FTP files 

 
Spelling Checker: 

Choosing the appropriate dictionaries 
Installing dictionaries 
User Dictionaries 
User Options 

Toolbar: 
Feature List 
Toolbar List 
Inserting Tools 
Removing Tools 
Resetting Default Tools 
Use Large Icons On Tool Bar 

Key Mapping: 
Available Commands 
Existing Hot Keys for Commands 
Assigning Hot Keys for Commands 
Removing Existing Hot Keys for Commands 
Resetting Defaults 
File Containing Keyboard Mapping 

Syntax Highlighting (Please see Syntax Highlighting Section) 
File Types: 

Inserting File Names/Descriptions 
Replacing File Names/Descriptions 
Deleting File Names/Descriptions 
Resetting Defaults 
Scrolling in the File List 

File Associations: 
What are File Associations? 
Setting UltraEdit Associations 
Setting File Types/Extensions 
Editing File Descriptions 

Directories: 
Setting the Default Save Directory 
Setting the Macro Default Directory 
Setting the Template Directory 
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General Configuration Page 
The general options page has the following selections: 

Allow Multiple Instances  if checked, allow multiple instances of UltraEdit 

Project Menu on Main Menu  enables the Project Sub-Menu on the Main 
Menu Bar 
Recent Files List on File Menu enables the Recent File List on the File Menu directly 

rather than as a sub-menu 

Number of Recent files sets the number of recent files that appear on the file 
menu for quick opening of files 

Number of Hex Characters/Line defines the number of hex characters to be shown in 
each line of the display 

Left Delimiters for Ctrl+Dbl Click configures delimiter characters for text selection with 
Ctrl+Mouse Left Button Double Click 

Right Delimiters for Ctrl+Dbl Click configure delimiter characters for text selection with 
Ctrl+Mouse Left Button Double Click 

Save Bookmarks save bookmarks when file is closed 

Minimize on last file close if checked, UltraEdit will minimize when all open files 
are closed 

Minimize to System Tray if checked, UltraEdit will minimize to the System Tray 
and NOT to the task bar 

Always on top if checked, UltraEdit will be set to always be the top 
window 

Disable File Change Detection disables the detection of files changed outside of the 
editor 

Auto Update Changed Files auto update files that have changed outside the editor 

Disable Line Number disables line number display improving speed on large 
files 

Open File Without Temp File opens file without creating temporary file (all changes 
are permanent) 

Auto Detect Unix Files instructs UltraEdit to automatically detect Unix files 
when opened and ask if they should be converted 

Auto Convert Unix Files instructs UltraEdit to automatically detect and convert 
Unix files when opened 

Save File as Input Format instructs UltraEdit to save files in the same format in 
which they were created 

Default to Read Only  determines if the file is opened as Read-Only by default 

Reload Open Files on Startup remembers the files that were open from last session 
and reloads them on startup 

Use Default Dir on Initial File Open uses the default directory for the initial file open 

Use Active File Dir. On File Open uses the directory for the active file for the file open 

Trim Trailing Spaces on Save automatically trims trailing spaces when a file is saved 



 98

Multiple Instances 
The Multiple Instances menu item determines if UltraEdit opens another instance of UltraEdit 
if it is invoked when a copy is already active.  If this option is enabled, a new instance is 
opened each time UltraEdit is invoked.  If this option is not enabled, only a single instance of 
UltraEdit is opened, and any additional request results in the first instance becoming active 
with the new file loaded in addition to any files already open. 

Project Menu on Main Menu 
This option configures the editor to include the Project Menu on the Main Menu bar of the 
editor.  If this option is not checked the Project Menu appears as a sub-menu of the File 
Menu. 

Note - After changing this setting the editor must be restarted for the menus to 
change. 

Recent Files List on File Menu 
This option configures the recent file list to appear on the File Menu rather than as a sub-
menu.  If this option is not checked the recent file list appears as a sub-menu of the File 
Menu. 

Note - After changing this setting the editor must be restarted for the menus to 
change. 

Double Click Selections 
UltraEdit allows selection of text by double clicking the primary mouse button (usually the left 
button).  Normally a single word is selected made up of any alphanumeric character or 
underscore _. 

If at the time the primary mouse button is double clicked the control key is pressed, a string 
is selected rather than just a single word.  This can be very useful in selecting filenames, e-
mail addresses etc.  The characters that delimit the string are configurable in the General 
Options configuration page.  This function works on a single line only.  

These entries, one for the left edge of the text to be selected and one for the right edge 
specify what characters should be used to stop any further text from being selected.  If a 
space only is specified in each field all text either side of the cursor position will be selected 
until a space is encountered. 

If text is selected when the right mouse button is pressed, a new menu item Open File 
Highlighted is added to the top of the pop-up menu and if selected the file is opened if it 
exists. 

Save Bookmarks 
UltraEdit provides the ability to save the bookmarks for any file that has active bookmarks 
when a file is closed.  By default the feature is not enabled.  This may be enabled by setting 
the "Save Bookmarks " setting in the General Options configuration page.   

If this option is disabled UltraEdit will delete any saved bookmarks the next time UltraEdit is 
closed. 
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File Change Detection Settings 
UltraEdit automatically detects any changes to a file that is loaded within UltraEdit and is 
changed outside of UltraEdit. 

By default, when the changes are detected UltraEdit will prompt the user with the option to 
reload the file (in which case any unsaved changes to the file in UltraEdit will be lost).  The 
user may choose to reload the file or ignore the changes. 

Optionally, UltraEdit provides the ability to ignore any file changes by setting the "Disable 
File Change Detection" setting in the General Options configuration page.  In this case 
UltraEdit will not detect, or prompt for any file changes. 

Optionally, UltraEdit provides the ability to automatically update the loaded files with any 
changes that have been made outside of the editor by setting the "Automatically Update 
Changed Files" setting in the General Options configuration page.  In this case, the file will 
be loaded and any unsaved changes made within UltraEdit will be overwritten automatically 
without prompting. 

Disable Line numbers 
The Disable Line Numbers option allows the line number display in the status bar to be 
disabled.  Under normal circumstances this option should be left unchecked.  For very large 
files, file positioning may be slowed down while UltraEdit establishes the line number.  In this 
case the line numbers may be disabled. 

If the option is checked, line numbers are disabled; if unchecked line numbers are enabled. 

Large File Handling (open file without temp file) 
UltraEdit allows editing of very large files.  This is accomplished with relatively small 
amounts of memory being used.  UltraEdit is a disk-based editor and only loads a small 
portion of the file into memory at one time.  Normally, UltraEdit copies a file that is being 
edited to a temporary file, and at the end of the editing session deletes the file, after copying 
back to the appropriate original file. 

To speed up editing of very large files, the General Options configuration page allows you to 
specify editing without using temporary files.  This removes the time necessary to copy the 
file to a temporary file.  When editing files of many megabytes this can be an advantage. 

WARNING - If this option is selected, all changes are permanent! 

A dialog box is shown warning the user this setting is enabled each time a file is opened.  
Changing the INI settings will disable this. 

Additionally, the Disable Line Number option improves the performance when navigating 
around large files, as less disk accesses are required to track the line numbers. 

Default to Read Only 
The Read Only command toggles the state of the read only status of the file.  If the read only 
status is set the file cannot be modified.  If the file has already been modified the 
modifications are maintained and the file may be saved. 
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Reload Open Files on Startup 
If this option is checked, UltraEdit saves information about the open files when UltraEdit is 
closed.  This information is used to automatically reload the files that were open the next 
time UltraEdit is started.  This allows easy reloading of a set of files that are edited on a 
regular basis.  If UltraEdit is invoked automatically for printing, the files are not reopened. 

Use Default/Active File Directory For File Open 
Normally the directory used for the File Open command is the last directory that UltraEdit 
opened a file from.  This directory information is retained when UltraEdit is shutdown and 
restarted. 

When the Use Default Directory for File Open option is set, the normal behavior is 
overridden and the process default directory is used.  This allows the user to specify the 
default directory from the icon or shortcut that invokes UltraEdit.  In this case, UltraEdit does 
not retain the directory information and it always uses the default directory for the process. 

When the Use Active File Directory for File Open option is set, the normal behavior is 
overridden and the directory of the currently active file is used.  This allows the user to easily 
open a file from the same directory as an already open file by activating the file and then use 
the File Open command. 

Only one of these should be selected.  

Edit Configuration Page 
The Edit Configuration Page has the following selections: 

Auto Indent    toggles the state of automatic line indentation 

Allow Positioning Beyond Line End allows the cursor to be positioned beyond the end text in 
a line 

Disable Drag and Drop disables the Drag and Drop Editing feature 

Home Key Always Goto Column 1 forces the Home key to go to the first non-space 
character unless in that position, in which it will go to the 
first column 

Auto Complete File specifies source file for Auto Completion function 

Tab/Word Wrap Change List Tab and Word-Wrap settings will change to reflect the 
extensions shown.  The "default" setting is used for any 
files that do not match the user-defined extensions. 

Use Spaces in place of Tabs tab stops will be based on the number of spaces 
specified below 

Tab Stop Value sets number of spaces to use in place of tabs 

Default Word Wrap on for Each File toggles use of word wrap each time a file is created 

Wrap Method allows user to set wrap at window edge, after selected 
column #, after column # inserting CR/LF, automatically 
insert CR/LF at file open, or set absolute wrap after 
column # 
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Automatic Line Indentation 
UltraEdit provides automatic line indentation.  When automatic line indentation is enabled, 
UltraEdit automatically indents a line to match the indentation of the previous line. The 
indentation is performed by inserting spaces into the document. 

This option is only active in INSERT mode, not in OVERSTRIKE mode. 

Disable Drag & Drop 
UltraEdit supports dragging and drop editing using the mouse. 

Drag and drop editing allows the user to select text in the normal manner and then copy or 
move the selected text by dragging it to a new location with the mouse.  No keyboard 
interaction is required. 

Initially the user selects text in the normal manner.  Once text has been selected, the user 
may click the primary mouse button (usually the left button) on the selected text, at which 
time the mouse pointer changes to a pointer with a small dotted rectangular box at the 
bottom of the pointer.  This pointer indicates you are in the drag and drop editing mode and 
may drag the selection to a new location. 

While keeping the primary mouse button down the selected text may be dragged to a new 
location.  As you move the mouse the cursor will follow the mouse and the cursor indicates 
the new position of the text if you stop pressing the mouse button (and "drop" the text). 

The user may even drag the text from one file to another within UltraEdit.  If the mouse is 
positioned over a different file within UltraEdit, that file will become active and the text may 
be dropped into that file at the cursor position shown. 

At any time, pressing ESCAPE will cancel the drag and drop mode. 

Additionally, instead of moving the text being dragged it may be copied to a new location.  If 
at any time while in the drag and drop mode the CTRL key is pressed and held the mouse 
pointer changes to have a small '+' symbol beside it indicating the text will be copied to the 
new location indicated by the cursor and also remain in the original position. 

Drag and Drop editing is supported in normal, HEX and Column editing modes. 
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Auto-Completion 
UltraEdit provides the ability to complete words automatically while typing.  There are there 
three aspects to the Auto-Completion: 

- When invoked all the keywords from the Syntax Highlighting will be available in the list 
(if the file uses Syntax Highlighting). 

- In configuration under the EDIT tab a user specified file may be used to provide the 
strings for Auto-Completion.  In this case a new line is required for each word, or 
sentence (allowing a complete sentence/paragraph to be specified). 

- UltraEdit will search back 50K in the active file from the cursor location for words that 
match a partially typed word and show these. 

By default Auto-Completion is invoked with Ctrl+Space.  When this is invoked a list box is 
displayed with the possible words/phrases for completion.  If an appropriate word exists it will 
be highlighted.  Typing additional characters will change the selection as appropriate to a 
word that matches the partial word typed. 

The user may use the cursor keys to change the selected word and at any time use the TAB, 
SPACE or ENTER to select the word to be used.  Doing so will cause UltraEdit to replace the 
partially entered word (if present) with the selected word/phrase. 

Shortcut Keys: CTRL+Space 

Tab/Word Wrap Change List 
UltraEdit allows the tab and Word-Wrap settings to be based on the file extension of the file.  
Initially the defaults will be used.  To add an extension type click on "Change List" and a 
dialog will be displayed allowing you to add or edit up to 10 extension types. 

The tab and Word-Wrap settings will change to reflect the extensions shown.  The "default" 
setting is used for any files that do not match the user-defined extensions. 

Tab Settings 
UltraEdit allows for selection of Tab Stops and for Tab characters to be replaced by spaces 
automatically while editing. 

Use spaces in place of Tabs, if checked instructs UltraEdit to replace Tab characters with 
spaces.  If this selection is made, the Tab Stop Value allows selection of the number of 
spaces to use. 

The Tab Stop Value specifies the Tab stops, or the number of spaces to use in place of a 
Tab character. 

If the option to replace Tabs with spaces is chosen, UltraEdit inserts spaces in place of Tabs 
but maintains the Tab Stop spacing using the number of spaces specified. 

UltraEdit does not replace existing Tab characters that may exist within the document. 
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Word Wrap command  
Use this command to automatically wrap words to the next line at the horizontal edge of the 
active window, or at a specified column. 

There are four selectable modes of operation for word wrap: 

Wrap at window boundary, without inserting a hard return. 
Wrap at a specified column number without inserting a hard return. 
Wrap at a specified column number and insert a hard return. 

With this option, an additional option specifies if the file should be automatically wrapped on 
input.  If selected, the file is wrapped on input, otherwise text is only wrapped as it is 
modified. 
Note - The column wrap above wraps on a word boundary.  This may mean that the wrap 
does not occur on the specified column but on a lesser column number. 

Absolute wrap after specified column.  This will wrap exactly at the specified column. 
With this option, an additional option specifies if the file should be automatically wrapped 
on input.  If selected, the file is wrapped on input, otherwise text is only wrapped as it is 
modified. 

If the option to wrap at a specified column AND insert a hard return is made, the file is 
automatically modified to wrap at the column and insert appropriate hard returns. 

Additionally, the Reformat Paragraph feature may be used to wrap a paragraph to the 
specified column number. 

If the editor active window is in HEX mode, this command is not available. 

Find Configuration Page 
The Find Configuration Page has the following selections: 

Show Slim Find dialog shows a slim dialog after the initial find command is 
started with find next/find previous buttons on it 

Continue Find at End of File when a search reaches the end of file and the string is 
not found the search is continued from the other end of 
the file 

Unix Style Regular Expressions use UNIX style/syntax Regular Expressions.  (see 
Appendix 2, Regular Expressions for further details) 

Find dialog defaults to word when set, UltraEdit automatically initializes the 
find/replace dialogs with the word under the cursor 
position.  If not set, it uses selected text if present or the 
last find string. 

Find Next/Prev finds selected text when set, UltraEdit will find the selected text when a 
FIND NEXT/PREVIOUS command is performed instead 
of the previous search string UNLESS Regular 
Expressions is selected. 

Show Slim Find Dialog 
This option determines if the slim Find dialog with Find Next and Find Previous buttons 
should be shown after the find command is initially started. 

If set, the dialog is shown at the top of the screen. 
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Continue Search at End of File 
This option determines if the search for a string is to be continued at the opposite end of the 
file if the string is not found. 

If this option is not set, UltraEdit does NOT wrap around at the end of file when searching for 
a string.  The default behavior is for UltraEdit to continue the search from the opposite end of 
the file when a target is not found. 

Backup Configuration Page 
The backup configuration page allows the editor backup and auto-save options to be set.  
This page provides the following options: 

Backup Files on Save when a file is saved the option to generate a backup file 
is provided 

Default Backup Directory allows all backup files to be copied to the same backup 
directory 

Automatic Backup   automatically saves all open files at the desired interval 

Backup Files on Save 
When a file is saved the option to generate a backup file is provided.  Three choices are 
available: 

No backup file is created - When a file is saved the original file is overwritten and a backup file is 
not created. 

Replace extension with .BAK - When the file is saved, the original file is copied or renamed to a 
backup file with the same filename and a “.BAK” extension in place of the existing 
extension. The modifications are saved to the original filename/extension. 

Append .BAK to the existing extension - When the file is saved the original file is copied or 
renamed to a backup file with the same filename and extension and .BAK is added to the 
filename (filename.ext.BAK).  The modifications are saved to the original 
filename/extension. 

Default Backup Directory 
Normally the directory used for the backup file is the same directory as the source file.  This 
parameter allows all backup files to be copied to the same backup directory. 

If this item is left blank then the directory used will be that of the source file. 

Automatic Backup 
The option is provided to automatically save all open files at the desired interval.  The 
interval is configurable in minutes.  If the interval is set to zero (0) no automatic save is 
performed. 

Two further options are available for backup: 

The option is provided for the automatic save to ignore files that do not have a name (i.e. files 
that were created with the New File command).  This stops the Save As dialog from 
appearing if an unnamed file exists and has been modified. 

The option is provided for the automatic save to ignore files that were downloaded via FTP to 
avoid the delay and possible connection issues of automatically writing a file to a remote 
server. 
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If a file is saved due to the automatic backup/save command a .BAK file is only created for 
the first save of the session.  For subsequent saves with this feature the .BAK file is not 
created or overwritten. 

Spell Checker Configuration 
The spelling checker options configuration page allows selection of the main spelling 
dictionaries to be used by UltraEdit.  The user may select any of the languages shown, or if 
preferred may select none of the languages in which case UltraEdit will use only the user 
dictionary. 

The spelling checker will be slower for more languages selected. 

UltraEdit is not distributed with all dictionaries, as the size of these is prohibitive.  Ensure you 
have installed the appropriate dictionary before selecting a language.  Normally, the English 
(American) dictionary is distributed with UltraEdit. 

Access from this page is given to select the User Dictionaries and additional Spell Checker 
Options. 

Note: The spelling checker performance varies with the options selected.  If the Case 
Sensitive setting is selected the performance can be significantly improved. 

Options Dialog 
You can use the Options Dialog to specify various spelling-checker options. These options 
affect the way the spelling checker operates. 

Ignore Capitalized Words 
When enabled, any words beginning with a capital letter are ignored (i.e., are skipped over 
without being checked). You might enable this option if the text being checked contains 
many proper names. 

Ignore All-Caps Words 
When enabled, any words containing all capital letters are ignored (i.e., are skipped without 
being checked). You might enable this option if the text being checked contains many 
acronyms. 

Ignore Words with Numbers 
When enabled, any words containing embedded digits are ignored (i.e., are skipped without 
being checked). Examples of such words include “Win95” and “Q4.” You might enable this 
option if the text being checked contains many code words or other symbols containing 
digits. 

Ignore Words with Mixed Case 
When enabled, any words containing an unusual mixture of upper- and lower-case letters are 
ignored (i.e., are skipped without being checked). Examples of such words include 
“MicroHouse” and “CapsLock.” You might enable this option if the text being checked 
contains many variable names or other symbols which use case changes to distinguish 
words. 
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Report Doubled Words 
When enabled, any word appearing twice in a row is reported via the Check-Spelling Dialog. 

Case Sensitive 
When enabled, a distinction is made between capitalized and non-capitalized words. For 
example, canada is considered different from Canada, so canada would be reported as a 
misspelling. When the option is disabled, canada and Canada are considered identical. 

Phonetic Suggestions 
When enabled, suggestions are made on the basis of phonetic (sounds-like) similarity to the 
misspelled word. This option tends to improve suggestions for badly misspelled words. 
Enabling this option will increase the time required to locate suggestions. Note that either this 
option or the Typographical Suggestions option must be enabled or no suggestions will be 
offered. 

Typographical Suggestions 
When enabled, suggestions are made on the basis of typographical (looks-like) similarity to 
the misspelled word. This option is appropriate for people who are generally good spellers. 
Note that either this option or the Phonetic Suggestions option must be enabled or no 
suggestions will be offered. 

Suggest Split Word 
When enabled, two separate words will be suggested as a replacement for a misspelling 
containing two joined words. For example, “is the” would be suggested as a replacement for 
“isthe”. 

Match Case in Replacements 
When enabled, suggested replacements for misspelled words will use the same letter-case 
pattern as the misspelled word. When disabled, the replacements will use the case pattern of 
the word as it exists in the dictionary. This option also applies to words defined in auto-
change and conditional-change dictionaries. 

Auto Correct 
When enabled, words defined in auto-change dictionaries will automatically be changed to 
their specified replacements. When disabled, you will be prompted before the words are 
changed. 

Suggestions 
Determines the speed and accuracy of the initial search for suggested replacements for 
misspelled words. When a misspelled word is detected, a search is automatically made for 
suggestions. This option controls the speed and accuracy of this automatic search. Pressing 
the Suggest button in the Check-Spelling dialog causes an increasingly more accurate (but 
slower) search for suggestions. 

OK button 
Closes the Options Dialog, and saves any changes made to the option settings. 
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Cancel button 
Closes the Options Dialog, and discards any changes made to the option settings. 

Dictionaries Dialog 
The Dictionaries Dialog allows you to open and close user dictionaries, and to edit the 
contents of an open user dictionary. The contents of dictionaries are saved in disk files. You 
can open some or all of your user dictionary files at any time. Only open dictionaries are 
checked during a spell-checking operation. 

Add File button 
Opens a user dictionary file. When you select the Add File button, a dialog appears which 
you can use to select the dictionary file to open. The set of open dictionary files is 
remembered, so once you add a dictionary file you don’t need to add it again. If you need to 
create a new user dictionary, use the New button. You can open other applications user 
dictionary files. 

Add Word button 
Causes the word entered in the edit area of the Words list to be added to the currently 
selected dictionary. Note that if the dictionary type is “auto change” or “conditionally change,” 
you must enter a word and a replacement, separated by a colon (e.g., “teh:the”). Note that 
the Add Word button is enabled only when a new word is typed in the edit area of the Words 
list 

The words you add may contain virtually any character, but only words which contain 
embedded periods should have trailing periods (e.g., U.S.A. is OK, but USA. is not). 

Close button 
Closes the Dictionaries dialog. 

Delete Word button 
Causes the word appearing in the edit area of the Words list to be removed from the 
currently selected dictionary. If the dictionary type is “auto change” or “conditionally change,” 
enter just the word without the colon or replacement word. 

Export button 
Saves the contents of the currently selected dictionary to a text file. When you select the 
Export button, a dialog appears which you can use to select the name of the text file to which 
words in the dictionary will be exported. The words are written to the file one per line. If the 
dictionary type is “auto change” or “conditionally change,” words and their replacements are 
written, separated by a colon. 

Files list 
Contains the list of open dictionary files. When you select a file from the list, its contents are 
displayed in the Words list. 
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Import button 
Adds the words contained within a text file to the currently selected dictionary. When you 
select the Import button, a dialog appears which you can use to select the text file to be 
imported. Each word in the selected file is loaded into the dictionary. If the dictionary type is 
“auto change” or “conditionally change,” words in the file must be in word:replacement form 
(e.g., “teh:the”). 

Language 
Displays the language (e.g., English or French) of the words in the currently selected 
dictionary. 

New button 
Creates a new user dictionary file. When you select the New button, a dialog appears which 
you can use to specify attributes of the new dictionary. See the New Dictionary dialog for 
details. 

Remove File button 
Closes the currently selected dictionary file. Closed dictionaries are not checked during a 
spelling check. Although the file is closed, it is not deleted. Closed dictionary files can be 
later reopened using the Add File button. 

Type 
Displays the type or purpose of the currently selected user dictionary. The dictionary type 
indicates what will happen if a word is located in the dictionary during a spelling check. 

Words list 
Contains the list of words in the currently selected user dictionary. If the dictionary type is 
“auto change” or “conditionally change,” then the list contains words and their replacements, 
separated by colons. 

New Dictionary Dialog 
You can use the New Dictionary Dialog to specify the attributes of a new user dictionary. 

Browse button 
Displays a dialog that shows the names of other user dictionary files. You can use the dialog 
to view the names of existing dictionary files, and to enter the name of the new dictionary 
file. 

Cancel button 
Closes the New Dictionary Dialog without creating a new dictionary. 

File Name box 
Contains the name of the disk file used to hold the new dictionary’s contents. You can enter 
a name here or use the Browse button to display a dialog showing the names of other 
dictionary files. 
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Language list 
Specifies the language (e.g., French, English) of the words the new user dictionary will 
contain. If the language you want to use is not listed, select “Other.” 

OK button 
Closes the New Dictionary Dialog and creates the new dictionary. 

Type list 
Specifies the type or purpose of the new user dictionary. The type defines what happens 
when a word is located in the dictionary during a spelling check. 

Check-Spelling Dialog 
The Check-Spelling Dialog appears if a word requiring your attention is detected. You can 
use the dialog to specify whether the word should be ignored or replaced. 

Add button 
Causes the reported word to be added to the dictionary selected in the Add Words To list. 
Use the add button if a correctly spelled word you use often is reported as a misspelling 
(e.g., your family name). If the word is not used frequently, you may want to select the Ignore 
or Ignore All buttons instead. 

Add Words To list 
Indicates which user dictionary words will be added to when you select the Add button. The 
Add Words To list shows all ignore-type user dictionaries currently open. You can open or 
close other dictionaries via the Dictionaries dialog, which is accessible by selecting the 
Dictionaries button. 

Cancel button 
Stops the current spell-checking operation. 

Change button 
Causes the reported word to be replaced with the word in the Change To box. Only this 
occurrence of the reported word is replaced. If you want this and all following occurrences of 
the word replaced, select the Change All button. 

Change All button 
Causes this and all following occurrences of the reported word to be replaced with the word 
in the Change To box. If you want only this occurrence of the word to be replaced, use the 
Change button. If the reported word is one you frequently misspell, you might consider 
adding it to a change-type or suggest-type dictionary via the Dictionaries dialog. You can 
display the Dictionaries dialog by selecting the Dictionaries button. 
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Change To box 
Contains a word that will replace a misspelled word when you select the Change or Change 
All buttons. You can enter a word in the Change To box by typing, or you can select one of 
the suggested replacements from the Suggestions list. 

Consider Changing box 
Contains a word that may be misspelled or otherwise incorrect, and is presented with a 
candidate replacement word. You can change the word by selecting the Change button, or 
skip it by selecting the Ignore button. Note that the label of this box changes to Not in 
dictionary when a misspelled word is detected. 

Dictionaries button 
Causes the Dictionaries dialog to be displayed. You can use the Dictionaries dialog to open 
or close user dictionaries, and to edit the contents of user dictionaries. 

Ignore button 
Causes this occurrence of a misspelled word to be skipped. If the same misspelled word 
appears later, it will be reported. 

Ignore All button 
Causes this and all further occurrences of a misspelled word to be skipped. You might use 
this button if the word reported as a misspelling is actually spelled correctly. If the word is 
one you use frequently, you may wish to ignore it permanently by selecting the Add button. 

Lock Pos. check-box 
Locks the position of the Check-Spelling dialog in place. Normally the Check-Spelling dialog 
attempts to position itself to avoid the window containing the text being checked. When the 
Lock check-box is checked, the Check-Spelling dialog will always appear at the last place 
you positioned it. 

Not in dictionary box 
Indicates that a misspelled word was detected. The word is considered misspelled because it 
could not be located in any open dictionaries, or was located in an exclude-type dictionary. 
Note that the label of this box changes to Consider changing when a word and a suggested 
replacement are displayed. 

Options button 
Causes the Options dialog to be displayed. You can use the Options dialog to set spelling-
checker options. 

Suggest button 
Search more thoroughly for suggested replacements for the current misspelled word. Each 
time you press the Suggest button, a “deeper” search is made. The Suggest button is 
disabled once all possible suggestions have been located. 
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Suggestions list 
Contains a list of suggested replacements for the word reported as misspelled. This list is 
filled in automatically when a misspelled word is detected. Subsequent presses of the 
Suggest button may yield more suggestions. A word selected in this list will be automatically 
copied to the Change To box, where it can be substituted for the misspelled word by pressing 
the Change button. 

Configure Toolbar 
The Toolbar may be configured to include up to 50 items of the user’s choice.  Any feature 
listed in the menus may be configured to the toolbar using the dialog presented. 

The Feature List lists all the features that may be displayed on the toolbar including a Button 
Separator to separate groups of buttons. 

The Toolbar List displays the currently selected list of features in the toolbar. 

To add an item to the toolbar, select the position in the toolbar list at which the new item is to 
be inserted.  In the feature list, select the item to be inserted.  Click the insert button to insert 
the item in the toolbar. 

To remove an item in the toolbar, select the item in the toolbar to be removed.  Click the 
remove button to remove the item from the toolbar. 

The items in the feature list are listed in the same order as they appear on the menus. 
The default button resets the toolbar list to the default configuration. 

Use Large Icons on Toolbar 
If checked, large icons are used on the toolbar.  This option is only read at startup. 

Key Mapping† 
The Key Mapping dialog allows the user to reassign the default key mapping provided by 
UltraEdit to suit their particular needs. 

This dialog shows a list of commands within UltraEdit that may be mapped by the user to a 
key combination of their choice.  Clicking on any of the commands will show the existing key 
assignment (if any) and the command description below the list. 

To add or change a command key assignment: 

1) Select the command you wish to modify from the Commands list. 
2) Click the mouse in the Press New Key entry window area, or TAB to give it focus. 
3) Type the new key assignment just as you would if you were invoking the command - this 

key combination will be captured and displayed. 
4) Click on the Assign button and the new key will be assigned to the command.  If an 

existing key is assigned you will be asked if you wish to delete it and replace with the 
new assignment. 

 

To remove a key assignment: 

1) Select the command you wish to modify from the Commands list. 
2) Select the existing key assignment from the Existing keys list. 
3) Click on the Remove button and the key assignment will be removed. 

 

                                                        
† This feature is only available in the 32-bit version of UltraEdit. 
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To reset the key assignments to the default: 

1) Click on the Defaults button and the key assignments will be reset to the defaults.  The 
user will be prompted to confirm the action. 

File Containing User Keyboard Mapping 
The keyboard mapping file is stored (and searched for when UltraEdit starts up) in the same 
directory as the INI File. The filename is the same as the EXE with the .KBD extension, i.e. 
UEDIT32.KBD. 

File Type Configuration Page 
This page allows the list of file types that appear in the File Open and File Save As dialog 
boxes to be configured.  Up to 10 file types may be configured.  These file types will be 
shown in the file operation dialog boxes in the same order they are shown on this page. 

Each file type configured consists of a file name and file description.  The file name may 
(and probably does) include wildcard characters and may include multiple file extensions 
each separated by a semicolon  “;”(i.e. “*.c;*.cpp”).  The file description is a text field 
describing the file types. 

This dialog also provides a DEFAULT button that resets the file types to the initial settings. 

File Open dialog box 
The following options allow you to specify which file to open: 

File Name 
Type or select the filename you want to open.  This box lists files with the extension you 
select in the List Files of Type box.  

List Files of Type 
Select the type of file you want to open. 

Drives 
Select the drive in which UltraEdit finds the file that you want to open.  

Directories 
Select the directory in which UltraEdit finds the file that you want to open. 

Read Only 
Check this item to open a file in a read-only manner.  Modifications will be disabled. 

Network... 
Choose this button to connect to a network location, assigning it a new drive letter.  
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UltraEdit allows multiple files to be selected from the file list and opened at one time (Except 
UltraEdit-32 on Windows NT†).  To select multiple files, select the first file from the list, then 
with the CTRL key pressed, select other files in the list.  When all files are selected, select 
OK and the selected files will be opened. 

Dragging files from the File Manager into UltraEdit’s window and dropping them will also 
open files. (Releasing the mouse button). 

File Save As dialog box 
The following options allow you to specify the name and location of the file you’re about to 
save: 

File Name 
Type a new filename to save a document with a different name.  A filename can contain up 
to eight characters and an extension of up to three characters.  

Drives 
Select the drive in which you want to store the document. 

Directories 
Select the directory in which you want to store the document. 

Network... 
Choose this button to connect to a network location, assigning it a new drive letter. 

File Associations† 
The File Associations dialog allows the user to associate UltraEdit with selected file types.  
This dialog shows a list of current associations for UltraEdit, and a list of file types that 
UltraEdit determines the user may wish to associate with UltraEdit. 

The user may add or remove file associations using this dialog. 

A file association is used by Windows Explorer to determine which application is to be used 
to open the file when the file is double clicked or opened in the Explorer. 

The list showing UltraEdit Associations shows all file types that are currently associated with 
UltraEdit.  The user may select any item in this list and remove the association with the 
Delete Button. 

To add an association, the user may select an item from the FileTypes/Extensions drop 
down list or type in a new extension and add it with the Add button.  The Description may be 
modified for any file type that is added. 

When an association is added, UltraEdit saves the old association if it exists and restores it if 
the UltraEdit association is later removed using this dialog. 

                                                        
† The normal operation of Windows NT does not permit the selection of long filenames, and multiple 
selection from the open dialog.  To facilitate both operations, the open dialog box normally allows single 
selection with long filenames.  If however the SHIFT key is pressed while the file open dialog is invoked 
multiple selections are permitted with short file names. 
† This feature is only available in the 32-bit version of UltraEdit. 
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Directories Configuration Page 
The Directories Configuration Page allows the default directories used by UltraEdit to be 
configured.  These options are: 

Default Save Directory sets the default directory for saving files with the Save As 
command 

Macro Default Directory sets the default directory for loading and saving macros 

Template Directory  sets the directory for template storage 

Default Save Directory 
Normally the directory used for the Save As command is the default directory which may 
vary depending on which directory was last used for a file open and may be any directory. 

This may be overridden by specifying the default directory that is always presented when the 
Save As command is used.  This item is specified in the Advanced Directories Configuration 
page. 

If this item is left blank then the default directory is the default directory for the process. 

Default Template Directory 
If no directory is defined as the Default Template Directory, templates will be saved in the 
directory currently in use at the time the template is created.  This can cause it to appear that 
templates are not being saved if the user attempts to access Templates in the Advanced 
menu after changing directories. 
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Chapter 12 Syntax Highlighting Features 
This section describes the syntax highlighting features available within UltraEdit and the aspects 
of user configurability. 

The following topics will be covered: 

Selectable Programming Wordfiles 
What is a wordfile? 
Preconfigured Wordfiles 
Alternate Wordfiles Currently Supported: 

Multiple wordfiles are available at “http://www.idmcomp.com/downloads/additional.html” or 
“http://www.ultraedit.com/downloads/additional.html”   

Configuring Languages 
How many languages can I configure? 
What can I change? 
What should not be changed? 

Color Selection 
Selectable colors for up to 10 languages 
Customizable, limited only by platform color settings 
Full Path Name for Wordlist 
Enable Syntax Coloring 

Configurable string characters for syntax highlighting.  This may be up to two characters.   
Delimiters 

What are they? 
What do they do? 
How do I modify them? 
Allowable Characters 

Keywords 
What are they? 
What do they do? 
Modification conditions 
Allowable Characters 

Function Definition Strings 
What are they? 
What do they do? 
How do I modify them? 

Language Specific Indentation 
Indent/Unindent Strings 
How do I modify them? 

Marker Characters 
What are they? 
What do they do? 
How do I modify them? 

Syntax Highlighting Configuration Page 
Syntax highlighting is the ability to recognize predefined words and display them in different 
colors.  This is particularly useful for programmers, and can also be useful to other users 
who may want certain words in a document to show up in a different color. 

UltraEdit provides support for ten languages or word sets that may be recognized.  Each 
word set may be configured to have a different color for the following groups of words: 

Normal Text (Words that are not recognized) 
Words that appear in a comment line, or block comments 
Alternate set of block comments 
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Strings 
Number values (must start with a digit (0-9))  
Up to eight groups of different recognized words 

The Configuration Dialog allows the colors to be selected for the different languages and 
color groups.  This also allows the user to specify the location of the "wordfile" used for 
highlighting. 

For any of the color groups the foreground/text color and the background color may be set.  
By default the background will revert to the background specified for normal text 
(Background Color Automatic will be checked).  This must be unchecked to activate the 
background color. 

Each color may be changed by clicking on the colored box beside the text description.  
When clicked, a dialog box will appear that allows the new color to be selected. 

Additionally for each color group (except Normal Text) font styles of Bold, Italic and 
Underline are available.  These may be selected individually for each color group.  
With some fonts the underline may not always show correctly, and with bold, the 
spacing may not be correct for non-fixed pitch fonts. 

The Auto-Correct Keywords checkbox enables or disables the Auto-Correct feature. 

Note - The highlighting is determined by the file extension (details below).  The file 
extension of the file being modified must be defined in the "wordfile" for one of the 
languages. 

Users may configure the predefined words as follows: 

UltraEdit reads a configuration file (the default file is "WORDFILE.TXT"), to configure the 
syntax highlighting.  This file is read each time the editor starts up.  The size of this file may 
be up to 128KB.  The syntax for this file is as follows: 

Language Definition 
The word set, or language is specified by a /Ln where n has a value of 1 to 10.  This must be 
at the beginning of the line.  A description or name of the language may be specified 
immediately following the /Ln in quotes.  This description if present is displayed when setting 
up the colors for the language.  The description may be up to 18 characters. 

Line Comments 
The comment characters used for line comments is specified by the string "Line Comment = 
"  followed by the comment characters.  Three characters are allowed, if there are less than 
three then the last character must be followed by a space. 

A second set of line comments may be specified by the string "Line Comment Alt = "  
followed by the comment characters.  Three characters are allowed, if there are less than 
three then the last character must be followed by a space. 

As some instances may require that a space is a part of the line comment an alternative 
method to describe the line comment is available.  Using the alternative method, the number 
of characters used is specified by the user with the following syntax: 

"Line Comment Num = xCC " 

where x specifies the number of characters (1 to 3) and IMMEDIATELY following are the 
characters to be used as line comments.  In the example above, x would be 3, and the line 
comment would be CC  (note the space after CC). 
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Block Comments 
The characters used for block comments may also be configured (i.e. /* …  */ for C).  These 
are in the form "Block Comment On = " and "Block Comment Off = " followed by up to five 
characters each that define the comment designators.  For compatibility with previous 
releases, the /* and */ are used for file types that have .C as one of the extensions.  This may 
be overridden.  The first character of the block comments may be a space. 

If a Block Comment On is defined but the Block Comment Off is not defined the commenting 
will stop at the end of the line.  This effectively allows the block comments to be used as line 
comments also. 

Additionally, a second set of block comments may be defined for languages that require it.  
This is particularly useful for ASP allowing HTML comments to be maintained with the 
addition of adding highlighting for ASP blocks. 

The second set of block comments are in the form "Block Comment On Alt = " and "Block 
Comment Off Alt = " followed by up to five characters each that define the comment 
designators.  The first character of the block comments may be a space. 

If a Block Comment On Alt is defined but the Block Comment Off Alt is not defined the 
commenting will stop at the end of the line.  This effectively allows the block comments to be 
used as line comments also. 

File Extensions/Types 
The file extensions that are applicable for this language are specified by the string “File 
Extensions = “ and each extension is separated by a space.   

Color Selection 
Color codes may be specified by adding a line with /Cn at the beginning of the line, where n 
is the color index of 1 to 8. A description or name of the section may be specified 
immediately following the /Cn in quotes.  This description if present is displayed when setting 
up the colors for the language.  The description may be up to 18 characters. 

All information specified remains in effect until overridden with new command information. 

The following example specifies the first language to be used with files with the extensions 
‘C’, ‘CPP’, ‘H’ or ‘HPP’.  The color used for the words is the first selectable color and the 
comment characters are //. 

/L1”C/C++” Line Comment = // Block Comment On = /* Block Comment Off = */ File 
Extensions = CPP C H HPP 

/C1 

auto 
break 
case char const continue chr$ 
default do double 

Case Sensitivity 
If the language is not case sensitive, the keyword Nocase may be added to the command 
line i.e.: 

/L1 Line Comment = // Nocase File Extensions = CPP C H HPP 
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Strings 
When using many programming languages characters in single quotes and double quotes 
are treated as literal strings, and word and comment recognition should be ignored.  This is 
the default behavior for UltraEdit.  There are some languages, (i.e. HTML and others) where 
this behavior is undesirable.  To facilitate such languages the keyword “Noquote” may be 
added to the command line to override the default behavior i.e.: 

/L1 Noquote File Extensions = HTM 

UltraEdit also supports configurable characters for quote strings.  The default characters for 
strings are single and double quotes (‘) and (“).  These may be overridden with the keywords 
“String Chars = “ followed by up to two characters.  This is only required if you wish to use 
different characters from the default.  If for example you wish to use the double quote only 
for strings you would have al line similar to the following: 

/L1”C/C++” Line Comment = // Block Comment On = /* Block Comment Off = */ String 
Chars = “ File Extensions = CPP C H HPP 

Note the “String Chars” portion. 

Additionally, if you have two characters for the strings defined (or using the defaults) and you 
wish to have a different color for each type of string, you may now include the character (i.e. 
double quote) in one of the color groups in a line by itself.  This will override the configurable 
color for the strings that are encapsulated by this character. 

/L1”C/C++” Line Comment = // Block Comment On = /* Block Comment Off = */ String 
Chars = ‘” File Extensions = CPP C H HPP 

/C1 

auto 

break 

 “ 

 …  

In the above example, all strings that have double quotes (“) around them will be colored 
with the color group C1 while strings with a (‘) around them will use the default color for 
strings. 

Escape Character 
In many languages there is a special designated character that is referred to as an Escape 
Character.  This is used to override the normal string characters (and other characters).  If a 
string were defined that itself contained a quote character normally used to define the string, 
the syntax highlighting would interpret this quote as the end of the string.  If however this 
quote character were preceded with an Escape Character the quote character would be 
appropriately treated as part of the string and not the end of it. 

The Escape Character is defined as follows: 

/L1"C/C++" Escape Char = \ …  

In this case the Escape character is defined as a backslash. 
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Keywords 
Note that ALL words starting with the same character may be on the same line or spread 
across multiple lines, however if they are spread across multiple lines the lines must be one 
after the other with no empty lines or other lines between them. 

If the language is case sensitive, the letter ‘A’ is different from ‘a’ and so words starting with 
‘A’ MUST be on a different line from words starting with ‘a’.  If the language is case 
insensitive words starting with the letter ‘A’ must be on the same line as words starting with 
the letter ‘a’. 

Keywords beginning with a Sub String 
There are instances in some languages where it is desirable to highlight keywords that begin 
with a particular sub-string, however the complete word is not known.  UltraEdit provides the 
ability to define sub-strings that are used to determine if a word should be highlighted.  If 
such sub-strings are defined for a particular language under a color group UltraEdit will 
determine if a word begins with one of the sub-strings.  If it does, it will be highlighted 
accordingly. 

The sub-strings should be defined as with any other set of keywords however the line 
containing the sub-strings should start with "** " and all sub-strings should be on the same 
line as in: 

** aaa bbb 

The example above would highlight any words beginning with "aaa" or "bbb". 

Words Starting with '/' 
As UltraEdit uses '/' as a command character words to be highlighted require special 
handling.  To highlight words beginning with a '/' the line should begin with '// ' followed by the 
keywords as in: 

// /mykeyword /anotherkeyword 

HTML Specific 
HTML is considerably different from other languages, and to better facilitate the use of 
UltraEdit for editing HTML files the “HTML_LANG” keyword was added.  When this keyword 
is present the special characters ‘<’ and ‘/’ may be placed in front any keyword as desired 
without all keywords with the special characters all having to be on the same line (unless 
they all begin with the same letter). 

Below is an example portion of a wordfile for HTML: 

/L3”HTML” Line Comment = // HTML_LANG Block Comment On = <!-- Block Comment 
Off = --> File Extensions = HTM HTML 

/C1 
<A </A> <ADDRESS> </ADDRESS> <APPLET </APPLET> 
<B> </B> <BASE <BASEFONT <BGSOUND <BIG> </BIG> <BLINK> </BLINK> 

<BLOCKQUOTE> </BLOCKQUOTE>  
<CAPTION> </CAPTION> <CENTER> </CENTER> <CITE> </CITE> <CODE> </CODE> 
Additional enhancements for HTML will be added in the future. 
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FORTRAN Specific 
FORTRAN is quite different from other languages regarding comments, and to better 
facilitate the use of UltraEdit for editing FORTRAN files the “FORTRAN_LANG” keyword 
was added.  When this keyword is present, UltraEdit treats a ‘C’, ‘c’ or ‘*’ in the first column 
as a line comment indicator and the rest of the line is highlighted as if it were commented 
out. 

Below is an example portion of a word file for FORTRAN: 

/L4”Fortran” FORTRAN_LANG File Extensions = FOR FTN 
/C1 

…  

Note- any of the normal comment indications may also be used (line comments, block 
comments). 

LaTex/Tex Specific 
TeX/LaTeX is quite different from other languages and each command starts with a ‘\’.  To 
better facilitate the use of UltraEdit for editing TeX/LaTeX files the “LATEX_LANG” keyword 
was added.  When this keyword is present, UltraEdit has special handling for syntax 
highlighting to allow words to be appropriately handled and highlighted with the ‘\’, and with 
consecutive words. 

This also allows the recognized words to be placed in the wordfile with out all of them being 
on the same line.  If the word begins with ‘\’ then the second character is used to determine 
which line the word should on.  All words beginning with ‘\a’ should be on the same line as 
other words beginning with ‘\a’ or ‘a’.  In the same way, all words beginning with ‘\b’ should 
be on the same line as other words beginning with ‘\b’ or ‘b’ but on a different line from those 
starting with ‘\a’ etc. 

Below is an example portion of a word file for TeX/LaTeX: 

/L4”TeX/LaTeX” LATEX_LANG File Extensions = TEX LATEX 
/C1 

…  

Note- any of the normal comment indications may also be used (line comments, block 
comments). 
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Delimiters 
UltraEdit has built in delimiters that are used to determine when a new word starts, and when 
a word finishes so that it may be matched against the set of words for a given language.  
With the exception of the ‘<” and ‘>’ characters in HTML a character that is a delimiter may 
not also be part of a word. i.e. you can not say the @ symbol is to be considered part of a 
word, and it is a delimiter between words.  (Future enhancements may allow this). 

With release 4.1 and later, UltraEdit allows the delimiter characters to be configurable by the 
user.  For compatibility, the existing delimiters are retained if the user does not specify the 
delimiters for a given language.  Each language may have its own set of delimiters.  It is not 
necessary to configure the delimiters for languages if you are using the defaults. 

To specify the delimiters, add a NEW line similar to the following to your wordfile: 

/Delimiters = ~!@$%^&*()_-+=|\/{}[]:;”’<> ,.?/7 

Note that the Delimiters should include a space and a TAB character if you want them to be 
considered delimiters.  The line must begin with “/Delimiters =”. 

With release 5.0 it is possible to assign the delimiter characters to the color sections.  If you 
have a character that is a delimiter, such as a ‘+’ and you wish this to be colored with one of 
the group colors you may add this character to a line of its own under the color section.  This 
will retain its recognition as a delimiter and be highlighted with the appropriate color. 

Function Definition Strings 
UltraEdit allows the user to show a list of functions in the active document.  As the definition 
of a function may be different for different languages it is necessary to allow this to be 
configured based on the language. 

This is accomplished by modifying the wordfile and defining the string UltraEdit uses for 
each language.  The string will be used by UltraEdit as a Regular Expression search string to 
find the functions. 

Note - The regular expression string must use UltraEdit style regular expressions.  
This ensures that the function list will always work irrespective of the regular 
expression settings. 

Up to three functions strings per language may now be defined allowing more 
function/procedure formats to be specified. 

To specify the function string add a line similar to the following for the specific language: 

/Function String = "%[a-zA-Z]*)" 

or 

/Function String 1 = "… " 

or 

/Function String 2 = "… "  

This string to be searched for MUST be in quotes.  If required, you can specify that only part 
of the resultant string is displayed in the function list.  To do this, use the tagged expressions 
as defined under the Regular Expressions and enclose the portion of the expression that is to 
be displayed between "^(" and "^") as in: 

/Function String = "%[a-zA-Z]+^(*^))" 

This example would ignore the first word and display the rest of the line. 
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 Indentation 
UltraEdit provides for automatic indentation based on the specific language to indent a block 
of code or to out-dent a block of code. 

For indentation for a specific language add a line similar to the following line under the 
particular language section: 

/Indent Strings = "{" 

Any number of words may be specified in quotes (each word/string must be in a separate set 
of quotes "").  For the word to match it must be the LAST non-space characters of the line.  
The indentation is the next TAB stop from the indentation of the preceding line (same as if a 
TAB key was pressed). 

For out-denting for a specific language add a line similar to the following line under the 
particular language section: 

/Unindent Strings = "}" 

Any number of words may be specified in quotes (each word/string must be in a separate set 
of quotes "").  For the word to match it must be the FIRST non-space characters of the line.  
If the line that contains the string is indented LESS than the preceding line an indentation 
does not occur, otherwise the matching character/word is out-dented to the preceding TAB 
stop and the new line is indented to the same point. 

Marker Characters 
There are times when it is desirable to highlight all characters between two characters.  
UltraEdit provides for marker characters that mark the first and last part of a string that 
UltraEdit highlights between.  All characters between the two characters are highlighted. 

To define marker characters for a specific language add a line similar to the following line 
under the particular language section: 

/Marker Characters = "ab"  

where a is the first character of the string to be highlighted and b is the last character.  Note 
that all characters on a line will be highlighted including spaces.  If the line is a comment or 
string this is ignored. 

Additionally, you may define up to 4 pairs of characters to highlight between as in: 

/Marker Characters = "abcdefgh"  

where strings starting with 'a' and ending with 'b' are highlighted as are strings starting with 'c' 
and ending with 'd' etc. 

The color of the highlighted string is configurable.  To specify the color, add the two 
characters under the appropriate color section as if they were a word such as "ab", "cd" etc. 

The user may modify this file. 

Auto-Correct 
If Syntax Highlighting is enabled UltraEdit will automatically (optionally) check each word 
against the keywords in the wordfile and if the word matches except for the case of the word 
UltraEdit will correct the word to match the case in the wordfile.   

For this to work, the current file must be highlighted with Syntax Highlighting and the 
language as specified in the wordfile must NOT have the "Nocase" command word specified. 
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Chapter 13 Command Line/Invocation Features 
This section describes the command line options available within UltraEdit.   

The following topics will be covered: 

Command Line Parameters 
Long/short filenames 
File Open Methods 

Wildcard Characters 
Lists of Files to open 

Specifying Cursor Position at File Open 
Opening Read-Only Files 
Printing from the Command Line 
Specifying the UltraEdit INI file 
Command line option for line and column 
Invoking macros from the Command Line 

Command Line Parameters 
UltraEdit supports command line parameters specifying files to be opened.  UltraEdit allows 
multiple files to be specified in the command line.  Each of the files specified will be opened 
when UltraEdit starts up.  The filenames on the command line should be separated with a 
space (‘ ‘).  For long file names, they should be enclosed in quotes “”. 

Additionally, UltraEdit support two other methods of opening files on the command line: 

Wildcard characters 
UltraEdit will accept any normal wildcard specification for files to be opened, i.e. “*.c” will 
open all files with the “.c” extension. 

File containing list of files to be opened  
You may specify that the filename on the command line contains a list of files to opened by 
using a “/f” parameter on the command line.  In this case, UltraEdit will read each line of the 
file on the command line, and attempt to open each file.  The file specified on the command 
line when the “/f” parameter is used must contain only filenames, and each filename must be 
on a separate line. 

UltraEdit accepts an “/r” parameter on the command line to open files in a read-only manner. 

To specify the line and column number at which to position the cursor when the file is 
opened, the line number and column number should follow the file name immediately 
separated from the filename by a ‘/’ character follows: 

filename/5/2 This opens the file with the cursor positioned at line 5, column 2.  The 
line number may be specified without specifying the column number. 

The separator character ‘/’ was a comma in previous releases, however as this is a valid 
character for filenames it has been changed.  If it is preferred to use the comma, or another 
character the following line may be added to the INI file: 

LineColumnChar= , 

where the comma may be any character except colon ‘:’, however UltraEdit will not be able 
to open a file that contains this character. 
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UltraEdit accepts a ‘/P’ or ‘/p’ on the command line.  This instructs UltraEdit to print the files 
that appear on the command line automatically and to exit when the files have been printed. 

UltraEdit permits the INI file used for UltraEdit settings to be specified by the user.  If the 
command line contains “/I=filename” this is used. 

Example: /i=c:\windows\uedit32.ini 

The filename must follow the /i= immediately.  It can be a long name with spaces, in which 
case it must be in quotes. 

For more information on the INI settings see INI File Selection. 

UltraEdit allows macros to be automatically invoked from the command line with the 
following syntax added to the command line: 

/M,E,5=”full path of macro file/macro name” 

The /M specifies the macro command 

The ,E specifies that after execution of the macro, the file should be saved and the editor 
exit, this is an optional parameter. 

The ,5 specifies the number of times the macro should run.  This is an optional parameter, 
and if not present the macro will run once if a file is loaded on the command line.  If a file is 
not specified on the command line the macro will not run unless the number of times is 
specified. 

The macro file name is specified in  quotes.  Optionally, the name may include a forward 
slash (/) followed by the name of the macro if the file contains more than one macro.  If a 
macro name is not specified, the first macro in the file will be used. 

DDE Support 
UltraEdit supports the following DDE commands.  They are all part of the “System” topic. 

Command:       Function: 

 

[open(“filename”)] Opens the specified file.  
Following the filename any of 
the normal command line 
parameters may be specified 
for macro running, positioning 
at line number etc. 

 

[save()]       Saves the active document. 

[print(“filename”)]      Print the specified file. 

 

[printto(“filename”,”printername”,”printer driver”,”port”)] Print the specified file to the 
specified printer, giving the printer name, printer driver and port. 

 

These commands must be passed exactly as shown. 

The following example uses DDE open to open a file and run a macro: 

[open(“filename” /M,E,1=”full path of macro file/macro name”)] 
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Chapter 14 System Features 

Move command (System menu) 
Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys. 

Note:  This command is unavailable if you maximize the window. 

Shortcut Keys: CTRL+F7 

Next Window command (Document Control menu)  
Use this command to switch to the next open document window.  UltraEdit determines which 
window is next according to the order in which you opened the windows. 

Shortcut Keys: CTRL+F6 

Size command (System menu)  
Use this command to display a four-headed arrow so you can size the active window with the 
arrow keys. 

After the pointer changes to the four-headed arrow: 

1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the 
pointer to the border you want to move.   

2. Press a DIRECTION key to move the border. 

3. Press ENTER when the window is the size you want. 

Note:  This command is unavailable if you maximize the window. 

Shortcut 

Mouse: Drag the size bars at the corners or edges of the window 
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Chapter 15 Window Management Features 
This section describes the window management options available within UltraEdit.   

The following topics will be covered: 

Window Menu Commands 
Duplicate windows: 

Opening duplicate windows 
Closing duplicate windows 
Moving between duplicate windows 

Cascade: 
How do I cascade windows? 
Why would I cascade windows? 

Tile: 
How do I tile windows? 
How do I control the display order of tiled windows? 

Next/Previous 
Arrange Icons 
Close All Files 
Output Window 
Show in default browser  

World Wide Web Interface: 
Default Browser button/menu item to show current file in the default WWW  
browser. 

Window Configuration: 
Splitter Windows 

Status Bar Data 

Window Menu Commands 
Duplicate Window  creates a duplicate window that views the same document 

Cascade   arranges windows in an overlapped fashion 

Tile Horizontal  arranges windows in non-overlapped horizontal tiles 

Tile    arranges windows in non-overlapped vertical tiles 

Next Window  makes the next window active 

Previous Window  makes the previous window active 

Arrange Icons  arranges icons of closed windows 

Minimize All   minimizes all open documents 

Close All Files  closes all open documents 

Show File in Browser shows active document/file in browser 

Synchronized Scrolling synchronizes vertical scrolling for all non-minimized windows 

Window 1, 2, ...  goes to specified window 
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Duplicate Window command 
Use this command to open a new duplicate window with the same contents as the active 
window.  You can open multiple document windows to display different parts or views of a 
document at the same time.  If you change the contents in one window, all other windows 
containing the same document reflect those changes.  When you open a duplicate window, it 
becomes the active window and is displayed on top of all other open windows. 

Cascade command 
Use this command to arrange multiple opened windows in an overlapped fashion. 

Tile Horizontal command 
Use this command to vertically arrange multiple opened windows in a non-overlapped 
fashion. 

Tile Vertical command 
Use this command to arrange multiple opened windows side by side. 

Next Window command 
Use this command to switch to the next open document window.  UltraEdit determines which 
window is next according to the order in which you opened the windows. 

Shortcut Keys: CTRL+F6 

Previous Window command 
Use this command to switch to the previous open document window.  UltraEdit determines 
which window is previous according to the order in which you opened the windows. 

Shortcut Keys: SHIFT+CTRL+F6 

Arrange Icons Command 
Use this command to arrange the icons for minimized windows at the bottom of the main 
window.  If there is an open document window at the bottom of the main window, then some 
or all of the icons may not be visible because they will be underneath this document window. 

Close All Files 
Use this command to close all documents currently open in UltraEdit.  Any attempts to close 
documents with unsaved changes will cause UltraEdit to prompt the user with a dialog box 
asking if changes need to be saved before closing. 

Note: If documents that are part of a project are closed using this command, UltraEdit will 
not automatically reopen these documents upon the next use of the project.  If you wish to 
reopen files upon the next use of the current project, choose a different project and UltraEdit 
will present a dialog box asking if you wish to close the currently opened files.  Files closed 
in this manner will be reopened when you return to a project. 
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Show File in Browser 
This feature allows the active file to be displayed in the default WWW browser.  For this 
feature to work, the user must have installed a WWW browser and the file types/extensions 
must be registered in Explorer/File Manager.  The file types/extensions used are “.HTML” for 
the 32-Bit version and “.HTM” for the 16-Bit version. 

When selected, UltraEdit creates a temporary copy of the file and invokes the default 
browser with this file.  The temporary file is deleted when the original file is closed, or if the 
user invokes the browser again with the same file. 

Synchronized Scrolling 
If this feature is enabled UltraEdit will scroll all windows that are not minimized when any of 
the windows are scrolled vertically.  This allows viewing two (or more) files together without 
the need to scroll each one individually. 

When the user clicks on the vertical scroll bar to provide scrolling, or on the up/down arrows 
on the vertical scroll bar the windows will be scrolled together. 

Additionally if the user uses the Ctrl+Up/Down for scrolling the windows will be scrolled 
together. 

If the user uses the cursor keys to reposition the file the windows will not be scrolled together 
allowing the user to change position in one file without affecting another file. 

Scrolling by dragging the Thumb on the vertical scroll bar will attempt to scroll the windows 
together, however this method on large files may not keep the files synchronized. 

1, 2, ... command 
UltraEdit displays a list of currently open document windows at the bottom of the Window 
menu.  A check mark appears in front of the document name of the active window.  Choose 
a document from this list to make its window active. 
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Chapter 16 Help Features 
This section describes the user help options available within UltraEdit.   

The following topics will be covered: 

Help Menu Commands 

Adding Help Files 

Help menu commands 
Index  offers you an index to topics on which you can get help 

Add Help File add additional help files to help menu 

Using Help  provides general instructions on using help 

About  displays the version number of this application 

Index command 
Use this command to display the opening screen of Help.  From the opening screen, you can 
jump to step-by-step instructions for using UltraEdit and various types of reference 
information.   

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen. 

Add Help Files 
This menu item allows Windows help files to be added to the UltraEdit Help menu for direct 
reference from within the editor. 

Up to 5 help files may be added and will appear directly above this item in the help menu.  
When this item is selected, a dialog box appears that allows the user to enter the help 
filename and path, or browse for a help file.  Additionally, a field exists for the name of the 
help file that will be used to identify it in the help menu. 

If some text is selected within an open document within the editor, the user may press F1 to 
see a list of user configured help files that may be searched for the selected string.  
Alternatively, with text selected in an open document, the user may select the appropriate 
help file from the help menu and that help file will be searched for the corresponding topic 
that matches the selection. 

The topic will be shown if found in the help file.  If not, the search dialog with closest match 
of topics will be shown. 

The user help files may be Windows Help files (.HLP) or compiled HTML files (.CHM) files. 

Using Help command 
Use this command for instructions about using Help. 

About command 
Use this command to display the copyright notice and version number of your copy of 
UltraEdit. 
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Appendix 1 Keyboard Commands 
 

UltraEdit allows the use of keyboard commands for a number of commonly used features.  
The keyboard commands are listed below: 

F1 Help Show UltraEdit help 
Shift+F1 Context Help Invoke the context help command and cursor. 
Ctrl+N File New Create a new document file 
Ctrl+O File Open Open an existing document file 
Ctrl+F4 File Close Close an existing document file 
Ctrl+S File Save Save the active document 
F12 File Save As Save the active document as a new file 
Ctrl+P File Print Print the active document 
Ctrl+X Edit Cut Cut text from the document into the clipboard 
Ctrl+C Edit Copy Copy text from the document into the clipboard 
Ctrl+V Edit Paste Paste text from the clipboard into the active 

document 
Ctrl+A Edit Select All Select All the text in the active document 
Ctrl+Z Edit Undo Undo the last action if possible 
Ctrl+Y (previously 
Ctrl+A) 

Edit Redo Reverse the last Undo action if possible 

Ctrl+J Edit Select Word Select the current word (same as double click). 
Ctrl+E Edit Delete Line  Delete line the cursor is on 
Ctrl+F11 Edit Delete to Start of Line  Delete from the cursor to start of line 
Ctrl+F12 Edit Delete to End of Line  Delete from the cursor to end of line 
F7 Edit Insert Time/Date Insert time/date at cursor 
Alt+F3 or 
Ctrl+F 

Edit Find Find a character string 

Ctrl+F3 Edit Find Prev Repeat last find toward beginning of file 
F3 Edit Find Next Repeat last find toward end of file 
Ctrl+B Edit Match Brace Find matching brace (,[,{ or },],) 
Ctrl+R Edit Replace Find and replace a character string with another 
Ctrl+G Edit Goto Goto the specified line (or HEX address) 
Ctrl+T Edit Reformat Paragraph Reformat the current paragraph or selected text 
Ctrl+F5 Format To Lower Convert selected text to lower case 
ALT+F5 Format To Upper Convert selected text to Upper case 
F5 Format Capitalize Capitalize first character of each word in selected 

text 
Shift+F5 Format Invert Case Invert case of all characters in selected text 
Ctrl+K Edit Spell Check Invoke the spelling checker 
ALT+C Column Mode Toggle column/block mode on and off 
Ctrl+Backspace Delete previous word Delete the word preceding the cursor 
Ctrl+Delete Delete next word Delete the word following the cursor 
Ctrl+I Insert Literal Character Insert a literal character at the cursor position 
INS Insert/Overstrike Mode Toggle between Insert and Overstrike mode 
Ctrl+H HEX Edit Toggle HEX editing mode 
Ctrl+D HEX Insert/Delete Insert or delete characters in HEX editing mode 
Ctrl+F2 Set Bookmark Toggle bookmark on and off 
F2 Goto Bookmark Goto next bookmark 
Ctrl+M Macro Play Replay a macro 
Ctrl+L Macro Play Multiple Times Replay a macro the specified number of times 
Ctrl+F6 Next Window Make the next document window active 
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Ctrl+Shift+F6 Previous Window Make the previous document window active 
F4 Toggle Window Toggles focus between File Tree View and Edit 

Window 
Alt+F4 Exit UltraEdit Exit UltraEdit 
Alt+0-9 
Shift+Alt+0 - 9 

Insert Template0 Insert user defined template 

F9 DOS Command Run DOS Window command 
Ctrl+F9 Last DOS Command Repeat last DOS Window command 
F10 Execute Window Program Execute Windows Program 
Ctrl+Shift+A Inserts ä character  
Ctrl+Shift+A Inserts Ä character 

(Caps Lock on) 
 

Ctrl+Shift+O Inserts ö character  
Ctrl+Shift+O Inserts Ö character 

(Caps Lock on) 
 

Ctrl+Shift+U Inserts ü character  
Ctrl+Shift+U Inserts Ü character 

(Caps Lock on) 
 

Ctrl+Shift+S Inserts ß character  
Ctrl+Shift+S Inserts ß character 

(Caps Lock on) 
 

Home Beginning of Line Move cursor to beginning of line 
End End of Line Move cursor to end of line 
Ctrl+Up Scroll Up Scroll up one line keeping cursor in view 
Ctrl+Down Scroll Down Scroll down one line keeping cursor in view 
Ctrl+Home Top of Page Move cursor to first character in file 
Ctrl+End Bottom of Page Move cursor to last character in file 
Ctrl+Shift+Up Select Text Up Select one line of text while moving cursor up one 

line 
Ctrl+Shift+Dn Select Text Down Select one line of text while moving cursor down one 

line 
Shift+Home Select to Beginning of Line Select all text from cursor position to first character 

in line 
Shift+End Select to End of Line Select all text from cursor position to last character 

in line 
Ctrl+Shift+Home Select to Top of File Select all text from cursor position to first character 

in file 
Ctrl+Shift+End Select to End of File Select all text from cursor position to last character 

in file 
F8 Display Function List Display Function List 
Alt+Right Arrow Next Paragraph  Position cursor at first not space character of next 

paragraph 
Alt+Left Arrow Previous Paragraph Position cursor at first not space character of current 

paragraph (if positioned mid-paragraph) or previous 
paragraph 

Alt+Page Up Top of Window  Position cursor beginning of first line in of the display 
Alt+Page Down Bottom of Window Position cursor beginning of last line in of the display 
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Appendix 2 Regular Expressions 

Regular Expressions (UltraEdit Syntax): 
 

Symbol Function 
% Matches the start of line - Indicates the search string must be 

at the beginning of a line but does not include any line 
terminator characters in the resulting string selected. 

$ Matches the end of line - Indicates the search string must be at 
the end of line but does not include any line terminator 
characters in the resulting string selected. 

? Matches any single character except newline 
* Matches any number of occurrences of any character except 

newline 
+ Matches one or more of the preceding character/expression.  

At least one occurrence of the character must be found. 
++ Matches the preceding character/expression zero or more 

times. 
^b Matches a page break 
^p Matches a newline(paragraph) 
^t Matches a tab character 
[ ] Matches any single character, or range in the brackets 

^{A^}^{B^} Matches expression A OR B 
^ Overrides the following regular expression character 

^(… ^) Brackets or tags an expression to use in the replace command.  
A regular expression may have up to 9 tagged expressions, 
numbered according to their order in the regular expression.  
The corresponding replacement expression is ^x, for x in the 
range 1-9.  Example: If ^(h*o^) ^(f*s^) matches “hello folks”, ^2 
^1 would replace it with “folks hello”. 

 

Note - ^ refers to the character ‘̂’ NOT Control Key + value. 

Examples: 

m?n matches “man”, “men”, “min” but not “moon”. 
t*t matches “test”, “tonight” and “tea time” (the “tea t” portion) but not “tea 
time” (new line between “tea “ and “time”). 
Te+st matches “test”, “teest”, “teeeest” etc. but does not match “tst”. 
[aeiou] matches every lowercase vowel 
[,.?] matches a literal “,”, “.” or “?”. 
[0-9, a-z] matches any digit, or lowercase letter 
[~0-9] matches any character except a digit (~ means NOT the following) 
 

You may search for an expression A or B as follows: 

"^{John^}^{Tom^} 

This will search for an occurrence of John or Tom.  There should be nothing between the two 
expressions. 
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You may combine A or B and C or D in the same search as follows: 

"^{John^}^{Tom^} ^{Smith^}^{Jones^}" 

This will search for John or Tom followed by Smith or Jones. 

Regular Expressions (Unix Syntax): 
The table below shows the syntax for the "Unix" style regular expressions. 

 

Symbol Function 
\ Marks the next character as a special character. "n" 

matches the character "n". "\n" matches a linefeed or 
newline character. 

^ Matches/anchors the beginning of line. 

$ Matches/anchors the end of line. 

* Matches the preceding character zero or more times. 

+ Matches the preceding character one or more times. 

. Matches any single character except a newline character. 

(expression) Brackets or tags an expression to use in the replace 
command. A regular expression may have up to 9 tagged 
expressions, numbered according to their order in the 
regular expression. 

[xyz] A character set. Matches any characters between brackets. 

[^xyz] A negative character set. Matches any characters NOT 
between brackets. 

\d Matches a digit character. Equivalent to [0-9]. 

\D Matches a nondigit character. Equivalent to [^0-9]. 

\f Matches a form-feed character. 

\n Matches a linefeed character. 

\r Matches a carriage return character. 

\s Matches any white space including space, tab, form-feed, 
etc but not newline. 

\S Matches any nonwhite space characters but not newline. 

\t Matches a tab character. 

\v Matches a vertical tab character. 

\w Matches any letter character including underscore. 

\W Matches any non-letter character. 

 

Note - ^ refers to the character '^' NOT Control Key + value. 
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Examples: 

 m.n matches "man", "men", "min" but not "moon". 

 Te+st matches "test", "teest", "teeeest" etc. but does not match "tst". 

 Te*st matches "test", "teest", "teeeest" etc. AND matches "tst". 

 [aeiou] matches every lowercase vowel 

 [,.?] matches a literal ",", "." or "?". 

 [0-9, a-z] matches any digit, or lowercase letter 

 [^0-9] matches any character except a digit (^ means NOT the following) 

 

You may search for an expression A or B as follows: 

"^(John|Tom) 

This will search for an occurrence of John or Tom.  There should be nothing between the two 
expressions. 

 

You may combine A or B and C or D in the same search as follows: 

"^(John|Tom)(Smith|Jones)" 

This will search for John or Tom followed by Smith or Jones. 

 

Additionally: 

\p              Matches CR/LF (same as \r\n) to match a DOS line terminator 

 

If Regular Expression is not selected for the find/replace and in the Replace field the 
following special characters are also valid: 

Symbol Function 
^^ Matches a "^" character 

^s Is substituted with the selected (highlighted) text of the 
active file window. 

^c Is substituted with the contents of the clipboard. 

^b Matches a page break 

^p Matches a newline(paragraph) (CR/LF). 

^t Matches a tab character 

 

Note - ^ refers to the character '^' NOT Control Key + value. 



 135

Appendix 3 INI File Selection and Advanced Settings 
UltraEdit maintains most of its configuration settings in an INI file.  This allows the user to select 
the INI file to be used under different configurations and allows the user to maintain the settings 
for UltraEdit when using UltraEdit from different workstations on a Network. 

The default INI files used by UltraEdit are ULTRAEDT.INI for UltraEdit and UEDIT32.INI for 
UltraEdit-32. 

Telling UltraEdit Which INI File to Use 
To override the default behavior, you may use a command line parameter, an environment 
variable, or add an INI file to the directory containing UltraEdit. 

The rules are as follows: 

The command line is checked first; if the command line contains "/I=filename" this is used. 

Example: /i=c:\windows\uedit32.ini 

The filename must follow the /i= immediately.  It can be a long name with spaces, in 
which case it must be in quotes. 

If the command line parameter is not found the environment variable is checked.  Please 
note the environment variable specifies the directory that will contain the INI file, NOT the 
INI filename itself.  The environment variable name is UEINIDIR.  If this is defined, UltraEdit 
attempts to use this directory with the default INI file names. 

Finally, UltraEdit will look in the directory the EXE file is running from to locate the INI file 
and if it is not found, the Windows directory will be used. 

Advanced INI Settings 
Additional INI settings have been made available and are currently provided without user 
interface support -i.e. you cannot use a dialog box or menu function in UltraEdit to change 
them.  These have been provided to support user requests. 

These should always be added under the heading [Settings]. 

Auto Reformat = 1 
This setting causes the editor to automatically reformat a paragraph after a paste command 
if the Word-Wrap settings are set to wrap at a specific column number with the insertion of 
hard returns (CR/LF).  UltraEdit defaults to this behavior and setting this value to 0 will 
disable this feature. 

Caret Char = "some character" 
This setting allows a different character to be used in Find/Replace routines from the caret 
(^).  The character should be in quotes.  It is recommended a pipe character (|) or similar 
uncommon character be used. 

Caret Type =  0,1,2 
This setting determines the type of caret.  If set to 0 (default) in Insert Mode the caret will be 
a vertical bar and in Overstrike Mode the caret will be a block caret.  If set to 1 the block 
caret is disabled.  If set to 2 the caret type will be reversed such that in Insert Mode the caret 
will be a block caret and in Overstrike Mode the caret will be a vertical bar. 
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Column Overstrike =1 
With this setting set to one (1), the column operations operate either in insert mode (as 
default) or overstrike/overpaste mode based on the insert/overstrike keyboard setting.  This 
is toggled by the Insert Key and shows up on the status bar. 

If in the overstrike mode, cut/delete operations will remove the contents but leave spaces so 
that column data is not shifted.  Paste operations will paste over the current position data 
and not shift columns either. 

If its is preferred that the overstrike mode is what you require permanently for column mode, 
you may set the INI value to two (2). 

ConvertKBDInput = 1 
This setting instructs UltraEdit to convert the keyboard input from ANSI to OEM if an OEM 
font is selected.  The default setting is not to perform any conversion. 

Default File Type = 0, 1 or 2 
This setting determines the default file type for NEW files created within UltraEdit.  The 
default (0) is for DOS files.  Set this to 1 for UNIX files, or 2 for MAC files. 

DisableFlatToolBar = 1 
This setting disables the "Flat" style toolbar for Windows 95 and Windows NT 4.0 and later.  
If this setting is used, the toolbar will be shown with the raised buttons and separators 
between buttons. 

DontUseRename = 1 
This setting affects how UltraEdit generates the backup file.  The reason for the setting is 
that on some systems, if UltraEdit renames the original file to the backup the original file 
when it is recreated does not maintain the file permissions that previously existed. 

This setting instructs UltraEdit to copy the original file to the backup and not to rename it.  
This is slower than renaming it but does preserve the file permissions. 

This can also be useful in the case of FTP connections to Operating Systems such as Unix 
in which filenames are case sensitive.  If this setting is used the case of the filename will be 
preserved.  If the file is renamed in UltraEdit mixed case filenames will be changed to a 
uniform case. 

Large File Buffers = 1 
This setting determines if UltraEdit should use larger buffers internally for some of its 
operations.  This can speed up some operations on very large files but is very much 
hardware dependent. 

Lock File  = 1 
This setting causes the editor to keep the lock on any file that is opened.  Additionally, if the 
file is already locked, it allows for open by read-only in this case prompting the user with a 
dialog box to confirm the open as read-only.  This feature prevents modification of a file from 
outside of the edit session preventing loss of changes made. 
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Make Changed Files Active = 1 
This setting sets instructs UltraEdit to make any file it detects as changed and reloads to be 
the active file.  The default setting (0) is not to make the file active. 

Max Columns   =  
This setting specifies the maximum columns allowed within UltraEdit before it wraps the line 
(soft wrap).  The default is 4096 columns but a maximum of 9216 is allowed.  Some video 
drivers have a problem when this is set too high. 

New File = 0 
This setting instructs UltraEdit not to create a new empty document file when it starts up 
without other files to open.  The default setting is to create a new document file if no files are 
being opened automatically when UltraEdit starts up. 

No Temp Confirm = 0 
This disables the dialog box asking for confirmation when opening a file without a temporary 
file. 

Open Link Files = 1 
This setting causes the editor to open the link for modification.  The default setting of FALSE 
causes UltraEdit to expand the link to open the root file. 

Open Maximized = 1 
This setting determines if UltraEdit should always open its main window in a maximized 
state.  The default is for UltraEdit to remember the previous settings.  If this setting is set to 
1, UltraEdit will open the main window in a maximized state. 

Reload FTP Files = 1 
This setting determines if UltraEdit should reload FTP files when it reloads files for a 
project/workspace.  Typically UltraEdit does not reload FTP files automatically due to the 
potential time delay in connecting and load the files.  Setting this to 1 will ensure UltraEdit 
treats FTP files as normal files in this regard. 

Show Tag Descriptions = 1 
This setting determines if UltraEdit should show the descriptions for the tags in the Tag List.  
By default the tags are shown.  If this value is set to 0, the tags will not be shown. 

Sort Function List = 0 
This setting determines if UltraEdit should sort the Function List output when it is shown.  By 
default the Function List is sorted.  If this value is set to 0, the Function List will not be 
sorted. 
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Temp File Dir 
This setting allows the user to specify the directory UltraEdit uses for the temporary files it 
creates while editing.  Normally this should not be set but can be used if editing large files 
and there is not sufficient room in the temp directory for the temporary files UltraEdit creates. 

The format is: 

Temp File Dir= "directory" 

TitleNameOnly = 0 
This setting allows the user to specify that UltraEdit should only display the filename only 
and not the path in the title bar for the editing window.  When set to 0 the filename and path 
will be displayed (default).  When set to 1, only the filename will be displayed. 

Use DDE Associations = 0 
When File Associations are set from within UltraEdit the setting to use DDE is normally set in 
the registry for the specific file type.  On some systems this may cause an error message 
when the file is double clicked from Explorer.  In this case setting Use DDE Associations = 0 
may resolve this.  The file associations will need to be modified for this to take effect. 

Use Registry = 1 
This setting causes the editor to save and retrieve all settings from the Registry.  After 
UltraEdit determines the INI file in use it checks for this value before reading any other 
values.  If this is set, UltraEdit stores all settings in the Registry. 
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Appendix 4 Macro Parameters 
To modify the macro, commands may be typed directly into the macro edit box or selected 
from the command list.  Commands are not case sensitive but must be spelled exactly as 
shown in the command list. 

The table below shows the commands that may be added any parameters: 

Commands Parameters* Description 

“”  Insert text between the quotes (“”).  The closing 
quote must be the last non-space character on the 
line.  The characters to be inserted may cross 
multiple lines.  To insert a quote (“), place it as 
needed in the text being inserted and ensure the 
last character is also a quote.  To insert just one 
quote character (“) the line should look like this: 

 

“”” 

 

To insert a new line, add a line between the open 
quote and close quote.  To insert two lines with 1 
and 2 at the beginning of the lines the command 
should be as follows: 

 

“1 

2” 

AnsiToOem  Convert ANSI character set to OEM character set. 

Bottom  Jump to end of file. 

CloseFile  Close the active file. 

ColumnModeOff  Turn the column mode off. 

ColumnModeOn  Turn the column mode on. 

ColumnCut  Cut selected columns in column mode. 

ColumnDelete  Delete selected columns in column mode. 

ColumnInsert “” Insert string between quotes into selected 
columns. 

ColumnInsertNum Start number increment 
Leading Zero (optionally) 

Insert number in selected columns. 

Copy  Copy selected text to the clipboard. 

Cut  Cut the selected text from the file to the clipboard. 

Delete  Delete the selected text. 

DeleteLine  Delete the current line. 
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DeleteToEndofLine  Delete the current line from cursor position to End 
of Line. 

DeleteToStartofLine  Delete the current line from cursor position to 
Start of Line. 

DosToMac  Convert the file (line terminators) to MAC format. 

DosToUnix  Convert the file (line terminators) to UNIX format. 

Else  Else function for an IF…  command. 

IfSel 

…  

Else 

do these commands if the IfSel failed. 

Endif 

EndIf  Ends the block of instructions controlled by the 
IfFound/IfNotFound statements. 

EndLoop  End of loop - go back to beginning of the loop - 
see the Loop command. 

EndSelect  Stop Selecting Text (see Start Select for details). 

ExitLoop  Exit loop and go to first command after the loop 
(after the EndLoop command) - see the Loop 
command. 

ExitMacro  
  

 Exit Macro without processing any additional 
commands or returning an error. 

Find "" (Search string in quotes) 
MatchCase - indicates the 
search is case sensitive 
(optional) MatchWord - 
indicates the search string 
will only match instances 
that are a complete word 
(optional) RegExp - 
Indicates a Regular 
Expression search 
(optional) Up - Indicates 
search in reverse direction 
(optional) 

Find the string in quotes “” based upon the 
parameters specified. 

GetString prompt Prompts the user for a string that is inserted in the 
file at the current location.  The prompt is the 
prompt or question that is displayed to the user 
when the macro is run. 

GetString "Where country do you live in? 
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GetValue prompt Prompts the user for a value that is inserted in the 
file at the current location.  The prompt is the 
prompt or question that is displayed to the user 
when the macro is run. 

GetValue "How old are you? 

GotoBookMark  Jump to the next bookmark. 

GotoBookMarkSelect  Jump to the next bookmark and select text from 
cursor position to bookmark. 

GotoLine Line number (#) Jump to specified line number. 

GotoLineSelect Line number (#) Jump to specified line number and select text 
from cursor position to line. 

GotoPage Page number (#) Jump to specified page number. 

GotoPageSelect Page number (#) Jump to specified page number and select text 
from cursor position to page number. 

HexDelete Number of bytes to delete 
(#) 

Delete the specified number of bytes from the file. 

HexInsert Number of bytes to insert 
(#) 

Insert the specified number of bytes into the file. 

HexOff  Turn Hex mode off - switch to text mode. 

HexOn  Turn Hex mode on. 

IfCharIs "string" or number This checks if the current character at the cursor 
position is in the specified string, or matches the 
decimal number. 

IfCharIs "xyz” 

…  do these commands if the current character is 
x, y, or z. 

…  

EndIf 

IfCharIs 34 

…  do these commands if the current character is 
decimal value 34 - a double quote. 

…  

EndIf 

IfColNum number This checks if the current cursor position is the 
specific column number. 

IfColNum 10 

…  do these commands if the current cursor 
position is column 10.  Column 1 is the first 
column. 

…  

EndIf 
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IfEof  This checks if the current cursor position is at the 
end of file. 

IFEof 

…  do these commands if at end of file 

…  

EndIf 

IfFound    This checks the results from the last find 
command in the macro and will execute the next 
set of instructions up to an "EndIf" if the last 
search was successful: 

Find "something" 

IfFound 

…  do these commands if "something" was found 

…  

EndIf 

IfNotFound   This checks the results from the last find 
command in the macro and will execute the next 
set of instructions up to an "EndIf" if the last 
search was NOT successful: 

Find "something" 

IfNotFound 

…  do these commands if "something" was NOT 
found 

…  

EndIf 

IfSel  This checks if there is currently any selected text 
within the active file. 

IfSel 

…  do these commands if "something" is selected 

…  

EndIf 

InsertMode  Change text editing mode to insert mode for 
characters typed 

InsertPageBreak  Inserts a page break character at the current 
cursor position. 

InvertCase  Invert the case of selected text. 
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Key Backspace 

Ctrl+ 

DEL 

DOWN ARROW 

END 

HOME 

LEFT ARROW 

PGDN 

PGUP 

RIGHT ARROR 

UP ARROW 

Insert a key command into the macro.  Generally 
used for navigation in the file and for backspace 
or delete.  The “Ctrl+” modifier may be used as 
with normal editing to modify the command. 

 

For text input the “” string command is used, not 
the Key command. 

 

Loop x Loop x times where x is a number.  A value of 0 
indicates Loop forever.i.e. 

Loop 10 

…  do these commands 10 times 

…  

EndLoop 

Next Window  Switch to next window. 

NewFile  Create a new document in UltraEdit. 

OemToAnsi  Convert OEM character set to ANSI character set. 

Open  File name (“”) Open the specified file.  The Filename must be in 
quotes. 

OverStrikeMode  Change text editing mode to overstrike mode for 
characters typed. 

Paste  Paste the contents of the clipboard into the file. 

PlayMacro Number of times to play it 
(#) 

 

Macro name (“”) 

Play another macro.  Specify the number of times 
toplay the macro first, then the macro name.  The 
macro name must be in quotes. 

PreviousWindow  Switch to previous window. 
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Replace All - Replace all 
occurrences. 

 

AllFiles - Replace in all 
open files (requires All). 

 

Selected Text - Replace in 
selected text (Requires All). 

 

Replace String (“”) - String 
to replace the found string. 

 

The Replace command replaces the previously 
found string with the string specified.  This 
command MUST follow a Find command. 

 

As with the Find string, the replace string must be 
in quotes. The closing quote must be the last non-
space character on the line. 

 

The replace string may cross multiple lines 
however if the last non-space character in any line 
is a quote it will terminate the string.  All special 
characters permitted by the Replace Command 
are permitted here. 

ReturnToWrap Column number (#) at 
which wrap is performed. 

Zero for the column 
number indicates the wrap 
is to occur at the window 
boundary. 

Convert the file from hard returns to word wrap. 

Save  Save active file. 

SaveAs File name (“”) Save the active file as the filename specified. The 
Filename must be in quotes.  "^s" may be used in 
the filename.  UltraEdit will replace this with the 
currently selected text in the active Window.  
Likewise, "^c may be used and UltraEdit will 
replace this with the contents of the clipboard. 

SelectAll  Select all text in the current file. 

SelectToBottom  Select all text from the current position to the end 
of file.  

SelectToTop  Select all text from the current position to the top 
of file. 

SelectWord  Select the current word (same as double clicking 
a word). 

SortAsc IgnoreCase - Ignore case of 
characters in the sort. 

 

RemoveDup - Remove 
duplicate lines. 

Sort the file, or selected text in ascending order. 

SortDes IgnoreCase - Ignore case of 
characters in the sort. 

 

RemoveDup - Remove 
duplicate lines. 

Sort the file, or selected text in descending order. 

SpacesToTabs  Convert all of the (leading) spaces in a file to 
tabs. 
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SpacesToTabsAll  Convert all of the spaces in a file to tabs. 

StartSelect  Start selection.  This turns the selection mode on.  
Any cursor movement or positioning will be with 
selection on and the text is selected.  EndSelect 
will stop the selection mode.  The selected text 
will remain selected until another command 
causes it not to be selected as with normal 
editing. 

TabsToSpaces  Convert all of the Tab characters within a file to 
spaces. 

Template Template Number (#) Insert the specified template into the file. 

TimeDate  Insert the time and date into the file at the current 
location. 

ToCaps  Capitalize each word in the selected text. 

ToggleBookMark  Set or remove a bookmark at the current line.  

ToLower  Convert the selected text to lower case. 

Top  Jump to top of file. 

ToUpper  Convert the selected text to upper case. 

TrimTrailingSpaces  Trim trailing spaces from each line of current file. 

UnixMacToDos  Convert the active file (line terminators) from 
Mac/Unix to DOS format. 

WrapToReturn Column number (#) at 
which wrap is performed. 

 

Zero for the column 
number indicates the wrap 
is to occur at the window 
boundary. 

Convert the file from word wrap to hard returns. 

 

Where (#) exists in the parameter column a numeric value is to be entered for that 
parameter. Likewise, where (“”) exists in the parameter column a string is to be entered 
between quotes. The text only describes the meaning of the parameter.  All string 
parameters must be the last parameter. 
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APPENDIX 5 – Installation and Registration 

Installation Options 

PC/Network Installation 
UltraEdit may be installed either on a workstation or on a network.  This option is presented 
during the installation process. Installation to PC installs the necessary files and sets up the 
appropriate links. 

If a user chooses a network installation rather than a workstation installation, there are two 
options: 

Installation TO a Network copies all files to the network directly but adds no shortcuts or links 
to the installed files. 

Installation FROM a network creates the necessary links and shortcuts to network installed 
files. 

Silent Installation 
Executing the self-extracting EXEs (ULTRAEDI.EXE and UEDIT32I.EXE) without any 
parameters is the normal method of installing UltraEdit.  This leads the user through the 
installation allowing the user to select the appropriate location and options. 

In some cases it may be desired to perform a silent installation of UltraEdit to allow 
automated unattended installations.  This is possible with the following settings: 

uedit32i /s /m=filename 

 /s This indicates a silent install 

/m This indicates the file location (fully qualified path/filename) of the file with the 
install parameters. 

Currently there are two possible install parameters.  If these are not set they will default to 
the same defaults provided with a normal interactive installation. 

 MAINDIR=C:\PROGRAM FILES\ULTRAEDT  - This specifies the installation directory 

INSTALL_TYPE=A - This specifies the install type (The 
possible options are A=Normal, B=From 
Network, C=To Network) 
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Obtaining Authorization Information 
Users are provided an authorization code upon registration.  Users should have 45 days (30 
if they tried an earlier version) to evaluate UltraEdit without a code.  After this they must 
register to use it. 

When UltraEdit is started the "nag" screen should disappear after several seconds.  Do not 
press the "Enter Authorization" code button until you register. 

After the trial period users must register to continue to use UltraEdit.  The cost of registration 
is $30.00 for a single user license, $15.00 for an upgrade. 

Registration may be placed by one of the following methods: 

SECURE order form at: http://www.idmcomp.com 
FAX/Telephone by calling (513) 779 8549. 
MAIL - send payment/order to:  

 
IDM Computer Services 

 8209 Chestnut Hill Ct. 
 West Chester, OH 45069 
 USA 
 
E-Mail to idm@idmcomp.com or CompuServe 71613,2654 

Payment may be by one of the following methods: 
Credit Card - Visa, MasterCard, Amercian Express 
Check/Postal Money Order (Payable in US Dollars drawn on an US Bank Branch)  
CompuServe Online registration *** NOT FOR UPGRADES *** 
 (GO SWREG, register ID 2662 (UltraEdit) or ID 4017 (UltraEdit-32) 
Cash. 
Purchase Order (Not for single $15.00 upgrades) 

Uninstall or Overwrite? 
The suggested option is to overwrite the existing installation of UltraEdit without uninstalling.  
This will maintain your current INI settings.  You will be prompted as to whether or not you 
wish to overwrite your wordfile.  If your wordfile is overwritten and you later wish to use your 
old wordfile, it will be renamed wordfile.old. 
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APPENDIX 6 – License Agreements 

License Agreement – Unregistered 
LIMITED WARRANTY 

THE PROGRAM IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER 
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO WARRANTIES OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.  IN NO EVENT WILL 
THE AUTHOR or AUTHORS BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING 
INCIDENTAL OR CONSEQUENTIAL DAMAGES, ARISING OUT OF THE USE OF THE 
PROGRAM, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS LICENSE, UNDERSTAND IT AND 
AGREE TO BE BOUND BY ITS TERMS AS THE COMPLETE AND EXCLUSIVE 
STATEMENT OF THE AGREEMENT BETWEEN US, SUPERSEDING ANY PROPOSAL 
OR PRIOR AGREEMENT, ORAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS 
BETWEEN US RELATING TO THE SUBJECT MATTER OF THIS LICENSE. 

UltraEdit/UltraEdit-32 is a shareware program and is provided at no charge to the user for 
evaluation.  The purpose of shareware software is to provide personal computer users with 
quality software on a "try before you buy" basis, however payment is still required for 
continued use of the product. 

If you find this program useful and continue to use it after the trial period, you must make a 
registration payment (see the registration instructions for details).  This registration fee will 
license one user to use one copy of UltraEdit and/or Ultraedit-32 on any one computer at any 
one time.  All users will receive a copy of the latest release when they register, or it will be 
made available for downloading, and free technical support. 

Commercial users must register and pay for their copies within 45 days of first use or their 
license is withdrawn.  Site License and multiple user license arrangements may be made by 
contacting IDM Computer Solutions, Inc. 

Anyone distributing this product for any kind of remuneration must first contact IDM 
Computer Solutions, Inc. for authorization. 

You may distribute this software to friends and colleagues but you must include all files in 
the original distribution.  Please encourage them to register their copy if they find that they 
make use of it. 
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License Agreement – Registered 
This is a legal agreement between you (either an individual or an entity) and IDM Computer 
Solutions, Inc.  By opening the sealed software packages (if appropriate) and/or by using the 
SOFTWARE, you agree to be bound by the terms of this Agreement.  If you do not agree to 
the terms of this Agreement, promptly return the disk package and accompanying items for a 
full refund. 

SOFTWARE LICENSE 

1. GRANT OF LICENSE.  This License Agreement (License) permits you to use one copy 
of the software product identified above, which may include user documentation provided in 
on-line or electronic form (SOFTWARE).  The SOFTWARE is licensed as a single product, 
to an individual user, or group of users for Muliple User Licenses and Site Licenses.  This 
Agreement requires that each user of the SOFTWARE be Licensed, either individually, or as 
part of a group.  A Multi-User License provides for a specified number of users to use this 
SOFTWARE at any time.  This does not provide for concurrent user Licensing.  Each user of 
this SOFTWARE must be covered either individually, or as part of a group Multi-User 
License.  The SOFTWARE is in use on a computer when it is loaded into the temporary 
memory (i.e. RAM) or installed into the permanent memory (e.g. hard disk) of that computer.  
This software may be installed on a network provided that appropriate restrictions are in 
place limiting the use to registered users only. 

2. COPYRIGHT.  The SOFTWARE is owned by IDM Computer Solutions, Inc. and is 
protected by United States Of America copyright laws and international treaty provisions.  
You may not copy the printed materials accompanying the SOFTWARE (if any), nor print 
copies of any user documentation provided in on-line or electronic form.  You must not 
redistribute the registration codes provided, either on paper, electronically, or as stored in the 
files ULTRAEDT.REG, UEDIT32.REG, ULTRAEDT.INI, ULEDIT32.INI or any other form. 

3. OTHER RESTRICTIONS.  The registration notification provided, showing your 
authorization code and this License is your proof of license to exercise the rights granted 
herein and must be retained by you.  You may not rent or lease the SOFTWARE, but you 
may transfer your rights under this License on a permanent basis, provided you transfer this 
License, the SOFTWARE and all accompanying printed materials, retain no copies, and the 
recipient agrees to the terms of this License.  You may not reverse engineer, decompile, or 
disassemble the SOFTWARE, except to the extent the foregoing restriction is expressly 
prohibited by applicable law. 

LIMITED WARRANTY 

LIMITED WARRANTY.  IDM Computer Solutions, Inc. warrants that the SOFTWARE will 
perform substantially in accordance with the accompanying printed material (if any) and on-
line documentation for a period of 365 days from the date of receipt. 

CUSTOMER REMEDIES.  IDM Computer Solutions, Inc. entire liability and your exclusive 
remedy shall be, at IDM computer Solutions, Inc. option, either (a) return of the price paid or 
(b) repair or replacement of the SOFTWARE that does not meet this Limited Warranty and 
that is returned to IDM Computer Solutions, Inc. with a copy of your receipt.  This Limited 
Warranty is void if failure of the SOFTWARE has resulted from accident, abuse, or 
misapplication.  Any replacement SOFTWARE will be warranted for the remainder of the 
original warranty period or thirty (30) days, whichever is longer. 

NO OTHER WARRANTIES.  To the maximum extent permitted by applicable law, IDM 
Computer Solutions, Inc. disclaims all other warranties, either express or implied, including 
but not limited to implied warranties of merchantability and fitness for a particular purpose, 
with respect to the SOFTWARE and any accompanying written materials. 

NO LIABILITY FOR CONSEQUENTIAL DAMAGES. To the maximum extent permitted by 
applicable law, in no event shall IDM Computer Solutions, Inc. be liable for any damages 
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whatsoever (including, without limitation, damages for loss of business profits, business 
interruption, loss of business information, or other pecuniary loss) arising out of the use or 
inability to use the SOFTWARE, even if IDM Computer Solutions, Inc. has been advised of 
the possibility of such damages. 
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Index 
 

Advanced Features, 86 
Advanced Menu Commands, 86 
Alternate Capture Method, 91 
Display/Modify Templates command, 87 

Special Strings, 87 
DOS Command, 89 
Insert Templates Command, 89 
Run Windows Program, 91 
Tools Configuration/Use, 92 

Command Line, 92 
Command Output, 93 
Menu Item Name, 93 
Windows Program Checkbox, 93 
Working Directory, 93 

Advanced INI Settings, 135 
Auto Reformat, 135 
Caret Char = "some character", 135 
Caret Type, 135 
Column Overstrike, 136 
ConvertKBDInput, 136 
Default File Type, 136 
DisableFlatToolBar, 136 
DontUseRename, 136 
Large File Buffers, 136 
Lock File, 136 
Make Changed Files Active, 137 
Max Columns, 137 
New File, 137 
No Temp Confirm, 137 
Open Link Files, 137 
Open Maximized, 137 
Reload FTP Files, 137 
Show Tag Descriptions, 137 
Sort Function List, 137 
Temp File Dir, 138 
TitleNameOnly, 138 
Use DDE Associations, 138 
Use Registry, 138 

Alternate Capture Method, 91 
ANSI to OEM, 29, 75 
ASCII Table, 69 
ASCII to EBCDIC, 28 
ASCII to Unicode, 29 
Backup, 95, 104 
Carriage Return/Line Feed, 73 
Close All Files command, 20 
Column/Block Editing, 77 
Column/Block Editing Features, 77 

Column Menu Commands, 77 
Column Mode, 78 
Cut Columns command, 78 
Delete Columns, 78 
Insert Number, 79 
Insert/Fill Columns, 78 
Sum Columns/Selection, 79 

Command Line Parameters, 123. See also Tools 
Configuration/Use 
Wildcard characters, 123 

lists of files, 123 
Command Line/Invocation Features, 123 

DDE Support, 124 
Compare Files, 26 
compiler, 90 
Configuration Features, 95 
Date/Time, 42 
Display Features, 58 

Adding Individual Tag Lists, 65 
ASCII Table, 69 
Creating Custom Tag Lists, 64 
Display Line Numbers, 69 
Display Ruler, 68 
File Tree View, 62 

Common, 63 
Open Files, 63 
Project Files/Drive, 63 

Function List, 63 
Insert/Overstrike Modes, 61 
Line Spacing, 69 
Macro List, 63 
Mirror Display Font, 67 
No Scroll Left Side of Marker 1, 68 
OEM Character Set, 67 
Open File Tabs, 62 
Output Window, 66 
Replacing the Default Tag List, 66 
Reset Fonts, 67 
Set Colors, 67 
Set Column Markers, 68 
Set Font, 66 

Font dialog box, 67 
Set HEX/Column Mode Font, 66 
Set Printer Font, 67 
Show Column Marker 1/2, 68 
Show Spaces/Tabs, 68 
Status Bar command, 60 
Tag List, 64 
Tag List Modify, 64 
Toolbar command, 60 
View as (Highlighting File Type) command, 60 
View Menu Commands, 59 

Display/Modify Templates command 
Special Strings 

Date, 88 
Time, 87 

DOS Command, 89 
DOS to MAC, 28 
DOS to UNIX, 28 
EBCDIC to ASCII, 28 
Edit Features, 36 

Blocking Text, 40 
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Comment Add/Remove, 42 
Copy command, 38 
Cursor Movement, 37 

Cursor Arrows, 37 
Home and End, 37 
Insert/Overstrike Modes, 39 
Text Selection/Highlighting, 39 

Cut command, 38 
Delete, 41 
Delete Line, 41 
Delete to End of Line, 41 
Delete to Start of Line, 42 
Drag and Drop Editing, 41 

Drag and Drop Files, 41 
Edit Menu Commands, 36 
Insert Color, 43 
Insert Date/Time, 42 
Insert Literal Character, 43 
Multiple Clipboards, 39 
Paste command, 39 
Read Only Command, 42 
Redo command, 38 
Right Mouse Button Commands, 43 
Scrolling, 38 

horizontal, 38 
vertical, 38 

Select All command, 39 
Select Line command, 40 
Select Range, 40 
Selecting Text, 40 
Spelling Checker, 42 
Undo command, 38 
Word Wrap Command, 42 

Edit Menu Commands, 36 
File Conversion 

ANSI to OEM, 29 
ASCII to EBCDIC, 28 
ASCII to Unicode, 29 
DOS to MAC, 28 
DOS to UNIX, 28 
UNIX/MAC to DOS, 28 

File Management, 16 
Advanced Sort and Options, 27 

Ignore Case, 28 
Remove Duplicates, 27 
Sort Order, 27 
Starting Column, 28 

Case Sensitive File Names, 26 
Close command, 20 
Compare Files, 26 

Differences in color, 26 
Differences Side-by-Side, 27 
Ignore Blanks, 27 
Only Show Lines That Differ, 27 
Saving/Printing Output, 27 

Delete Active File command, 29 
Exit command, 35 
Favorite Files 

+All Open Files, 35 

Favorite Files, 34 
Add Active File, 35 
Add Directory, 35 
Add File, 34 
Close, 34 
Open, 34 
Remove File, 35 

File Conversion, 28 
FTP, 21 

FTP Accounts, 21 
FTP Accounts - Advanced, 22 
Open from FTP, 23 

Create Dir, 24 
Delete, 24 
Permissions, 24 
Refresh, 24 
Rename, 24 

Save As to FTP, 24 
Create Dir, 25 
Delete, 25 
Permissions, 25 
Refresh, 25 
Rename, 25 

Insert File, 29 
Insert String at Every Increment, 30 

End Point, 30 
Start Point, 30 

Large file handling, 29 
Make Copy/Backup, 26 
New command, 19 
Open command, 19 

File Open Dialog Box, 19 
Page Setup, 31 

Page Break Character, 33 
Page Margins, 33 
Print 2 Pages on 1 Sheet, 33 
Print Line Numbers, 33 
Print Syntax Highlighting, 33 
Wrap Text When Printing, 33 

Print Setup, 33 
Network, 34 
Options, 34 
Orientation, 34 
Paper Size, 34 
Paper Source, 34 
Print Setup Dialog Box, 33 
Printer, 34 

Quick Open command, 20 
Recent Files, 35 
Recent Projects/Workspaces, 35 
Save All command, 26 
Save As command, 25 
Save command, 25 
Save Selection As command, 26 
Send Mail command, 29 
Using File Tabs, 62 

File Menu Commands, 17 
File Tabs, 62 
Find command, 47 
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Font, 66 
Format Features, 71 

Add Indents, 76 
ANSI to OEM, 75 
Capitalize, 75 
Convert CR/LF’s to Wrap, 73 
Convert Wrap to CR/LF’s, 73 
Format Menu Commands, 71 
HTML Tidy, 76 
Insert Page Break, 76 
Invert Case, 75 
OEM to ANSI, 75 
Paragraph Formatting, 72 
Reformat Paragraph command, 72 
Remove Indents, 76 
Spaces to Tabs (All), 74 
Spaces to Tabs (Leading), 74 
Tabs to Spaces, 74 
To Lower Case, 75 
To Upper Case, 75 
Trim Trailing Spaces, 75 

Format Menu Commands, 71 
FTP, 21 
General Configuration Page, 97 

Backup Configuration Page 
Automatic Backup, 104 
Backup Files on Save, 104 
Default Backup Directory, 104 

Backup Configuration Page, 104 
Default to Read Only, 99 
Directories Configuration Page 

Default Save Directory, 114 
Default Template Directory, 114 

Directories Configuration Page, 114 
Disable Line numbers, 99 
Double Click Selections, 98 
Edit Configuration Page, 100 

Auto-Completion, 102 
Automatic Line Indentation, 101 
Disable Drag & Drop, 101 
Tab Settings, 102 
Tab/Word Wrap Change List, 102 
Word Wrap command, 103 

File Associations, 113 
File Change Detection Settings, 99 
File Type Configuration Page, 112 

File Open dialog box, 112 
File Save As dialog box, 113 

Find Configuration Page, 103 
Continue Search at End of File, 104 
Show Slim Find Dialog, 103 

Key Mapping Configuration Page, 111 
File Containing User Keyboard Mapping, 112 

Large File Handling, 99 
Multiple Instances, 98 
Project Menu on Main Menu, 98 
Recent Files List on File Menu, 98 
Reload Open Files on Startup, 100 
Save Bookmarks, 98 

Spell Checker Configuration 
Check Spelling Dialog, 109 
Dictionaries Dialog, 107 
New Dictionary Dialog, 108 
Options Dialog, 105 

Spell Checker Options, 105 
Syntax Highlighting Configuration Page, 115 

Auto-Correct, 122 
Block Comments, 117 
Case Sensitivity, 117 
Color Selection, 117 
Delimiters, 121 
Escape Character, 118 
File Extensions/Types, 117 
FORTRAN Specific, 120 
Function Definition Strings, 121 
HTML Specific, 119 
Indentation, 122 
Keywords, 119 
Keywords beginning with a Substring, 119 
Language Definition, 116 
LaTex/Tex Specific, 120 
Line Comments, 116 
Marker Characters, 122 
Strings, 118 
Words Starting with /, 119 

Toolbar Configuration Page, 111 
Use Large Icons on Toolbar, 111 

Use Default/Active File Directory For File Open, 
100 

Help Features, 129 
About command, 129 
Add Help Files, 129 
Help menu commands, 129 
Index command, 129 
Using Help command, 129 

Hex Editing Features, 44 
Hex Insert/Delete, 45 
Hex Mode Editing, 44 

Hex Mode – Line Terminators, 45 
Hex Mode Detection, 45 
Hex Mode Editing. See Hex Editing Features 
Highlighting, 115 
INI File Selection, 135 
Insert Templates command, 89 
Installation and Registration, 146 
Key Mapping, 111 
Keyboard Commands, 130 
License Agreements, 148 
list box, 50, 93 
List Box, 93 
Macro Features, 80 

Delete All, 83 
Delete Macro/Modify Hot Key, 83 
Edit Macro, 81 

Commands, 82 
Creating a New Macro, 82 
Modifying an Existing Macro, 82 
Parameters, 82 
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Load, 81 
Load and Append to Existing, 81 
Macro Definition Dialog, 82 
Macro Menu Commands, 80 
Playback, 85 
Playback Multiple Times, 85 
Record, 84 

Notes for Recording Macros, 84 
Save All, 81 
Set Auto Load, 81 
Stop Recording, 85 
Warn on Exit if Macro Not Saved, 85 

Macro Parameters, 139 
Obtaining Authorization Information, 147 
Output Window, 50, 93, 126 
PC/Network Installation, 146 
Print All Files command, 30 
Print command, 30 
Print Preview command, 31 
Print Preview Toolbar, 31 
Project Features, 55 

Close Project command, 56 
Delete Group, 57 
Files, 56 

Add Active File, 57 
Add File, 57 
Close, 57 
Open, 57 
Remove File, 57 

New Group, 57 
New Project command, 55 

Project, 56 
Workspace, 55 

Open Project command, 56 
Optional Wordfile, 57 

Project Menu Commands, 55 
Redo, 38 
Regular Expressions (UltraEdit Syntax):, 132 
Regular Expressions (Unix Syntax), 133 
Replace command, 50 
Revert to Saved, 25 
Search Features, 46 

Bookmarks, 53 
Continue Search at End of File, 50 
Find command, 47 

ASCII, 49 
Match Case, 48 
Match Whole Word Only, 48 
Search Direction, 48 

Find Command 
List Lines Containing String, 48 

Find in Files command 
Match Case, 49 
Match Whole Word Only, 49 
Regular Expressions, 50 
Results to Edit Window, 50 
Search Subdirectories, 50 

Find in Files Command 
Search In, 49 

Files Listed, 49 

Project Files, 49 
Find In Files command, 49 
Find In Files Command 

Search In 
Open Files, 49 

Find Next command, 50 
Find Previous command, 50 
Function List, 54 
Goto Line/Page, 53 
Match Brace, 53 
Replace command, 50 

ASCII, 52 
Find Next, 51 
Match Case, 52 
Regular Expressions, 51 
Replace, 51 
Replace All, 51 
Replace All in All the Open Files, 52 
Replace All Within the Selected Text, 52 
Replace in Current File, 51 

Replace in Files command 
Match Case, 52 
Match Whole Word Only, 52 
Regular Expressions, 53 
Search Subdirectories, 53 

Replace In Files command, 52 
Word Count, 54 

Search Menu Commands, 47 
Silent Installation, 146 
Sort, 27 
Special Character Summary, 48 
Spell Checker, 105 
Status Bar, 60 
Syntax Highlighting, 33, 67, 96, 115 
Syntax Highlighting Features, 115 
System Features, 125 

Move command, 125 
Next Window command, 125 
Size command, 125 

Tag List, 64 
Tag List Modify, 64 
Telling UltraEdit Which INI File to Use, 135 
Templates and Macros, 83 
Tile windows, 127 
Toolbar, 60 
Undo, 38 
Uninstall or Overwrite?, 147 
View Menu Commands, 59 
Window Management Features, 126 

1,2,…  command, 128 
Arrange Icons command, 127 
Cascade command, 127 
Close All Files command, 127 
Duplicate Window command, 127 
Next Window command, 127 
Previous Window command, 127 
Show File in Browser command, 128 
Synchronized Scrolling, 128 
Tile Horizontal command, 127 
Tile Vertical command, 127 
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Window Menu Commands, 126 Working with Wide Files, 43 
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